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Copyright © 2002 by The MegaPhone Company. All rights reserved. Except as permitted under 
the United States Copyright Act of 1976, no part of this publication may be reproduced or distrib-
uted in any form or by any means, or stored in a database or retrieval system, without the prior 
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SOFTWARE LICENSE AGREEMENT and LIMITED WARRANTY

By installing the PhonePro software program (“the Software”) you agree to be bound by all the 
terms and conditions of this license agreement. This license is effective until terminated. If you do 
not accept or agree to these terms you may terminate the license at any time by removing the 
Software from the computer on which the Software has been installed. This license will be termi-
nated immediately and without notice in the event that you fail to comply with any term or con-
dition hereof. Upon any termination you must destroy the Trial Software and any accompanying 
written materials and all copies thereof. Sections 3, 4, and 5 of this agreement will survive any 
termination. Please be aware that this Software may be programmed to cease functioning if 
appropriate serial numbers are not installed by a certain date, as required by this license, or if the 
software is copied to a computer other than the one it is license for, or tampered with in any way.

1. License Grant. The MegaPhone Company (“MPC”), grants you (“Licensee”), a non-exclusive, 
nontransferable license to install and use the Software on a single computer (a) for an evaluation 
period programmed into the software, (b) for an optional extended evaluation period after 
obtaining and installing an appropriate trial serial number (if available), and (c) thereafter after 
purchasing and installing an appropriate set of serial numbers for the software. This License is 
not a sale of the Software or any copy thereof. MPC retains title and ownership of the Software 
and all copies, regardless of the form or media on or in which the original or any copy may exist. 
MPC retains all rights to the Software and accompanying documentation not specifically granted 
to Licensee. 

2. Copyright. The Software and accompanying educational materials (“the Documentation”) are 
packaged as a compressed installer package ("the Installer"). All contents of the Installer are copy-
righted. Licensee may not copy, or encourage or allow copying of, the Software or Documenta-
tion that have been extracted from the Installer. Licensee may not transfer, convey, rent, 
sublicense, or otherwise distribute the Installer, the Software, or the Documentation, or any rights 
therein to any person or entity without express written permission from MPC. Licensee may not 
modify, reverse-engineer, decompile, create other works from, or disassemble the Software. Simi-
larly, Licensee may not copy, modify, adapt or create other works based upon the Documentation.

3. Limited Warranty and Disclaimer. LICENSEE ACKNOWLEDGES THAT THIS SOFTWARE 
MAY NOT SATISFY LICENSEE'S REQUIREMENTS OR BE FREE FROM DEFECTS. THIS SOFT-
WARE IS LICENSED “AS IS.” THE MEGAPHONE COMPANY MAKES NO WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES 
OF MERCHANTABILITY OF FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE 



 

SOFTWARE. THE MEGAPHONE COMPANY DOES NOT WARRANT, GUARANTEE, OR 
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF 
THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS IN TERMS OF ITS COR-
RECTNESS, ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. THE ENTIRE RISK 
AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE, AND ITS INTERACTION 
WITH OTHER EQUIPMENT OR SOFTWARE OWNED OR USED BY LICENSEE, IS ASSUMED 
BY LICENSEE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME 
STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

4. Limitation of Liability. IN NO EVENT WILL THE MEGAPHONE COMPANY, AND ITS 
DIRECTORS, OFFICERS OR AGENTS (COLLECTIVELY THE MEGAPHONE COMPANY) BE 
LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES 
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR 
INABILITY TO USE THE SOFTWARE EVEN IF THE MEGAPHONE COMPANY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL DAM-
AGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. The MegaPhone Company’s lia-
bility to you for actual damages from any cause whatsoever, and regardless of the form of the 
action (whether in contract, tort (including negligence), product liability or otherwise), will be 
limited to the amount of your purchase price.

5. General. This License Agreement constitutes the entire Agreement between you and The 
MegaPhone Company. If any provision of this Agreement is held invalid, the remainder shall 
continue in full force and effect. This Agreement is governed by the laws of the State of Califor-
nia, except as to copyrights and trademarks, which are governed by United States laws and inter-
national treaties. The Agreement is deemed entered into in Oakland, California. The Agreement 
shall inure to the benefit of MPC and its successors and assignees.

6. Export Law. The Software may not be exported outside the United States except as authorized 
and as permitted by the laws and regulations of the United States.

7. U.S. Government Rights. The Software qualifies as commercial computer software for pur-
poses of FAR 52.227-19 and DFARS252.227.7013. Accordingly, if the Software is acquired by a 
civilian government agency, it is furnished with only the minimum Restricted Rights provided 
by FAR 52.227-19. If the Software is acquired by a military agency, itis furnished with only the 
minimum Restricted Rights provided by DFARS 252.227-7013 (c)(1)(ii).

The following pertains to any software of Apple Computer, Inc., included with these software 
package:

APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. 
APPLE DOES NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS 



 

REGARDING THE USE OR THE RESULTS OF THE USE OF THE APPLE SOFTWARE IN 
TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. 
THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE 
IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY 
SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIA-
BLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES 
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTIONS, 
LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR 
INABILITY TO USE THE APPLE SOFTWARE EVEN IF APPLE HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EX-CLU-
SION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Should you have any questions concerning PhonePro or this Agreement, please write to 
sales@megaphoneco.com.
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1.
Getting Started

 

1.1. What is PhonePro?

 

PhonePro™ is a powerful and intuitive telephony applications builder 
for the Apple® Macintosh® family of computers.

With a Macintosh and your existing telephone system, PhonePro 
empowers you to create a broad range of custom telephony applica-
tions and services such as automated call processing, voice mail with 
electronic mail integration, interactive voice response (IVR), auto-
mated telemarketing, electronic bulletin boards, fax response systems 
and many more. It’s perfect for home offices, small to mid-range busi-
nesses and departments of large corporations.

PhonePro’s complete development environment is simple enough for 
non-technical people to build applications right out of the box and 
powerful enough for developers and system integrators to build com-
plex commercial applications.
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PhonePro is a computer language where functions are represented by 
icons rather than words. Instead of executing lines of code in a pro-
gram, PhonePro follows icons which are arranged in a script. Each 
icon represents an “action”, such as “Pick Up Phone” or “Play Mes-
sage”.

The program or script generated by PhonePro will perform actions 
represented by icons which are placed in the Script window. You 
determine the order in which functions or actions are completed by 
connecting paths between the icons.

Icons are added to a script by selecting and dragging them from a pal-
ette. Paths are created by dragging from one icon to another.

Click and drag a few icons from the palettes into the script window, 
connect them together and you have a simple answering machine. Use 
more advanced icons to create voice mail systems, automatic call dis-
tributors or automated call placing systems. When your script is com-
plete, use the front-end builder to create a polished, tamper-proof 
application. With PhonePro, virtually any telephony application you 
can imagine can become a reality.

 

1.2. How to use this guide

 

This guide covers everything you need to know to install and use 
PhonePro.

This chapter will help you determine what hardware, software and 
experience you need. Chapter 2 provides an overview of PhonePro’s 
key concepts. To get up to speed quickly, you may read the introduc-
tory material in Chapter 2 and skip directly to the Tutorial in 
Chapter 11. If you’d prefer to just jump right in and begin experiment-
ing, you could proceed directly to Chapter 10 which documents all of 
the PhonePro icons. However reading Chapter 2 and Chapter 4 first is 
highly recommended.

 

Note: Items which need extra emphasis appear in italic type. Be sure to read 
these carefully.
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1.3. What you need to know

 

This manual assumes that you are already an experienced Mac OS 
user and that you are familiar with basic procedures and the terms 
used to describe them.

You should, therefore, be familiar with the use of the mouse to point, 
select, and drag. You should also understand the use of windows and 
be able to open applications and documents. A knowledge of the uses 
of the Finder, Control Panels and Apple menu commands is also 
assumed.

Familiarity with AppleScript is not required, but recommended for 
developers who wish to make integrate PhonePro’s capabilities with 
other applications.

For full information on the Macintosh environment, please refer to the 
manuals and built-in help supplied with your Macintosh.

 

1.4. What you need to use PhonePro

 

Check that you have what you need before you install:

1. Macintosh computer:

- PowerPC Processor

- Mac OS 7.1 through Mac OS 9.2.2.

- 20 megabytes (MB) RAM or more available.

- A hard disk drive with at least 40MB free.

Some applications developed using PhonePro will require more mem-
ory and disk space than others. Sound files, for example, require a 
minimum of 4 kilobytes (KB) per second.
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2. Audio Hardware:
You will need a means of recording prompts for your 
PhonePro script. Depending upon which model Macintosh 
computer you have, you may need one or more of the follow-
ing:

- Microphone (for best results use a noise-cancelling micro-
phone mounted on a headset)

- Microphone adapter (for connecting an unpowered Micro-
phone to a Macintosh computer requiring line-level input)

- USB Audio adapter (for connecting an external Microphone 
to a Macintosh computer without an audio input jack)

- Tape deck and patch cord (for transferring pre-recorded 
audio on tape)

3. Telephony Interface Hardware and Software
You will need hardware that allows your Macintosh to access 
to the services of a particular telephone system. This hard-
ware is responsible for sending and receiving signaling infor-
mation to and from the telephone system as well as for 
sending and receiving the media streams (e.g., Voice, Fax, 
Data) associated with active telephone calls. The hardware 
may be installed inside your Macintosh, connected to your 
Macintosh through a serial cable, USB, or a local area network 
(LAN). Typical options include:

- Voice Modem. Voice modems are modems that support the 
ability to send and receive voice data.

- Voice Modem w/CallerID. Some voice modems have the 
ability to capture CallerID information from the signaling 
data that is provided from the telephone system.

- Internal Voice Modem. Your Macintosh computer may have a 
built-in voice modem. Most macintosh computers sold prior 
to 2002 had internal modems with voice capabilities. How-
ever, Apple Computer ceased to officially support this func-
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tionality starting with the original iMac. Unfortunately this 
means that the only way to be sure that your particular Mac-
intosh was shipped with a voice-capable internal modem 
supporting voice is to try it out for yourself.

- GeoPort Telecom Adapter. Macintosh computers with 
GeoPort hardware on the motherboard are able to support a 
GeoPort Telecom Adapter device. The GeoPort Telecom 
Adapter captures all information travelling across a phone-
line and delivers it into your Macintosh for processing. 
Unlike voice modems, the GeoPort Telecom Adapter doesn’t 
apply any compression to the data so it’s the best option for 
applications that require high quality audio.

PhonePro software accesses your telephony hardware using the 

 

Tele-
phone Manager

 

. In turn, the Telephone Manager controls your tele-
phony hardware using system extensions known as 

 

Telephone Tools

 

. 

 

PhonePro currently includes telephone tools for voice modems that use Rock-
well chipsets (such as those found on Apple’s internal voice modems) and the 
GeoPort Telecom Adapter. Check The MegaPhone Company’s website 
(www.MegaPhoneCo.com) for information about additional telephone tools.

 

4. Telephone Service
Each piece of telephony hardware must be connected to a 
telephone network. All the telephony hardware listed above 
is compatible with a single POTS (plain old telephone ser-
vice) analog line but you should check the documentation 
that came with your device for specific requirements. Options 
for telephone service include:

- Basic analog subscriber line.

- Analog subscriber line with CallerID. If your telephony hard-
ware supports callerID you’ll probably want to pay for call-
erID service.
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- Analog subscriber line with features. Features such as hold, 
transfer, three-way calling, and more may be available. They 
are invoked using special signaling sequences designed for 
analog lines.

- Analog Centrex Line. If you’re setting up PhonePro in an 
office, you may have the option to use Centrex lines. Centrex 
lines are like analog subscriber lines but they typically have 
callerID and support a rich set of features. Most significantly, 
they permit users within an organization to call between Cen-
trex lines using two, three, or four digit extension numbers 
and they require a network access digit (typically ‘9’) to be 
dialed before placing external calls.

- Analog PBX extension. If you’re setting up PhonePro in an 
office with its own Private Branch Exchange (PBX) you’ll typ-
ically request an analog, or “2500 set” line, that will be com-
patible with your analog telephony hardware. Like the 
centrex line it will probably have features such as hold, con-
ference, and transfer.

- Proprietary digital PBX extension. If you can’t get an analog 
line from your PBX, you may be able to use an adapter that 
connects to the handset of a digital telephone set and pro-
vides an jack to connect your analog telephony hardware. 
Unfortunately the limitations of these adapters are likely to 
restrict the types of applications you’ll be able to develop.

- ISDN subscriber line. An ISDN subscriber line is a digital 
phone line that allows two independent digital channels to be 
supported on a single phone line. An appropriate piece of 
telephony hardware may allow your PhonePro to communi-
cate directly with the ISDN line. However, most ISDN termi-
nal adapters provide analog jacks to which an analog 
telephony device can be attached.

- Broadband digital phone service. You may subscribe to tele-
phone service from your cable TV provider. In this configura-
tion, like the ISDN configuration, you may be able to interface 
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directly to the gateway device provided by your cable TV 
company, but it’s more likely that you’ll be able to connect 
your analog telephony hardware to an analog port on this 
device.

 

1.5. Installation

 

For instructions on installing and setting up your computer, connect-
ing your telephony hardware and connecting the associated telephone 
service, refer to the instructions that came with each device or service.

PhonePro uses a fully automated installer to place all the components 
included in the package into their appropriate places on your system. 
The installation includes:

• The PhonePro application, which is installed in the PhonePro 
application folder. 

• A utility application, 

 

MPC Sound Shop

 

 which is also installed in 
the PhonePro application folder. 

• A folder containing examples of PhonePro scripts, also installed in 
the PhonePro application folder. 

• Documentation in the form of this manual as a pdf file and a 
read me are installed alongside the applications in the PhonePro 
application folder.

• Telephone Tools are installed in your system’s extension folder 
and associated controls panels are placed in the control panel 
folder.

• Sound shop plug-ins known as sound effects are also placed in 
your system’s extensions folder

• A preferences folder was created containing special global files 
used by PhonePro and preferences files for the telephone tools

Optionally, the GeoPort system software and the telephone tool for the 
GeoPort Telecom Adapter may be installed.
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1.6. Application Setup

 

The first time you open the PhonePro application you’ll be given the 
option to review some introductory help information. You’ll then be 
asked if you want to begin using telephony hardware.

Many PhonePro users develop and do preliminary testing of their tele-
phony applications on computers that don’t have telephony hardware 
because PhonePro has the capability to run in simulation mode where 
applications can be tested with a virtual telephone service.

You may opt to configure your telephony hardware now or you may 
opt to do this later. If you choose to do it now, click the “Yes” button. 
You’ll be presented with the Telephone Settings window. In the upper 
portion of this window you should select the appropriate telephone 
tool for your telephony hardware/software using the pop-up menu. In 
the lower portion of the window you should configure the telephone 
tool. For example, a modem telephone tool will need to be configured 
by selecting the appropriate serial port and indicating the telephone 
number corresponding to the telephone service for the modem. Click 
the OK button when all the settings are correct.

If your attempt to configure a telephone tool fails you’ll be given the 
option to quit the application, proceed using simulation, or have the 
application attempt to try to activate the configuration again. Note that 
the “Try Again” option refers to the application trying to make the 
configuration you specified work -- not to giving you the opportunity 
to specify a different configuration. If the configuration you specified 
doesn’t work, click on the Simulate button and then use the “Select 
Hardware…” command in the Edit menu to reopen the Telephone Set-
tings window.

PhonePro offers a significant number of application preferences that 
customize its operation to your needs and your configuration. These 
are accessed through the preferences command in the Edit menu and 
are documented in Chapter 3.
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The telephone tool you select may offer further customization through 
a control panel. The Telephone Setup control panel is used to custom-
ize the behavior of the MegaPhone Company telephone tools and the 
Express Modem control panel (included with Apple Telecom Soft-
ware) is used to customize behavior of Apple’s telephone tool for the 
GeoPort Telecom Adapter.

The specific options that appear in the Telephone Setup control panel 
depend on the Telephone Tool you select from the pop-up menu at the 
top of the control panel. By default the control panel takes full advan-
tage of the capabilities of the corresponding telephony hardware, so 
you will not normally need to change these settings.

If the script that you’ll be deploying a script that places calls or trans-
fers calls you’ll also need to use the “Call Progress Trainer” feature 
(found in the Utilities menu) to train PhonePro to interpret the specific 
call progress tones used by your telephony service provider(s).
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2.
Key Concepts

 

This chapter summarizes the basic methods for using PhonePro and 
explains its functional elements. It describes how a PhonePro script is 
constructed and edited. Also included in this chapter are introductions 
to the associated software tools which are explained in more depth in 
other sections of this guide.

 

2.1. PhonePro Telephony Solutions

 

PhonePro provides a development environment for creating custom-
ized telephony solutions. A solution, or “application” developed in 
PhonePro consists of:

• One or more PhonePro Scripts

• Optional AppleScript template and script files

• Optional AIFF sound files

• Optional files for storing shared script components

• Optional files for storing text data

• Optional files containing fax data
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PhonePro scripts software programs with logic that is represented 
graphically. This logic appears as a collection of icons that represent 
PhonePro programming steps interconnected by paths that define the 
sequence in which those programming steps should be taken.

PhonePro scripts refer to three types of data:

• constant data which is set by the PhonePro developer and refer-
enced but not (normally) changed by PhonePro scripts,

• variables which are individual pieces of data that are modified by 
PhonePro scripts, and

• tables which are simple databases, or collections, of variable data.

PhonePro constant data, variables, and field within tables are assigned 
data types. Certain data types within PhonePro allow a PhonePro 
script to identify other files containing text or audio data.

PhonePro scripts can launch other PhonePro scripts (“sub-scripts”) 
and they can invoke AppleScripts. So several PhonePro and Apple-
Script files can be combined into a complex PhonePro solution.

PhonePro scripts can be further customized with front-end menus and 
dialog boxes and made to run in a captive mode so that they can be 
distributed to, or administered by end users.

 

2.2. Run, Simulate and Execute

 

Throughout PhonePro and in this Guide, you’ll find the terms “Run”, 
“Simulate” and “Execute”.

“Run” refers to actually running a script (complete with making calls, 
transferring calls, etc.), “Simulate” refers to testing a script, and “Exe-
cute” refers to either.
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2.3. Script Windows

 

The windows in which scripts are created can be moved, re-sized and 
arranged in layers using the standard Macintosh window controls. 
You can open a maximum of ten different script windows at a time.

Script windows can be arranged neatly using the Tile or Stack com-
mands under the Windows menu.

The “Tile Script Windows” command neatly arranges open scripts in 
equal rows, with top, bottom, right and left edges aligned.

The “Stack Script Windows” command stacks open script windows on 
top of one another, offset slightly lower. The title bar of each window 
remains visible.

 

Switching windows

 

When more than one script window is open, you may switch from one 
to another by clicking in the desired window. Alternatively, select the 
window’s name from the Windows menu, or press Command-1 for 
the first window listed; Command-2 for the second, etc. This method is 
helpful if you have a larger window open in front of a smaller one.

 

2.4. Defining Script Logic

 

2.4.1. Palettes

 

PhonePro icons, the building blocks for PhonePro scripts, are pre-
sented in palettes where they are grouped according to their function. 
This makes it easier to find them when you are building scripts.

There are eight palettes: the Core palette, the Telephony (“Phone”) pal-
ette, the Tables palette, the Files palette, the VoiceMail (“VMail”) pal-
ette, the User palette, the Modem palette, and the Fax palette. The 
Core, Phone, and Tables palettes appear to the left of the script win-
dow by default.
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All palettes can be shown or hidden by selecting the appropriate com-
mand from the Windows menu.

The Core palette contains icons which direct the flow of information 
within a script and permit the manipulation of variables.

The Telephony palette contains icons performing call control operation 
such as detecting inbound calls, collecting CallerID information, 
answering calls, making calls, and transferring calls. It also contains 
palettes for media services functions such as playing and recording 
sounds and detecting touchtones.

The Tables palette contains icons for opening, sorting, importing and 
exporting tables of information.

The VoiceMail palette contains icons associated with the built-in 
PhonePro voicemail functionality, including opening a mailbox, send-
ing a voicemail message, and reviewing the contents of an individual’s 
mailbox.

The User palette contains icons that interact with a person who is 
working at the Macintosh. These icons can be used to configure scripts 
or in any other circumstance where information is needed from a per-
son working at the Macintosh.

The Modem Palette contains icons which enable data communication 
to occur between computers as in, for example, a bulletin board.

The Fax Palette contains icons which allow individual fax documents 
or groups of documents to be sent.

 

Moving and sizing palettes

 

You can move, hide or re-size palettes like any Macintosh window. 
Palettes can only be re-sized vertically and can be as short as one icon 
tall, or as long as your screen or the number of icons allows. If you 
wish certain palettes to appear by default, set these using the “Pal-
ettes” panel in Preferences.
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2.4.2. Icons

 

To get an icon from one of the palettes into your script, drag the 
desired icon into the script window. You can place the icon anywhere 
in the script window and it can be moved again at any time by drag-
ging it. To remove an icon from the script window, select it and press 
the Delete key.

Each icon is numbered in the order that it is dragged into the script. 
This number appears in a box to the left of the icon. It has no effect on 
the potential position of an icon, but serves as a reference as the script 
is built.

 

Important: You are limited to a mixture of 2000 icons, paths, and other ele-
ments per script. There can be up to 10 script windows active on the desktop 
at one time.

 

2.4.3. Configuring Icons

 

Most icons can be configured to indicate how they should function in a 
given context (for example, how many rings to wait before answer-
ing).Icons are configured by double-clicking on an icon and providing 
the necessary information in the configuration dialog box that 
appears.

Icons that require configuration before they can be used in a script are 
shaded and remain so until they have been fully configured. Some 
icons do not permit configuration and others include default informa-
tion that makes configuration optional. 

 

Figure 2-1. Play Message Icon
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For example, when a new Play Message icon is added to a script it 
appears shaded because it cannot be executed until it is configured 
with what message is to be played. To configure a Play Message icon 
to play a pre-recorded sound stored in the script file, choose “Sound” 
from the pop-up menu to the left of the configuration window, then 
choose a particular sound stored in the script from the pop-up menu 
that lists the available sounds. If you have not yet recorded the desired 
sound, PhonePro provides the tools to record it.

Specific information concerning how to configure each icon can be 
found in Chapter 10 of this manual.

 

2.4.4. Reviewing Icon Configurations

 

Once you have configured some icons, you can quickly review the 
configuration of each by holding down the Command key while click-
ing on the icon. A box appears which contains information about how 
the icon is configured. Balloon Help, described later in this chapter 
under Getting Help, also provides information on how each icon is 
configured.

 

2.4.5. Path Connectors on Icons

 

Icons operate from top to bottom. A path enters an icon through a sin-
gle connector on the top, the inbound connector, which causes the icon 
to act. A path can exit an icon through one or more outbound connec-
tors, leading the script to subsequent icons. There is no limit to the 
number of paths that may enter an icon at the inbound connector.

 

Figure 2-2. The Assign Value Icon
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Several icons, such as the Go icon, the Fatal Error icon and the Call Ter-
minated icon, don’t have inbound connectors because they are “event 
Catchers” and are executed whenever certain specific conditions are 
met. The Go icon is the start point for every script.

When completed, most icons exit through a single outbound connec-
tor, so there is only one direction for execution to proceed. Some icons 
have several outbound connectors. Two icons, Go To and Stop Script, 
have no outbound connectors.

 

Special icon connectors

 

Icons with multiple outbound connectors have letters or symbols near 
each connector to indicate its use.

For example, an icon which makes a yes or no decision, will have a dif-
ferent outbound connector for each result, represented by a “+” (yes) 
and a “-” (no) symbol. Script execution follows the path which 
matches the result of the decision.

 

Figure 2-3. The Go, Fatal Error, and Hot Key Icons

Figure 2-4. The Go To and Stop Script Icons

Figure 2-5. The User Decision Icon
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Some icons accept Touch Tone sounds from the phone line. These icons 
have three outbound connectors. The connector on the bottom of the 
icon is used when-ever information (in the form of Touch Tones) is 
successfully acquired over the phone line. If no Touch Tone key is 
pressed, the script exits the icon through the “T” (Time Out) outbound 
connector. If a tone is received but is not acceptable, the script uses the 
“E” (Error) outbound connector.

Menu icons have an outbound connector with a unique behavior. It 
allows multiple exit paths to be attached, each of which leads to a dif-
ferent destination. Each path is assigned to a unique menu option.

The Detect Rings icon a connector labeled “P” on its right, which is 
used to run tasks at regular intervals.

Full details about individual icons and any special connectors they 
have can be found in Chapter 10.

 

2.4.6. Paths

 

Icons are connected with paths, which can be any length. Paths are 
drawn between icons using the following method:

• Click on the outbound connector of the first icon.

• Drag the pointer toward the second icon. As you drag, a dimmed 
path appears.

• Drag the pointer to the inbound connector at the top of the second 
icon.

 

Figure 2-6. The TouchTone Menu Icon
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• When you reach this connector, the path clicks into place with a 
“snap” and becomes black, indicating that the icons are properly 
connected.

It is important to note that a path and an icon can only be connected by 
dragging the end of a path to an icon connector. The opposite does not 
work.

If the path does not turn black, you have probably dragged the path a 
little past one of the connectors. Check both ends of the path and make 
sure they are connected.

 

Disconnecting and deleting paths

 

To disconnect a path from an icon, drag either end of the path away 
from the icon. The path becomes dimmed. To remove a path, select it 
and press the Delete key. This re-moves only the path; any icons which 
were connected to it remain. You can disconnect and reconnect a path 
any number of times by dragging it to or from an icon.

 

Making corners in paths

 

While designing your script, you may wish to make a path turn a cor-
ner. This is possible, although you might consider using a Go To icon 
instead.

To make a path turn a corner, drag a path from the connector on the 
icon to approximately where you want to turn the corner. To create the 
second part of the path, click on the unconnected path connector while 
holding down the Command key. Drag a new path segment out from 
the connector. You may repeat this for as many segments as you wish.

PhonePro treats your connected path segments as one path when exe-
cuting a script but as separate paths during any editing. For instance, 
if you decide to delete a path containing corners, you need to delete 
each section. See Editing Features, later in this chapter, for a discussion 
of easy ways to accomplish this.
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2.5. Editing Scripts

 

While you are creating a script, you usually need to edit it in some 
way, by copying, moving, deleting or rearranging items within it. 
PhonePro provides a variety of ways to accomplish this.

 

2.5.1. Moving Icons and Paths

 

Before moving any path or icon, determine whether or not it has any 
connections that you would like to preserve.

Selecting and dragging an icon preserves the original connections to it. 
Selecting and dragging a path breaks connections. To break the con-
nections when moving an icon or group of icons, hold down the 
Option key while moving it. The newly-disconnected paths become 
dimmed.

If you move a group of paths and/or icons, the spatial relationships 
within the group are maintained but all paths connecting the group to 
the rest of the script are stretched or compressed.

 

2.5.2. Copying Icons and Paths

 

You can copy icons and paths from one script to another by highlight-
ing the portion that you wish to copy and choosing Copy from the Edit 
menu (or typing Command-C). To paste the selected items into 
another script, select its window and choose Paste (Command-V) from 
the Edit menu.

To copy an icon or path within a script, highlight the elements you 
wish to duplicate and select Duplicate (Command- D) from the Edit 
menu.

Duplicated icons are not configured, since they do not retain their con-
figuration information from the originals.
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2.5.3. Deleting Icons and Paths

 

To delete a single icon or path, select it and press the Delete key. The 
path or icon then disappears and any formerly-connected paths or 
icons become dimmed.

There are two methods for deleting groups of icons or paths:

1. If the icons/paths are spread out over an area, select them indi-
vidually by holding the Shift key down while clicking each one. 
To deselect a selected icon or path, Shift-click on the highlighted 
icon to deselect it. When you have highlighted all the icons or 
paths to remove, press the Delete key.

2. If the icons/paths are grouped together in the script, point to a 
blank place at a corner of the group and drag to the diagonally 
opposite corner of the group. A marquee appears as you drag and 
everything within it be-comes highlighted. If you want to change 
the composition of the group within the marquee, use the shift-
click method described above to select or deselect individual 
items. Press the delete key when you have highlighted all the 
items you wish to remove.

 

2.6. Data Types

 

PhonePro’s varied functionality requires many different types or for-
mats of information. These “data types” include text, numbers, phone 
numbers, locations of files on hard disks (“links”), and sounds. A table 
field or a variable always has a particular data type assigned to it 
when it is created.

During configuration of icons which use table fields or variables, it is 
only possible to select fields or variables of types which fit the tasks 
the icon will perform. Please see Chapter 4 for more details about data 
types.
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2.7. Sounds

 

Sounds which have been previously recorded, for example using the 
microphone on a Macintosh or imported from an audio CD, can be 
used within a PhonePro script. Additionally, PhonePro provides func-
tions which allow you to record, play, store and edit sounds. Working 
with sounds is explained in more detail in Chapter 5.

 

2.8. Variables

 

A variable is a single piece of information which is likely to change. 
Variables of several types are allowed, for example, day, date, time, 
phone number, text or whole numbers. PhonePro can also treat sounds 
as variables. More information about variables can be found in 
Chapter 4.

 

2.9. Tables

 

A table is a collection of information which you can enter and modify 
easily. Table records can be thought of as cards in a Rolodex™. Table 
fields are categories of information on the cards. The maximum num-
ber of fields in a PhonePro table is twenty-four. For more information 
about PhonePro tables, please see Chapter 4.

 

2.10. Data Storage

 

PhonePro can store the data accessed by a scripts (constants and vari-
ables including sound resources and file links) in four distinct places:

1. In scripts: where they are specific to a script file and can only be 
accessed from within that script. The scope of these items is 
“Local”.

2. In the “Common Resources” file: where they can be used by all 
scripts on a single Macintosh.
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3. In a “Shared file”, where individual constants and variables from 
several scripts can be stored and shared between any scripts 
which have that shared file open. These items are known as 
“shared items”.

4. In tables, where other information can be attached and tracked (as 
in voice mail). Tables can be accessed by any script.

The “scope” of a particular script element (whether Local, Shared or 
Common) should be chosen based on which scripts are to use a given 
piece of information.

 

Note: For portability, keeping components used by a single script confined to 
that script saves significant overhead. It can also keep a Macintosh using 
many scripts more organized and make the script easier to follow.

 

2.11. PhonePro Voice Mail

 

PhonePro’s built-inVoice Mail functionality is designed to allow cus-
tomers who do not have an electronic mail server at their site to gain 
many of the benefits of mail systems without having to invest in the 
cost of a server.

PhonePro Voice Mail uses the Macintosh file system to provide “mail-
boxes” for individuals who are to receive voice mail messages. These 
mailboxes are actually folders on a file server or local Macintosh hard 
disk drive. Voice mail messages are stored as files in these folders. 
Each file represents a single message.

Double-clicking these files plays the sound associated with the mes-
sage through the Macintosh’s speaker. In other words, PhonePro Voice 
Mail users need not have any special application, “INIT”, or desk 
accessory to listen to and maintain their voice mail.

The power of this simple system is considerable. Messages can be 
written to folders on remote AppleShare servers, or accessed in peer-
to-peer networks using file sharing.
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2.12. Getting Help

 

Help is easily available within the PhonePro development environ-
ment in two forms: Balloon Help and Built-in Help. Balloon Help can 
be turned on using the “Show Balloons” command in the Help menu. 
PhonePro’s Built-in Help can be accessed using “Help Mode” or by 
clicking on the “Help” buttons that appear in various PhonePro win-
dows.

Help Mode, invoked from the Help menu, places PhonePro into a spe-
cial mode that simplifies accessing on-line context-sensitive help by 
turning the cursor into a “?”. In this mode, any icon or menu com-
mand can be selected and help for that icon or menu is immediately 
presented.

For example, if you wish to review help for the Pick Up Phone icon, 
select Help Mode from the Apple menu (or press Command-B), and 
click on the Pick Up Phone icon.

If you need help with a dialog box, click on its Help button for specific 
information. Icon-specific help can be obtained by pressing both the 
Command and Option keys while clicking the icon.

PhonePro also has built-in explanations of most items that appear on 
the computer screen. Each description is displayed in a small balloon 
next to the item you are pointing to. When you move the pointer away, 
the balloon disappears. To turn Balloon Help on, choose Show Bal-
loons from the Help menu (which has a question mark icon). You can 
turn off balloons by choosing Hide Balloons from the same menu.

If you are using an extended keyboard, press the Help key and select 
an icon or menu command for information.

 

2.13. Option Buttons

 

Option buttons are a variation on standard Macintosh buttons that are 
unique to PhonePro. These buttons are used to conserve space in cer-
tain congested windows by putting related button functions “behind” 
normal Macintosh buttons. These optional functions are always 
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closely related to the primary function of the button. For example, 
Remove often has Remove All as the optional function.Option buttons 
have the upper right corner turned down to indicate that an optional 
function is available.

There are two ways to access these optional functions. One method is 
to click in the turned down corner of the button to display the optional 
function. Alternatively, hold down the Option key to display the extra 
function. Then click on the button to perform that function.

 

Figure 2-7. An Option Button
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3.
PhonePro Menus

 

This chapter describes PhonePro’s menus. Items common to all Macin-
tosh applications aren’t documented here as familiarity with those 
items (for example Open, Cut, Paste, Copy) is assumed.

 

3.1. File Menu

 

The File menu contains only one option which is not common to all 
Macintosh applications: the “Revert to Saved” command, which 
returns to the most recently saved version of the script. Current 
changes are cancelled.

 

3.2. Edit Menu

 

The Edit menu includes all the standard Macintosh Edit menu com-
mands along with commands for aligning icons and managing appli-
cation settings. PhonePro’s Preferences settings enable you to tailor 
PhonePro to the needs of your working environment. Additionally, the 
Edit menu contains the Telephone Setup option, which is used to con-
figure PhonePro for use with your telephone system.
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3.2.1. Alignment Options

 

The “Align to Grid”, “Align Left”, and “Align Top” menu commands 
allow you to arrange selected groups of icons neatly.

The “Align Left” command aligns the left sides of all the selected icons 
with that of the left-most selected icon. Similarly, the “Align Top” icon 
aligns the top sides of all the selected icons with that of the top-most 
selected icon. These commands work independently of the current 
grid settings (see grid preferences, below).

 

3.2.2. Preferences

 

When you choose Preferences, the Preferences dialog box appears. 
This window contains ten radio buttons which select panels for Check-
ing, Fax Software, General, Grids, Hardware, Palettes, Recording, 
Sound, Speaker, and VoiceMail preferences.

 

Options Common to all Preferences Panels

 

The following options are available from the Preferences dialog box 
regardless of which set of preferences you have selected:

• Help: Built-in help appears.

• Cancel: Closes the preferences window without saving changes.

• Save: Closes the window and saves the new settings.

 

General Preferences

When you open Preferences, the General settings panel appear. These 
settings relate to the feedback PhonePro provides when you are build-
ing and running a script, how dates and time values are expressed, 
and options for saving script files.
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• Snap When Paths Connect: Enables a “snap” to be heard when 
you successfully connect paths between icons.

• Report Errors When Simulating: An error box appears at the icon 
location in place of the Fatal Error handling mechanism. For more 
details, see the description of the Fatal Error icon in Chapter 10.

• Animate Script Run: When this option is checked, script files are 
displayed while they execute and individual icons are highlighted 
as they are executed. If this option is not selected, the Script win-
dow is hidden during script execution, which allows the script to 
execute significantly faster.

• Preload Icon Info When Possible: Checking this will make the 
script run considerably faster because all information needed to 
execute each icon is preloaded when the script is first run.

• Save Icon Trace to text file: Enables logging icon execution infor-
mation to the “Icon Trace” file in the PhonePro preferences folder.

The “When speaking dates” checkboxes determine how date and time 
values are converted to audio. The selected portions of the date and 
time information are included when these data types are verbalized.

The “Saving of Scripts” settings allow you to determine when and if 
scripts are automatically saved or when you will be offered the oppor-
tunity to save a script.

Checking Preferences

PhonePro helps simplify the process of creating and editing scripts by 
providing a checking function that validates continuity and comple-
tion of your script. Using these preferences you can choose when 
checking will occur and what will be checked. Your choices for when 
checking occurs can be one or all of:

• At Script Open: when you open an existing script.

• At Icon Execute: as each icon is executed.

• At Script Execute: when script execution begins.
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• At Script Launch: when a Launch Script icon is used to open and 
execute a “sub-script”.

Your choices for the type of checking you prefer are:

• No Check: no error checking.

• File Links: verifies the presence of all files used by the script.

• Links and Data: validates that the contents of the files are in place 
for successful running of the script.

Check Only Once at Change/Load: If this option is active, PhonePro 
will skip checking for a given script file if it has already been checked 
since it was last opened or changed.

Important: Each time checking occurs, there is a slight delay. The option to 
check at Icon Execute can significantly slow script execution, especially on 
slower Macintosh models or when network access is involved.

Fax Software Preferences

Use the fax software preferences panel to specify the fax software you 
are using, if any, with the appropriate radio button. If you have no fax 
software installed, click “None”.

The “Send Faxes When Simulating” checkbox allows you to skip fax 
sending operations when executing in simulation mode.

Grids Preferences

PhonePro can keep icons aligned to a grid. This makes scripts neater 
and easier to follow. 

• Automatic Align to Grid: Icons dragged in the script window will 
automatically snap to the closest grid point. (The top left corner of 
the icon is aligned with the grid.)

• Show Grids: This option makes the grid lines visible in the script 
window.

• Horizontal Grid Size: sizes the horizontal grid axis in pixels.
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• Vertical Grid Size: sizes the vertical grid axis in pixels.

By default the horizontal and vertical spacing is 8 pixels. Other recom-
mended values are 20, 28, and 50.

Hardware Preferences

The hardware preferences panel allows you to specify what hardware 
PhonePro should attempt to access while executing scripts. The 
options are:

• None: You can execute scripts in simulation mode, but you can’t 
record sounds. If you simulate without hardware, a pre-recorded 
sound will be substituted for any sound which the script would 
have recorded if recording hardware were present.

• Sound Input Manager: You can execute scripts in simulation 
mode and record sound using a Macintosh with a sound input 
device such as a microphone. You can’t execute scripts in Run 
mode, or interact with a phone line, if this setting is selected.

• Telephone Manager: Select this if you actually want to run scripts 
that interact with a phone line using an appropriately configured 
Telephone Tool.

Palettes Preferences

This box allows you to select which palettes will be displayed when 
PhonePro starts up.

Recording Preferences

The options available to you in recording preferences include:

• Macintosh Audio Recording Beeps: You can choose to have a 
recording beep played over the phone line before and/or after 
recording. Any sound resource (‘snd ‘) from the “Recording 
Beeps” file (located in the PhonePro preferences folder) can be 
selected from the lists titled “Before” and “After” in this panel.
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• Confirm Recording: If this box is checked, a message will appear 
on the Macintosh screen whenever a sound is recorded. If this is 
unchecked, recording will progress with no confirmation mes-
sage.

• Recording Quality: This allows you to choose the quality of your 
sound recordings.

• Silence Seconds: Sets the time that PhonePro will wait before ter-
minating a recording if there is no sound on the telephone line.

• End Trim: Recording from a telephone call is terminated after the 
system detects a touch tone, dial tone, a busy signal, or several 
seconds of silence elapse (as set above). The tone (or silence) that 
terminated the recording must then be trimmed off the end of the 
recording. Use these settings to adjust the amount trimmed in 
each case. The default settings are normally appropriate, but you 
can adjust them if you find that the end of recordings is being 
chopped off or if tones are being included in saved recordings.

Note: Be very careful when adjusting trim settings. If a caller terminates a 
recording using a touchtone which is not fully trimmed, playing back the 
recording can cause the touchtone to be detected as if it had just been pressed 
by the caller. This can cause your script to behave in an unintended fashion. 
This type of problem is very hard to detect because the script will appear to 
behave erratically even though the logic is correct so be sure that your trim 
settings are correct before deploying your script. 

Sound Preferences

The options available to you in the sound preferences panel allow you 
to configure text-to-speech settings and setting that govern the perfor-
mance of audio recording and playback operations:

• Use Record to Disk: Checking this box specifies that PhonePro 
should record directly to disk rather than recording to memory 
and then saving to disk.
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• Use Play to Disk: Checking this box specifies that PhonePro 
should play audio directly from disk rather than loading it into 
memory before playing it back.

• Text-to-Speech Settings: Choose a voice to use from the pop-up 
window, then set the Rate, Pitch, Volume and Modulation for that 
voice by clicking each respective text box and entering a value. 
The Rate setting controls how quickly PhonePro speaks outgoing 
messages when you have activated text to speech (i.e., you have 
configured a Speak List icon to use text to speech). Set a higher 
value here if you want PhonePro to speak quickly, a lower value 
to speak slowly. The Pitch setting controls how high PhonePro's 
synthesized voice sounds when it speaks a message, though the 
range available depends on the particular characteristics of the 
voice you've chosen. Again, enter higher values for higher pitches, 
lower values for lower pitches. The Volume setting controls how 
loudly PhonePro speaks messages. As before, higher values mean 
louder speech, while lower values mean softer speech. The effec-
tive range of values available is zero to 10. Finally, the Modulation 
setting controls the relative level of inflection that PhonePro uses 
when speaking a message. Enter a high value here to hear a more 
“natural sounding” voice. Enter a low value to hear a relatively 
flat, artificial-sounding voice. You can test the settings as you've 
configured them by clicking the button labeled Test. PhonePro 
will speak a standard phrase with the voice you've chosen, using 
the settings you entered.

Speaker Preferences

The speaker preferences panel allows you to configure certain options 
for the speaker (if any) associated with your telephony hardware:

• Turn on Modem/Speakerphone Speaker: While on, the modem 
speaker will play all phone line sounds, such as the dial tone or 
busy tone. Select the radio button corresponding to when you 
would like the speaker turned on.
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• Speaker Volume: Set the speaker volume to the desired level. 1 is 
the lowest volume setting and 8 is the highest.

VoiceMail Preferences

Use the voicemail preference panel to set the default user name and 
password for posting voicemail messages, control voicemail icon oper-
ation in simulation mode, and determine when PhonePro should “log 
on” using the default account:

• User Name: Enter the user name for the PhonePro voicemail 
account that will be used by default.

• Password Name: Enter the password for the PhonePro voicemail 
account that will be used by default.

• Perform Mail functions when simulating: This allows you to have 
your scripts perform mail functions as if the script were running, 
when simulation is in progress. If it is not enabled, PhonePro will 
not actually interact with the voicemail system during simulation. 
Instead, it will allow you to specify, via a dialog box, whether mail 
was successfully sent or not.

• Log On Automatically at Script Run: PhonePro will log on to the 
mail system whenever a script is executed.

• Log On at Each Mail Icon Execute: Allows you to log on to the 
mail system only when PhonePro encounters Mail icons in a 
script. Select this option if there are only a few Mail icons in your 
script, or if you do not wish PhonePro to be continually logged on 
to a mail server.

Note: If you change your mail server password or user-name, be sure to 
update these settings.

3.2.3. Create Settings Report

The “Create Settings Report…” command in the Edit menu creates a 
text file on disk which contains a full report of all settings (e.g. Prefer-
ences). You can then use this file as a reference when debugging, seek-
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ing technical support, or when configuring another PhonePro 
installation. You need to choose a location and enter a name for the set-
tings report file when you select this command.

3.2.4. Telephone Setup

Telephony services are selected and configured through two inter-
faces:

• The Telephone Settings window

• A Telephone Tool control panel

The “Select Hardware…” command in the Edit menu opens the Tele-
phoneSettings window which you can use to select and configure a 
telephone tool. Select the desired telephone tool in the pop-up menu in 
the top portion of the window and configure the tool in the lower por-
tion of the window.

Preferences for modem telephone tools bundled with PhonePro can be 
set using the Telephone Setup control panel. Settings in this control 
panel include:

• Ring Sound and Ring Volume: Use these pop-up menus to set the 
sound that should be played for each ring of the phone line and 
the volume at which it is to be played.

• CallerID Enabled: This checkbox is used to enable the collection of 
any CallerID information delivered by the telephone system.

• Dial tone TimeOut and Check for DialTone: These specify if the 
tool should wait for dial tone and the number of seconds that the 
tool will wait when making an outgoing call or attempting to 
transfer a call.

• Tone Dialing: This check box selects Touch Tone dialing. If it is 
unchecked, dialing will be performed using pulse dialing.

• Flash Length: The length of time the modem hook switch needs to 
“flashed” to register a flash hook signal.
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• Hold Key Sequence: The Touch Tone/Flash key sequence for plac-
ing a call on hold is set up here. Valid characters include 0, 1, 2, 3, 
4, 5, 6, 7, 8, 9, A, B, C, D, “*”, “!” (flash hook switch) and “,” (half-
second pause). If your telephone system can’t transfer calls, disre-
gard these settings.

• Transfer Key Sequence: The Touch Tone/Flash key sequence for 
transferring telephone calls is set up here. Valid characters are the 
same as for a Transfer Key Sequence.

• Return from Transfer/Ringing: The Touch Tone/Flash key 
sequence for returning to a call after a transfer fails because there 
is no answer is specified here. Your telephone system may require 
different key sequences to be used, depending on the state of the 
call when you wish to cancel a transfer.

• Return from Transfer/Busy: This setting specifies the Touch 
Tone/Flash key sequence for returning to a call after a transfer 
attempt fails because of as busy signal. Valid characters are the 
same as for a Transfer Key Sequence.

• Return from Transfer/Reorder: This setting specifies the Touch 
Tone/Flash key sequence for returning to a call after a transfer 
attempt fails because of as reorder signal. Valid characters are the 
same as for a Transfer Key Sequence.

• Silence Threshold: This sets the sensitivity of the silence detection 
while recording from the telephone line. The default value should 
be functional for most applications. If a lower-powered telephone 
line is used, it may be necessary to adjust this threshold level 
higher.



Script Menu

37

3.3. Script Menu
The Script menu includes commands that apply to the front-most 
script window. They are:

• Check: This command initiates checking of the script in the front-
most script window. PhonePro will present a dialog box reporting 
the first error that it discovers and then flashes the affected icon or 
connector.

• Simulate: This command executes the script in simulation mode. 
Simulating a script is a dry run using, for example, sample sounds 
instead of real recorded ones. A script which is being simulated 
does not actually interact with real telephone calls. Simulating a 
script is useful for isolating errors or developing and testing a 
script that doesn’t support telephony hardware for later deploy-
ment on a production telephony server.

• Run: This executes the script using the currently configured tele-
phone tool. If no telephone tool is currently configured, PhonePro 
will provide the option to configure one. Normally while a script 
is running PhonePro displays a small window that shows the 
name of script that is running, the amount of available disk space 
an memory, and the time that the last call was received, and an 
animated symbol that indicates that the script is executing. How-
ever, if the “Animate script run” option is checked in the General 
preferences panel, and the script isn’t a compressed script or one 
that has been set to run only in captive mode, PhonePro will leave 
the script window as it is and hilight the icon being executed as it 
runs, just as it does in simulation mode.

• Configure Icon: This command allows you to configure the 
selected icon using it’s configuration dialog box. Double-clicking 
the icon is a short-cut for display an icon’s configuration dialog 
box. Please see Chapter 10 for descriptions of all PhonePro icons 
and their configuration options.
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• Find Icon by Number: Use this option to find any icon in a script 
by entering its number. The desired icon will be selected and the 
script window will scroll horizontally and vertically to bring the 
desired found icon into view.

• Show Configuration Browser: This command presents the config-
uration browser window. The Configuration Browser consists of a 
window with two list boxes. The box on the left lists all of the 
icons in the script sorted by icon number. Clicking on one of these 
icon reference produces a summary of that icon’s configuration in 
the box on the right. Clicking the “Change” button produces the 
icon configuration window for the that icon.

• Create Configuration Report: The “Create Configuration Report” 
produces a text file that lists every icon in the front-most script 
and the configuration details for each. You’ll be prompted for a 
filename and location to save the new report.

• Show/Hide Icon Trace: This command control the display of the 
Icon Trace window. The Icon Trace window tracks the execution 
of each icon in a script as it occurs while a script is being run or 
tested in simulation mode. The icon trace is useful for monitoring 
a script and the calls it makes or receives and as a debugging tool.

• Show/Hide Data Connection Monitor: This command control the 
display of the Data Connection Monitor window. This window 
lists all of the data exchanges which occur while a data connection 
is established (using the Establish Data Connection icon).

• Show Execution Error: This command displays a window with all 
of the details about the last execution error including where it 
occurred.

• Configure Front End: This command allows you to make the 
script into a captive script and to select options for the script’s 
front end. Please refer to Chapter 7 for details.

• Configure Front End Menus: Use this command to access the win-
dow that is used to create front end menus. Please refer to 
Chapter 7 for more information on front end menus.
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• Create Compressed Script: This command creates a copy of the 
script that can be run as a captive script but not edited. PhonePro 
compressed scripts execute significantly faster than normal scripts 
and require a smaller memory footprint and less disk space. After 
the script has been compressed, PhonePro will tell you how much 
smaller the script has become. You should see at least a 50% 
reduction in the size of your script. You also have the option to 
embed a name for your script into the compressed script. This 
name will be used in place of “PhonePro” if the compressed script 
is used with PhonePro’s runtime engine.

Before creating a compressed script, you should have thoroughly tested your 
script in PhonePro’s Simulation Mode and then while using a live phone line.

3.4. Tables Menu
This menu allows you to create and manage PhonePro table files. 
Please refer toChapter 4 for a complete description of PhonePro tables 
and the functionality of each of these menu commands.

• New: This command creates a new table file.

• Open: This command opens an existing table file.

• Check: This command checks a table file for links to other files. 
Each link is checked to see if the relevant file or folder exists. If 
any invalid links are found, you will be given the option to restore 
the link by finding the appropriate file. You may select “Cancel”, 
in which case the file will be “Unassigned”. The Check option also 
checks the location of any sounds which are referenced within a 
table file.

• Restructure: This command allows you to changes the structure of 
an existing table file. For example, a field can be renamed, added, 
removed, or it can have its data type changed. While you may 
change the data type of a field, this should be undertaken with caution 
because any information stored in that field may be lost.
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• Recover: This command rebuilds the file structure of a table which 
has become corrupted.

• Import: This command extracts the data contained in a file gener-
ated using another application and inserts it into a PhonePro 
table.

• Export: This command saves a PhonePro table file as a tab-delim-
ited text file, which can be used by other applications.

3.5. Utilities Menu
The Utilities menu contains miscellaneous utility commands that 
apply to all the PhonePro scripts you are working with.

3.5.1. Data Browser

PhonePro maintains file links, variables, and pre-recorded sounds, 
which can be referenced by PhonePro icons in scripts. This PhonePro 
data can be stored in four types of files:

1. In the current script.

2. As a shared item, in a specific shared file.

3. In the Common Resources file.

4. In linked table files.

The Data Browser gives you a central location where you can create 
new script data items, locate and edit those you’ve already created, 
delete unneeded items, and move data between script, common, and 
shared files.

Radio buttons at the top-right of the Data Browser allow you to change 
the source of the data to be browsed. You may select one of the open 
script files, a shared file, or the Common Resources file. You can view 
resources in any script you have open by clicking on “Script:” and 
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choosing that script from the pop-up menu at the upper right corner. 
(To access tables through the data browser, select a file that has a link 
to the desired table file.)

Choose the type of data items you want to browse from the pop-up 
menu in the upper left corner.

When you have chosen a file and an item type, use the buttons arrayed 
along the top of the data list to create or modify an item. You can, for 
example, create new variables, tables, and file links, or locate, edit, and 
delete existing variables, tables, and file links. Click Play to hear a par-
ticular sound that you have included in your script. Click Move to 
move data between script files, shared files and the common resources 
file. The buttons that are active in the Data Browser vary depending on 
the data you have selected.

3.5.2. Word Sounds

When you create scripts, you will find that there is often a requirement 
to “speak” some text to a caller. This adds a great deal of versatility to 
a script, because you can create a script that “reads” appropriate text 
based on the contents of a table field or variable using a pre-recorded 
voice rather than the synthesized voice of the Macintosh text to speech 
capability.

The mechanism that PhonePro employs to do this is the Word List. 
This works with the Speak List icon(shown on the left) and lists a 
series of sounds, each with a title. At installation, PhonePro includes a 
small list of words that correspond to prerecorded sounds (‘snd ’ 
resources). Additional words can be easily added to the list using the 
Word Sounds window.

The words list mechanism is designed to be as flexible as possible as it 
translates entries that are Number, Text, Decimal, Day, Date, Time or 
Phone Numbers into spoken words.
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Note: numbers are “spoken” in a colloquial manner - by default, 123 becomes 
“one twenty three”, and “3000” is read as “three thousand”.The Speak List 
icon offers the option to “Speak numbers individually”, reading 123 as “one 
two three”.

Words or phrases can be added to the Word List by clicking the “New 
Word” button. A window will appear containing PhonePro’s Sound 
Recording Buttons and space to enter the label for the new word. Type 
the new into the text box provided and record the corresponding 
sound. For more information about the Sound Recording Buttons, see 
Chapter 5

Figure 3-1. The Data Browser Window
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A special feature of the Word List is that it allows homonyms (words 
that sound the same but are spelled differently) to be handled by 
entering multiple words into a single entry’s title separated by “=” 
symbols. This means that a single sound may be matched with several 
pieces of text. An example of this is there, their and they’re, or for, four 
and 4.

Important: 

1. Word labels (and therefore combinations of homonyms) can only be 31 or 
fewer characters long.

Figure 3-2. Word Sounds Window
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2. Duplicate labels may produce undesired results - the word found will not 
necessarily be the first matching the label shown in the list.

The “Edit” button allows an existing word from the list to be re-
recorded or edited, and also allows the word or words associated with 
the sound to be changed.

The “Play” button plays the sound associated with a title in the list.

The “Try Phrase” button provides a means for checking how titles 
from the list would sound when played down the phone line. If you 
enter a phrase which contains word titles not included in the list, 
PhonePro will give you the option to add the missing parts using the 
Sound Record buttons.

The “Remove” button allows you to remove a selected word title from 
the list.

3.5.3. PhonePro VoiceMail Utilities

• Open PhonePro VoiceMail Mailbox: This brings up a list of all 
users that have been entered into the PhonePro voice mail table. 
You can select a user and access their voice mail.

• PhonePro VoiceMail users: A table of people is maintained for 
PhonePro VoiceMail by using this command from the Utilities 
menu. Each user must have a mailbox location specified which 
can be a folder on a local or remote hard disk. This mailbox loca-
tion can be accessible from that user’s station over a network, or 
messages can be retrieved remotely over the telephone using a 
script created for this purpose.

When using PhonePro VoiceMail, the Log On Mail Server icon is used 
to identify which user of the PhonePro Voice Mail system is currently 
accessing their mailbox or sending messages.
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By default, the User Name and Password specified in the E-Mail Pref-
erences is used as the originator for messages, but this can be changed 
by “logging on” at the icon as another user of the PhonePro Voice Mail 
system. The originator of the message will then be displayed as the 
name of the file.

If multiple messages are received from the same originator, a “#” and 
an incremental number are assigned to the name of the file.

Messages are deleted by dragging them to the trash. The sender of the 
message is typically identified by the name of the sound file. Further 
information about each message can be accessed by selecting Get Info 
from the Finder’s File menu.

For more information about PhonePro VoiceMail, please refer to 
Chapter 8.

3.5.4. Telephony Hardware Control

• Call Progress Trainer: Allows you to configure PhonePro for 
detecting call progress tones applicable to your phone system. See 
Chapter 9 for more information.

• Hang Up Phone: Allows you to disconnect the phone when you 
are using a headset.

• Reset Hardware: Resets the modem if it is off hook, or other-wise 
in the wrong state.

3.6. Windows Menu
• Show/Hide palettes: These commands allow a palette to be dis-

played or put away as required.

• Tile Windows: This arranges all the open script windows neatly 
next to each other on the screen.

• Stack Windows: This places all open script windows one on top of 
the other so that their title bars can all be seen.
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4.
Data Handling

This chapter explains how PhonePro handles the information it needs 
to accomplish its tasks. It is possible to use data of various data types 
(such as numbers, text, telephone numbers and sounds) in PhonePro 
scripts. Single data items are variables (which can be changed during 
script execution) and values (which do not change). Tables provide a 
way to organize and store multiple related pieces of information.

4.1. Data Types
PhonePro allows you to assign one of several Data Types to a variable, 
table field, or constant value. Data Types make configuration of icons 
as simple as possible, and are intended to reduce errors in creating a 
successful script.

• Text Type: This type is used for names, addresses, and other infor-
mation that’s from zero to 255 characters. Any printable character 
that can be typed on the keyboard can be included in script ele-
ments of this data type.



Data Handling

48

• Number Type: This type is used to store whole numbers (inte-
gers) from -2,147,483,648 to +2,147,483,647. Any value between 
these two limits, inclusive, can be stored in a script element of this 
data type.

• Decimal Type: Decimal numbers from 1.5x10 -45 to 3.4x10 38 can 
be stored in script elements of this data type. Two places to the 
right of the decimal point are maintained.

• Phone Number Type: Valid touch tone characters, “0”, “1”, “2”, 
“3”, “4”, “5”, “6”, “7”, “8”, “9”, “A”, “B”, “C”, “D”, “#”, “*”, “!” 
(the “hookswitch flash” character), and “,” (the “pause” character) 
can all be stored in elements of this data type. Hyphens, parenthe-
sis, and quotation mark characters (used to indicate area or coun-
try codes in a telephone number, for example) are also permitted 
but ignored when telephone numbers are dialed.

• Sound Type: Sounds are ‘snd ’ resources stored in script files, 
shared files, the common file, and table files.

• Day Type: Elements of the Day Type represent Sunday, Monday, 
Tuesday, Wednesday, Thursday, Friday or Saturday.

• Date Type: The Date Type is used to store calendar days. 
PhonePro can easily translate dates to its format from almost any 
entered format. The default format is dd-mmm-yyyy (for exam-
ple, 15-Jan-1993).

• Time Type: Elements of scripts that are Time Type represent times 
of a particular day, and can also be used to signify elapsed tim-
ings. For example, a Time Type field in a table might contain 
4:31:22 A.M. Times are stored with seconds, but by default sec-
onds are not “spoken” over the telephone line.

• Boolean Type: The Boolean Type allows you to specify a True or 
False condition. You might use this when, for example, you need 
to activate features in a script that normally are dormant, such as 
sending voice messages to a user's mailbox rather than to a partic-
ular folder, or using Speech Manager to “speak” text stored in a 
table field or a variable rather then simply playing a sound.
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• Text File Link: Standard text-only files are accessed from script 
elements that are Text File Link type.

• Sound File Link: Sounds may be stored in separate sound files in 
both ‘sfil’ and “AIFF” format. The Sound File Link data type is 
used to store references to sound files so that they can be accessed 
by PhonePro scripts.

• Script File Link: PhonePro script files are accessed from script ele-
ments that are Script File Link type. For example, the Launch 
Script icon requires data of the Script File data type.

• Table File Link: PhonePro tables are accessed from script ele-
ments that are of Table File Link types. One table can point to 
another if it has a field of this data type.

• Any File Link: Any Macintosh file can be accessed from elements 
of this data type.

• Path To Folder Type: This data type is used to identify a folder on 
a hard disk. For example, PhonePro VoiceMail uses a field of this 
data type to identify mailbox folders.

• Path To File Type: This data type is used to identify an arbitrary 
file that need to exist. For example, the Record Message icon 
allows sound to be recorded to a file specified by a variable of the 
Path To File data type. Unlike sound files referenced by Sound File 
Links, the destination file need not exist in advance.

• VoiceMail Address: This data type is used to specify the mailbox 
for a user of a mail system. This data type would be used to iden-
tify the mailbox that users wish to have voice mail messages sent 
to from an answering machine or a Call Attendant-type script.

4.2. Variables
Variables are pieces of information which can change depending on 
the actions of the script. For instance, “Number of Calls Received” 
could be a variable as it would change regularly as calls come in.
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4.2.1. Script, Shared, and Common elements

Variables, like other script elements, can be drawn from three possible 
sources, represented by the three radio buttons in the top right corner 
of the:

• Script
You can attach variables to the current script, in which case 
they will not be available from any other script file.

• Shared
Variables can be shared, in which case they are placed in a 
shared file and are accessible by opening that file from any 
script. 

• Common
Variables can be Common, which means they are automati-
cally available to any script on a given Macintosh computer.

4.2.2. Creating Variables

New variables can be created using the Data Browser, or, directly in an 
icon’s configuration window. 

Creating variables directly in icon configuration windows is a simple 
operation. Suppose, for example, that you wish to store a sound you 
record from the phone line in a variable. Configuring the Record Mes-
sage icon is simply a matter of selecting where in the script you want 
to store the recorded message — in this case, choose Variable from the 
pop-up menu to the left — then choosing the variable you want to use 
to store the message from the pop-up menu labeled Variable. If you 
have not yet created a variable to use, simply choose “Add New…” 
from that same menu and PhonePro will prompt you to select a vari-
able type, to name the variable and to save it. You can choose to save 
variables, pre-recorded sounds, and file links in the script itself (indi-
cated by the script name), in a common file that all PhonePro scripts 
will use, or in a “shared file” that more than one script will share. 
Choose your option from the pop-up menu labeled File.
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To create a new variable using the Data Browser, choose “Variables” 
from the pop-up menu on the left side and use controls on the right 
side to identify the file radio button corresponding to the and click the 
Select Variable button. Both lead to the Variable List.

Click the “Add New” button. This displays the “Select New Variable 
Type” window.

Figure 4-1. Creating a New Variable Using the Data Browser
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Double-click on the data type you want your variable to have, or select 
it and click OK. This presents the Variable Editor, where you can name 
and assign a value to your new variable or, if it is a sound, record it 
using the Sound Recording controls.

4.3. Tables
A PhonePro table is a collection of records, each of which may contain 
up to twenty-four fields. Each field contains one piece of information 
of a specific data type. You set the contents and the data types of each 
field. A PhonePro table file is similar to a spreadsheet file in which the 
rows are records and the columns are fields.

Figure 4-2. Variable Editor
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4.3.1. Creating a Table

Before you begin creating your table, you need to decide what fields 
you want. Each field stores a different data type or category of infor-
mation which must be specified before anything can be stored in the 
table.

Although you can change the fields later on, this should be done with 
care. If you change the type of information a field contains, you will 
lose all the contents of the changed fields.

1. Select “New Table” from the Table Menu. The New Table dialog 
box appears.

2. For each field in the table, enter a name for the field and use the 
pop-up menu to set its data type. IMPORTANT: Table files may not 
be larger than 16MB in size. If you plan to associate one or more sounds 
with a record and anticipate having a large number of records you should 
store the sounds in separate files by using the PathToFile data type rather 
than the Sound data type.

Figure 4-3. New Table Dialog
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3. You may specify that an entry is required for all records. Use this 
when, for example, you need a name and a password to be able to 
log onto a mail server to send voice messages. The effect of click-
ing the “Required” checkbox is to prevent a user from moving to a 
new table record until the required field in when editing the table. 
Those who construct scripts with front ends will probably find 
this most valuable.

4. Clicking the “Unique” checkbox for a given field tells PhonePro to 
prevent a user from entering a number, text, or other value for this 
field that t already exists in another record in the table. This will 
enable you to prevent duplication among your table records for 
key fields. Say, for example, that you want to prevent users on a 
small voicemail system from picking the same password to use 
when calling in to retrieve their messages — perhaps because the 
users all know and can enter each others' names. Unique pass-
words might be the only way to prevent listeners from retrieving 
each others' messages in this instance. Clicking the Unique check-
box will require each user in you voice mail users' table to enter a 
unique password or sequence of digits.

5. Click “Add” to add each new field to the table. If you make a mis-
take can you remove a field by selecting it and clicking “Remove” 
or correct it by entering the correct parameters and clicking 
“Replace”.

6. You must complete these steps for each field you want to include 
in your table. You can have a maximum of twenty-four fields in a 
table, but you do not have to use all twenty-four. It is important 
that the field data type be set accurately (please see Data Types 
earlier in this chapter) as PhonePro uses this information to deter-
mine which operations may be performed on it.

7. When you have finished specifying all the fields for the new table, 
click OK. 

8. Name the table using the directory dialog box. It will be saved 
automatically.
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4.3.2. Opening and Browsing Tables

1. Select the Open Table command from the Table menu.

2. Locate the table to open in the directory dialog box which appears.

3. The Table Browser is then presented. The Browser allows you to see 
the contents of one field. To view the contents of another field, select it 
from the pop-up menu located next to “Field Shown”.

To view individual records, double-click on a record in the Table 
Browser and the Table Editor will appear, showing the complete 
record. 

The Table Browser has the following buttons:

• Add New: Displays the Table Editor with a new record.

• Edit: Displays the Table Editor the all the fields from the selected 
record.

Figure 4-4. Table Browser
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• Remove: deletes an entire record.

• Sort: arranges records first to last in alphabetical or numerical 
order.

Important: If the contents of a record contain digits, the sorted 
result may not be truly numerical. Alphabetically, the number 11 
comes after 1 but before 2 and all digits appear before letters. Fields 
of number and decimal data types are sorted by numeric value.

• OK: When you have finished browsing the table, click OK.

Table Editor

Double clicking on a record, selecting a record and clicking “Edit” and 
clicking “New” in the Table Browser all result in the Table Editor being 
displayed. The Table Editor window shows all the fields in a given 
record and allows them to be edited. Navigate through the records by 

Figure 4-5. Table Editor
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clicking the Previous, Next, First, and Last buttons. Other options in 
the Table Editor window are adding a new record, duplicating the cur-
rent record (hold down the option key), removing the record, remov-
ing all records (hold down the option key), and finding a particular 
value or repeating a find operation (with the option key). Click 
“Done” to close the Table Editor Window.

4.3.3. Changing a Table’s Structure

To add, remove, rename. or change the data type of field tables, select 
“Restructure” command from the Table menu.

This restructure command presents a directory dialog box from which 
you select the table file that you wish to update. When you have 
selected a file, you can change its structure using the Table Restructur-
ing dialog box which appears. This dialog box is similar to the New 
Table dialog box, except that it contains the format for the selected 
table file instead of an empty format.

Important: Remember that you will lose the data in a field if you change its 
data type.

4.3.4. Recovering a Table

If a table’s basic file structure (its “map”) becomes corrupted, the 
Recover Table function (the “Recover” command on the “Tables” 
menu) can be used to rebuild it. PhonePro will often suggest this when 
it is necessary.

Recovering a table will not necessarily maintain the data intact. If the 
file is severely damaged, some data may be lost.

4.3.5. Importing a Table

Any tab-delimited text file can be imported into PhonePro for use as a 
table. A single Tab character delimits fields and a Carriage Return 
character delimits records.



Data Handling

58

In creating such a file, the first row of information can be the name of 
each field, the second row the data type and then each record is listed 
in subsequent rows. The general format is fields in columns, records in 
rows, and each table in a separate file. If the table to be imported does 
not have the name and data types listed, the PhonePro table file into 
which it is being imported will provide the format for the table. 
Remember that the maximum number of fields in a table is twenty-
four.

To import a tab-delimited text file:

1. Select Import Table from the Table menu.

2. A directory dialog box appears. Choose a file to import.

3. A box then asks, “Does the Text File Contain Field Names and 
Types?”

If you select the Yes button, a box asks whether you want to 
“Append to an Existing Table”. Select the Yes button and a 
directory dialog box brings up a list of tables to append to. 
Choose the table and the box closes automatically.
If you don’t want to append the text file to an existing table, 
select the “No” button and you will be asked to name the new 
table.
If the text file does not contain field names and data types, 
then PhonePro will assume that you are appending the text 
file to an existing table file. In this case, it automatically dis-
plays a list of table files for you to choose from.

4.3.6. Exporting Tables

PhonePro can export a table into a tab-delimited text file which can 
easily be read by other software packages. To export a table:

1. Select the Export Table command from the Table menu. A dialog 
box appears from which you can select the table to export.
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2. Click Save and name the exported table and select the appropriate 
folder. The exported table will be a tab-delimited text file which 
can be opened by any application that can read tab-delimited files 
(for example, Microsoft Word, Excel, StatView, etc.).

4.3.7. Customizing the Table Editor User Interface

You may specify custom ‘DLOG’ resource to be used to format a cus-
tomized dialog box in place of the standard dialog boxes used for edit-
ing tables. To create a custom dialog:

1. Use a resource editor such as ResEdit or Resourcerer to open the 
PhonePro application.

2. Copy ‘DLOG’ number 1000 and ‘DITL’ number 1000 out of the 
PhonePro application into the Table file that requires a custom 
interface.

3. Renumber them both to another number between 1002 and 1999.

4. Open the DLOG and make sure it points to the DITL you just 
renumbered.

5. Edit the DLOG and DITL to satisfy your requirements for a cus-
tom table editor. You can add as many items as you want to the 
dialog, and you can move and resize the items already in the dia-
log.

6. Be sure not to renumber or remove any items numbered lower 
than 130. You can, however, move them outside of the displayed 
area of the dialog to hide them.

For information about editing DITL and DLOG resources, please see 
the documentation that accompanies your editor (ResEdit or Resor-
cerer).
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This is an advanced feature. Additional requirements and recommen-
dations include:

• We'd recommend NOT moving Edit Text fields that correspond to 
text-based fields out of the visible area. This may cause editing 
problems.

• Do not include any PICT or ICON items in the table, as these 
resources are not supported.

• Your custom DLOG and DITL resources may be placed in the 
PhonePro application itself, but it is recommended that they be 
placed in the appropriate table file.

• Note that sound fields are placed by the position of the Edit Text 
item for the respective field.

• Also, note that if you change Radio Buttons to checkboxes, you 
should only change the “yes” button to a checkbox and then hide 
the other radio button. Changing both radio buttons to check-
boxes will result in an error.
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5.
Sounds

This chapter describes how to record, edit, and store sound files in 
PhonePro.

5.1. Managing Sounds
PhonePro supports playing and recording sound files (both ‘sfil’ and 
‘AIFF’ type) as well as Macintosh sound resources (‘snd ‘s) stored in 
PhonePro script files, table files, shared files, and the common resource 
file.

Sound constants are sound resources stored in script files, shared files, 
and the common resource file that are referenced directly. These are 
typically recorded by the developer of a script and are not deleted or 
re-recorded by the script.

You can configure variables and table fields to be of type “sound file 
link” which means that they contain a reference to an external file con-
taining a single sound.

You can configure variables and table fields to be of type “sound” 
which means that they correspond to sound resource which are typi-
cally recorded and/or deleted during script execution.
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5.2. Working with Sounds in PhonePro
PhonePro provides a consistent way of recording, listening to, and 
editing sounds known as the “Sound Recording Buttons”. You will see 
this group of controls frequently when you are working with sounds 
while developing PhonePro scripts.

In the area just below the buttons PhonePro displays the current 
length of the sound.

The first button is the Record button, the second is Play, and the third 
is Edit. In addition to the three primary buttons, clicking on the Record 
button while holding down the option key allows a sound to be 
imported rather than recorded.

5.2.1. Record

This button records a new sound for the sound currently being 
worked on. When clicked it may display a confirmation box if this is 
enabled in the Recording preferences panel.

If the “Cancel” button in the confirmation dialog box is clicked, the 
recording is aborted. If the “Record Now” button in the confirmation 
dialog box is clicked, sound is recorded from the sound input device 
specified through the Macintosh Sound control panel (or SoundSource 
control strip).

During recording, the cursor becomes a “Click to Stop” cursor. Record-
ing will stop when you click anywhere.

When using built-in microphones and or an Apple external microphone, 
speak from a distance of 12-16 inches for best results.

Figure 5-1. The Sound Recording Buttons
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5.2.2. Sound Import Button

The sound import option button allows sounds to be easily imported 
from other environments. By holding down the Option key and click-
ing on the Record icon, a sound can be imported from any sound 
resource file.

Note: The sound import button imports sound resources (‘snd ‘ resources). It 
does not convert sounds stored in AIFF files into sound resources. 

Once you’ve option-clicked in the left-hand button, a Standard File 
dialog is displayed. Select the file which contains the sound resource 
you wish to import. After a file has been selected, a list of the ‘snd ‘ 
resources in that file will be displayed.

You can preview any of the sounds in the file. A single sounds can be 
imported, by selecting it and clicking “Import”. The contents of the 
sound resource will then be copied into the script, shared, or common 
file as it you had just recorded it.

5.2.3. Play

The Play Button plays the current sound.

During playing, the pointer cursor a “Click to Stop” cursor indicating 
that the sound playback can be interrupted by clicking the mouse but-
ton.

5.2.4. Edit

PhonePro includes a sound editor application named “MPC Sound 
Shop” which can be used to “clean up” sounds. This editor provides a 
graphic display of the waveform for a sound and includes Cut, Copy, 
Paste, and Clear functions.

MPC Sound Shop launches automatically when you click the Sound 
Edit button. In addition to editing recorded sounds using a waveform 
view, MPC Sound Shop will allow you to open more than one sound at 
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a time, cut and paste between sounds, and change a sound's compres-
sion, file formatting, sampling rate, and bit depth. See the section on 
MPC Sound Shop below.

5.3. MPC Sound Shop
You can use MPC Sound Shop by clicking the “Sound Edit” button in 
PhonePro or by launching it from the Finder and using it to open any 
AIFF or sound resource file.

To open an arbitrary sound resource file use the “Open” command in 
MPC Sounds Shop’s File menu and locate a file that contains the 
desired sound resources. MPC Sound Shop will list those resources in 
a window titled "[Filename] Sounds”, initially by name. Click the 
other field headings shown in this window — Resource ID#, length (in 
seconds), or size (in bytes) — to sort by that field. Double-click a sound 
in this list to open it and MPC Sound Shop will show you the sound’s 
waveform in a sound editing window.

An AIFF file contains only a single sound so Sound Shop simply opens 
the AIFF data in a sound editing window. You can edit and 
savechanges to the AIFF file and you can copy portions of the AIFF 
wave form to other sound editing windows. You cannot create a new 
AIFF sound file using MPC Sound Shop.

If you want to make a new sound resource, perhaps one you can use to 
join together parts of two sounds taken from elsewhere, choose “Make 
New Sound” from the Sound menu and MPC Sound Shop will create a 
new, untitled sound editing window.

5.3.1. Viewing Sounds

The magnifying glass button lets you zoom in and out on a sound in 
discrete jumps. Alternatively, click the upward-pointing or down-
ward-pointing arrows to increase the detail shown in the window (but 
decrease how much of the entire sound you can see) or decrease the 
detail shown in the window (and increase how much of the entire 
sound you can see) one step at a time. Numbers to the left of the arrow 



Editing Sounds

65

buttons show how many samples each pixel displays — for example, 1 
over 22 indicates that each screen pixel displays 22 samples. You can 
also reverse the ratio, so that each sample requires 22 pixels to display. 
This allows you to edit your sound in detail as fine as you wish. Along 
the bottom of the window, MPC Sound Shop displays the sound 
length in seconds or fractions of seconds, depending on how closely 
you've zoomed in.

In the Options menu you will find two settings: “Zoom sounds on 
opening”, and “Always fit to window”. The first option will cause 
Sound Shop to zoom sounds to the full size of your monitor when you 
open them, useful for detailed editing. The second option will adjust 
your scale factor so that the entire sound is displayed in the window. 
You can still zoom in and out manually, of course.

5.3.2. Editing Sounds

To edit a sound you've opened, click and drag a portion of the sound 
wave to select it. Then click the Play button to play it, or use standard 
Macintosh cut, copy and paste commands to add or remove portions 
of the waveform.

MPC Sound Shop also allows you to record new sounds (or re-record 
over previous recordings) by clicking the Record button. When you 
have finished recording and editing your sound(s), choose Save As 
from the File menu, name it and save it to your hard drive. MPC 
Sound Shop will continue to display the sound in the window you've 
opened.

To copy a sound you have recorded or imported using MPC Sound 
Shop into a PhonePro script:

1. Open the PhonePro script. (MPC Sound Shop will display any 
sound resources contained in that script, if any exist.)

2. Choose a sound from an open MPC Sound Shop window and 
choose Copy from the Edit menu or press Command-C.
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3. Click the window that corresponds to your open PhonePro script 
to select it

4. Choose Paste from the Edit menu or press Command-V. MPC 
Sound Shop will copy your sound into the open PhonePro script.

5.3.3. Sound Conversion

Sound conversion functions are available by selecting a sound for edit-
ing and choosing Get Info from the Sound menu. The Get Info win-
dow shows the sound's name, Resource ID number, compression/file 
formatting, sample rate, bit depth, number of samples, length in sec-
onds and size in bytes. We recommend making a copy of any sound 
you want to alter and saving it with a different name before perform-
ing any conversions to avoid any unintentional data loss. Choose dif-
ferent compression ratios, sample rates and bit depths from the 
appropriate pop-up menus and click Converted to hear the new 
sound. If you like the way it sounds, click Save to save your new set-
tings. If you want to hear the original sound to compare it with the 
new settings, click Original. If you don't like what you hear, click Can-
cel to leave your sound untouched.

5.3.4. Sound Effects

Sound Shop supports plug-in sound effects. Amplification, Fade in/
out, Normalize, and Tone generation are included. To apply a sound 
effect, select the waveform and choose the desired effect from the 
Effects submenu under the Sound menu.
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6.
AppleScript 

Support

PhonePro is scriptable using AppleScript (or any Open Scripting 
Architecture language that uses Apple events).

In addition to being scriptable, PhonePro scripts can build and run 
AppleScripts while executing (handling telephone calls, etc.). Refer to 
Chapter 10 for information about the “Build AppleScript” and “Run 
AppleScript” icons.

6.0.1. Opening a PhonePro Script

You can instruct PhonePro to open a script by specifying the complete 
pathname:

Open “My HD:Script Folder:Answer Phones”

A script must have already been opened by PhonePro in order to work 
with its contents using AppleScript.
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6.0.2. Do Script

Through Apple Events, you can specify a PhonePro script to execute. 
Here’s an example showing a PhonePro script called “Answer 
Phones” being launched from within AppleScript:

Do Script “Answer Phones”

6.0.3. Get Data and Set Data

Here’s an example of setting the value of a script variable with Apple-
Script:

set Variable “PN To Dial” of Script File
“My Test” to “555-1212”

PhonePro looks through the open scripts for one called “My Test”. In 
this script, it looks for a variable called “PN To Dial” and sets it to 
“555-1212”. If you wish to set the value of a variable in a shared file, 
substitute “Shared File” for “Script File” in the above example.

Setting the value of a variable in the Common Resources file is a bit 
different, since you can’t specify a file name. Here’s an example of set-
ting a common variable:

set Common Variable “PN To Dial” to “555-1212”

6.0.4. Telephony Apple Events

PhonePro supports Telephony Apple Events. For more information 
about Telephony Apple Events, consult “The Telephony Suite”, a doc-
ument that makes up the Apple Event Registry available from Apple.
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7.
PhonePro Script 

Front Ends

To make it easier for others to use scripts, you can set up a Front End, 
or local user interface to your PhonePro script, which allow people to 
run scripts and view and edit data without having to see the script 
itself. A Front End is added to a script after it has been created and 
debugged. It allows a running PhonePro script to behave in a fashion 
similar to standard Macintosh applications. 

A Front End is an excellent way to provide non-technical people with 
the full functionality of PhonePro without the need to train them in 
script development, while ensuring that their scripts are safe to use.

The Front End includes the standard Apple, File, and Edit menus 
along with a Utilities menus and a Scripts menu that lists all open 
scripts. (Note: The front end Scripts menu is not the same as the Script 
menu which is available when a Script window is open during devel-
opment). You can also create your own custom menus and menu com-
mands.

Note: A Front End “belongs” to a particular script. This script must be func-
tional (even if it just consists of a Go and a Stop icon).
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7.1. Configuring the Front End
Choose the Configure Front End command from the Script menu to 
activate a given script’s front end and to specify the parameters for it. 
The dialog box shown in Figure 8.3 appears:

The “Captive Script” checkbox determines whether or not this script 
opens as an editable script or a captive script. This must be checked in 
order to activate the Front End for the script. This setting will take 
effect the next time this script file is opened. To access a captive script 
for editing using PhonePro’s development tools, hold down the option 
key while selecting it from the Scripts or Windows menu.

Figure 7-1. 
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The “Author Name” and “About Box Text” are optional. When run-
ning a captive script the Front End includes an “About…” command 
to the Apple menu that displays a standard information box for the 
script. The text and author you enter here will display in this “About 
Box”.

If you wish to restrict access to a captive script to prevent user from 
modifying it use the “Password” field. Enter the password that will be 
required to open a captive script for editing using PhonePro’s devel-
opment tools. The password is optional. If you leave this empty, no 
password will be requested when an attempt is made to access the 
script.

The options available from the Configure Front End dialog box are as 
follows:

• Make Sub-Script: If this box is checked, the script can only be exe-
cuted when run by a Launch Script icon in another script. This 
option does not prevent you from simulating the script.

• Auto Run on Loading: When the script is opened, it will run auto-
matically.

• Hide Sub-Scripts: Any scripts launched by this script (with a 
Launch Script icon) will be hidden.

• Always Auto-Save Scripts: The script is always saved before clos-
ing without prompting the user. This is an important option if 
your script makes any changes to its own variables.

• Enable “Run” menu while captive: If this box is checked, the 
“Run” command will appear in the File menu of this script’s front 
end.

• Enable “Simulate” menu while captive: If this box is checked, the 
“Simulate” command will appear in the File menu of this script’s 
front end.

• Enable “Close” menu while captive: If this box is checked, the 
“Close” command will appear in the File menu of this script’s 
front end.
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• Enable “Auto-Run” menu while captive: If this box is checked, the 
“Auto-Run” command will appear in the File menu of this script’s 
front end.

• Display captive Scripts menu. If this box is checked, the Scripts 
menu will be included in this script’s front end.

Note: If you use captive scripts, write their passwords down! If you forget a 
password, there is no way to get to the script window again.

7.2. Creating Front End Menus
To make custom menus for an open script, select “Configure Front End 
Menus” from the Script menu. The dialog box in Figure 7-2. appears.

Click the “Add Menu” button under the Captive Menus list on the left 
to add a new Front End menu. Name the menu when prompted and it 
will be added to the Captive Menus list and highlighted.

Figure 7-2. Front End Menu Configuration
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To add “commands” to the new menu, click the Add Item button 
under the Menu Items list on the right and assign a name to the item 
by typing it when prompted. It will then appear, highlighted, in the 
Items list.

To remove a menu or menu item from the lists, select it and click the 
“Remove” button under the appropriate list.

To rename a menu or menu item, select it and click the “Rename” but-
ton, then assign the new name.

Once commands have been added to your menu, they can be linked to 
the appropriate elements in the script.

Remember that the Front End menus “belong” to a script, so if a Front End 
command causes another script to be launched, the menubar will be updated 
to correspond to the menus appropriate for the newly-launched script.

7.3. Linking Menus to Data
To assign an action to a menu item, select an entry in the Menu Items 
list, and click the “Link To…” button at the right of the window. The 
Menu Item Editor appears, with the menu item’s name at the top, as 
shown in Figure 7-3..

When a command is chosen from a Front End menu, an action can be 
initiated on one of the following:

1. A dialog box permitting the user to enter the value for a particular 
variable can be displayed.

2. A dialog box permitting the user to access a particular sound can 
be displayed.

3. The script can be executed starting at an arbitrary icon (rather 
than the Go icon). A dialog box can optionally be displayed before 
the script is executed and the script may be run normally or in 
simulation mode.
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4. Another script file can be opened or executed. A dialog box can 
optionally be displayed before the script is executed and the script 
may be run normally or in simulation mode.

5. A table file function can be invoked. Options include viewing the 
contents of the table with the Table Browser and Table Editor, 
importing data into the table (either appending or replacing exist-
ing data), and exporting data from the table.

6. A dialog box permitting the user to access a linked sound file can 
be displayed.

To configure a particular menu item use the Menu Item Editor to set 
the following:

• Dialog text: Enter the instructions for the user associated with this 
command. This should a short piece of text that clearly identifies 
the kind of data involved, and what the user should do with it.

Figure 7-3. The Front End Menu Item Editor
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• Help text: Enter the text that you want to appear when the user 
clicks the Help button in the dialog box they are presented with.

• Link to: Select the type of link desired (variable, sound, start at 
icon, script file, table file, or sound file) to be linked using the pop-
up menu at the left, and then specify the item using the pop-up 
menus on the right.

• Depending upon the type of link selected, various options will 
appear. Select the desired option using the pop-up menu or check-
box.

7.4. Testing Front End Menus
In most cases, to see how the menu that you have just configured 
would look to the user, you don’t have to exit the Menu Item editor—
just click the “Test” button. The dialog box which the user will see 
after choosing the menu item will appear. Click OK or Cancel to exit 
the test dialog box. Note: Menus that execute or open scripts cannot be 
tested with the test button.



PhonePro Script Front Ends

76



77

8.
VoiceMail

8.1. PhonePro VoiceMail
A simple but complete VoiceMail system is built directly into 
PhonePro. This system takes advantage of the Macintosh file system to 
create user mailboxes to hold voicemail messages using folders.

PhonePro VoiceMail is designed to be simple and intuitive. Any folder 
on a local or remote hard disk can be designated a “mailbox”, and 
VoiceMail messages can be saved, reviewed, and deleted remotely via 
a PhonePro script and through the PhonePro application interface. In 
addition, messages can be played directly from the Finder simply by 
double-clicking on the files. The individual messages are stored as 
‘sfil ’ files, a special file type that the System 7.0 (and later) Finder can 
play directly without opening any application.

This approach offers a great deal of flexibility for the PhonePro devel-
oper and for clients of the mail system. For example, a file server (ded-
icated or not) could be made as the central storage location for 
VoiceMail messages. A “Mailboxes” folder could be created on one of 
its attached volumes, and individual folders inside of this folder could 
be created for each client. In this way, the client’s computers don’t 
have to be on continuously for VoiceMail to be readily available.
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Users can then check their VoiceMail mailbox by mounting the volume 
containing the voice mailboxes and opening their folder. Alternatively, 
the separate folders can each be “shared” independently, and access 
privileges can be assigned to each folder so that only the “owner” can 
access the messages stored there.

Messages can be reviewed by double-clicking on the files. Messages 
can be deleted by dragging them to the trash can icon. Additional 
information about messages can be viewed by selecting Get Info… 
from the File menu in the Finder. This includes the subject of the mes-
sage, which is included when the message is sent.

The table of PhonePro VoiceMail users is maintained from the Utilities 
menu within the application. This is a special PhonePro table that is 
created automatically by PhonePro to track the locations of folders for 
VoiceMail mailboxes. Each record of the table represents one client of 
the PhonePro VoiceMail system.

Figures 10-2 and 10-3 show the table browser for PhonePro VoiceMail 
users. Each record contains five fields. The first field tracks the name of 
the client. The Password field is used by PhonePro when the Open 
PhonePro VoiceMail Mail-box… menu command is selected. Cur-
rently, no formal access restriction capability exists - if the client (or 
anyone else) can access a mailbox’s folder, they can listen to the Voice-
Mail messages inside. You can use the Password field from within a 
script to confirm the identify of a caller attempting to retrieve mes-
sages.

The Extension and Message fields are not used by the VoiceMail sys-
tem, and are for your use within scripts. They are provided as a conve-
nience only and may be changed to different data types if necessary.

Note: This table must contain the Name, Password, and Pathname fields in 
exactly the positions shown. You may use Change Format… on this table, 
but you must leave these three fields as named with the provided data 
types in the same positions within each record or PhonePro will func-
tion unpredictably.



PhonePro VoiceMail

79

After selecting the “Path…” button from the table viewer, the 
PhonePro VoiceMail administrator can locate any Finder folder as the 
location for this client’s VoiceMail messages. New folders can be cre-
ated from here as well. To select a folder as the location for messages 
for a client, select the folder by highlighting it in the list, and then 
select the “Select” button at the bottom of the dialog box.

You may wish to specify special sharing (or Access Privileges) for fold-
ers so that only the appropriate person can access a folder for retriev-
ing messages.

Important! If the name of the hard disk or any intermediate folders is 
changed, PhonePro will not be able to locate the folder to save or 
retrieve messages. If a folder or disk name is changed, mailboxes may 
need to be re-located through the “PhonePro VoiceMail Users” com-
mand in the Utilities menu.
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9.
Call Progress 

Trainer

The Call Progress Trainer is utility built into PhonePro that allows you 
to train PhonePro to recognize call progress tones (such as ringback 
and busy) on the telephone lines that you are using to deploy your 
application.

The Call Progress Trainer must be used to “train” PhonePro before you 
run a script which makes or transfers phone calls. Typically only one 
training session per combination of telephone tool and phone line 
(PBX or external telephone network) is required. However, informa-
tion about more than one type of phone system can be stored and used 
with PhonePro for improved recognition accuracy. Each training ses-
sion consists of producing and recording ringback, busy, and error 
conditions for a given phone system. During script execution 
PhonePro uses this “training” information to determine if a call 
attempt has succeeded or failed.

Different telephone systems use a variety of frequencies and patterns 
of tones to indicate to a caller whether a new outgoing call is ringing or 
busy. Therefore it is important to have a way to adapt easily to these 
different phone systems when operating sophisticated telephone 
applications like PhonePro.
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9.1. Using Call Progress Trainer
Call Progress Trainer is an easy way to train PhonePro to discriminate 
the call progress tones that may be present on your telephone line to 
indicate the status of outgoing calls and calls that have been trans-
ferred.

When Call Progress Trainer is first started, you’ll have an opportunity 
to “train from scratch”, in other words, with the assumption that no 
“training” has previously occurred and that there is no record of any 
tones which the Telephone Tool must recognize. This option simplifies 
the training process.

Training involves making a series of telephone calls to numbers whose 
“status” is known - they are identified as “busy” or “ringing”. Several 
calls are made to each number.

As you may have noticed, different telephone systems can sound sig-
nificantly different when a call is being placed to or from them. Call 
Progress Trainer can have multiple “ring” and “busy” “tone sets” for 
identifying the ringing and busy sounds generated by each of the tele-
phone systems it may encounter.

At a minimum, you must train the tool to recognize one “ringing” and 
one “busy” sound for your local telephone system. If you are using an 
internal system and will be making or transferring calls between that 
system and an outside one, you’ll need to train the tool to recognize 
two “busy” tone sets and two “ringing” tone sets, one for each phone 
system.

If you make international calls, tone sets for “busy” and “ringing” will 
be required for each type of tone encountered through these systems 
as well.

The numbers called for each “busy” or “ringing” training can be the 
same number, as long as the correct state is setup when Call Progress 
Trainer calls to accomplish its training.
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A series of questions will be asked for each new tone set, and it’s 
important that the telephone number being used to train the tool is 
“on hook” or “off hook” at the appropriate times for each set of calls.

The first question for each set requires that the set be identified as a 
“busy”, “ringing”, or a “reorder” tone. Click the button corresponding 
to the type of tone set you’ll be training for.

The next dialog box is where the “name” of the tone set is entered. Use 
a name that will describe the target telephone system and whether the 
set is a “busy”, “ringing”, or “reorder” set. This box is shown in Figure 
9.4, on the following page.

Finally the telephone number to dial as an example for the set is 
requested. Enter a number you know to be in the “state” (“busy”, 
“ringing”, or “reorder”) that you’re currently training the tool to rec-
ognize.

After this number is entered, Call Progress Trainer will place five tele-
phone calls to the number you specified. After each call, Call Progress 
Trainer will ask you if you want to include the call in the training (in 
case someone answers by mistake or some other problem occurs). 
When all five calls have been completed, you’ll be able to specify 
another tone set type or “Cancel” to complete the training.

When the training calls have been completed, you will see the Call 
Progress Trainer window.

The options available from the Call Progress Trainer are as follows:

• Easy Train: This button is used to add new tone sets, or can also be 
used to re-train the tool entirely. It initiates the series of questions 
described previously.

• Add New: This button displays the dialog box shown in Figure 9-
2. This dialog box is used to create and edit information con-
trained in the tone sets. It can be used to correct problems that are 
not resolved through the “Easy Train” mechanism.

• Remove: This button removes a tone set from the table.



Call Progress Trainer

84

• Quiz: This button will request a telephone number to call and 
attempt to identify the result of the call. If this does not yield the 
desired results, try re-training the tool. 

• Report: This button produces a text file report that may be of 
assistance when working with Technical Support.

• Help: This button accesses a number of help boxes for the Call 
Progress Trainer utility.

• Exit: This button stops execution of the Call Progress Trainer and 
saves the results in the appropriate Telephone Tool file.

Figure 9-1. Call Progress Trainer Window
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9.2. Trouble Shooting Call Progress Trainer
If your phone line is noisy, i.e. you hear scratchy static noises when 
you make an outbound call, PhonePro may have problems determin-
ing if a call has been answered.   When you use Call Progress Trainer, 
you can edit each sample and look at the call's chart.   A typical chart 
will look something like this:

If PhonePro is having trouble determining when your outbound calls 
are answered, check the line noise level. If it looks like your telephone 
line has line noise problems, then you have two options. 

1. You should contact your local telephone company and ask them 
what can be done to correct the problem.

2. You can go into the settings window in Call Progress Trainer. If 
you change the Threshold to a higher level, making it average 
instead of minimum, then you will probably have better results.

Figure 9-2. 
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Figure 9-3. 
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10.
PhonePro Icons

This chapter provides a detailed description of each PhonePro icon 
and its configuration. It is intended as a reference when writing appli-
cations with PhonePro.

PhonePro Icons are grouped into palettes: Core Palette, Phone Palette, 
Table Palette, Files Palette, VoiceMail Palette, User Palette, Modem 
Palette, and Fax Palette. This chapter is organized by palette and each 
PhonePro icon is documented in the same logical sequence it appears 
in its respective palette.

Each icon definition consists of a brief Description of the icon’s func-
tion; details of the possible Choices in Configuration; some Examples 
of Use and any Special Considerations which are relevant.

10.1. Overview
There are generally two kinds of PhonePro icons:

• Flow of Control icons
• Functional icons

Functional icons carry out specific tasks while Flow of Control icons 
are used to determine how execution will flow through a script.
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10.1.1. Flow of Control Icons

Flow of Control icons can be identified by the triangle, diamond, or 
octagon they contain. Some Flow of Control icons have inbound con-
nectors. These icons are used within scripts to determine where script 
execution will proceed.

In addition, there are Flow of Control Icons that have no inbound con-
nectors. These are known as “Event Catchers”. When certain events 
occur execution of the script jumps to the appropriate event catching 
icon if it exists.

Every PhonePro script must contain exactly one Go icon. This icon 
determines where execution will begin in the event that the script is 
run. PhonePro automatically places a Go icon at the top of each script 
window so this icon doesn’t appear in any palette.

10.1.2. Paths

Description:

Paths are used to connect icons in a script. Script execution progresses 
from the outbound connector of the one icon to the inbound connector 
of a second icon.

See Chapter 2, section 2.4, for a review of defining logic flow using 
icons and paths.

Figure 10-1. Flow of Control Icons with Inbound Connectors

Figure 10-2. Event Catchers
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Choices in Configuration:

In general, paths don’t need to be configured. The exceptions are paths 
connected to the outbound connector of Touch Tone Menu and Text 
Menu icons. Please refer to the description of the Touch Tone Menu 
and Text Menu icons for full information.

Special Considerations: 

In a script window, paths drawn in gray are not connected at both 
ends. Paths drawn in black are completely connected.

Paths should connect the outbound connector of one icon to the 
inbound connector of another icon. A path can’t be drawn between 
two inbound or two outbound connectors. With the exception of menu 
icons (described above), avoid connecting two paths to the same type 
of connector as this will produce a Fatal Script Error upon execution.

10.2. Core Palette

10.2.1. Script Annotation Tool

Description:

Use this tool to add notes to a script. Documenting the functions of dif-
ferent groups of icons in a script is important for making your scripts 
easy to debug, maintain, and extend.

Figure 10-3. Paths Associated with Menu Icons
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Choices in Configuration:

Type text into the text box. Use the Font, Margin, Alignment, and Size 
pop-ups to create the desired text style. Check the arrow checkbox to 
attach an arrow, so that the text can be visually connected to a specific 
part of the script.

Special Considerations: 

The whole box enclosing the text annotation can be moved about the 
script as if it were an icon. You can also drag and re-size the text box as 
desired by dragging the “handle” that appears in the lower right cor-
ner of the enclosing rectangle when the block of text is selected. The 
arrow, if one is used, may be adjusted for size and position by drag-
ging its handle to the desired spot.

Examples of Use:

This is useful for providing documentation as part of a script so that 
another person can easily understand how the script executes.

10.2.2. Rectangle Tool

Description:

The Rectangle tool is used to draw cosmetic boxes in the script win-
dow. It can be used to outline a group of icons for viewing purposes, 
or to draw attention to notes contained in the script.

In a large script with many groups of icons, cosmetic rectangles can 
improve the clarity and readability of the script.

Choices in Configuration:

This box can be dragged to a desired location in the script window and 
re-sized using the handle that appears at the box’s lower right corner 
when it is selected. The thickness of the rectangle’s border can be set 
by double-clicking inside the rectangle.
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Special Considerations: 

None.

Examples of Use:

Using the Cosmetic Rectangle icon, outline a segment of a larger script 
to make it easier to see and more readable. Also, place a rectangle 
around script annotation to distinguish it from the rest of the script.

10.2.3. Assign Value

Description:

Assigns the value of one variable, table field or constant to another 
variable or table field.

Choices in Configuration:

Under “Store Contents of”, select the source of data by clicking the 
appropriate button. Then, using the top “Select…”. button, select the 
specific data item by name (if you have clicked the “Value” radio but-
ton, a text box appears into which you type the value; no “Select” but-
ton appears in the top portion of the dialog box in this circumstance. 
Use the “Type” pop-up to give a data type to the item if it is a value.

Under “Into”, select the table field, variable, or sound that receives the 
copy of the data.

Special Considerations:

The source and destination must have the same data types, with one 
exception: an item of the text type (a name, for instance) may be 
assigned to a sound type as a way to rename the sound.

After an assignment, a copy of the data exists in both locations. If one 
copy is changed, the other remains unchanged.
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Examples of Use:

In a system in which PhonePro takes retail orders over the phone, the 
total value of a caller’s order may be temporarily stored in a variable. 
When the call is complete, this total is then assigned to a table field in 
that caller’s permanent record.

10.2.4. System Inquiry

Description:

This icon retrieves information from the Macintosh, such as the cur-
rent time of day, date, available disk space, and much more. System 
Inquiry information can be placed into a table field or a variable. The 
available information and corresponding data types are listed below:

• Current Day: Day

• Current Date: Date

Figure 10-4. Configuration Dialog Box for Assign Value Icon
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• Current Time: Time

• Name of Script: Text

• Number of Icons in Script: Number

• Time Script Execution Started: Time

• PhonePro Version Number: Text

• Start-up Disk Space Available: Number

• Last Fatal Script Error Number: Number

• Last Fatal Script Error Location: Text

• Last Fatal Script Error Description: Text

• Last Fatal Error Label #: Number

• PhonePro’s free memory: Number

• Random Number: Number

• Last record Interrupt Reason: Text

• Last Recording Length in Seconds: Number

• Current Telephone Tool Name: Text

• Telephone Number of this Line: Phone Number

• Volume Name of PhonePro Application: Text

• Speech Manager Available: Text

• Date/Time Stamp YYYY-MM-DD HH-MM-SS: Text

• Date Stamp YYYY-MM-DD: Text

• Time Stamp HH-MM-SS: Text

• Minute Stamp MM-SS: Text
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Choices in Configuration:

System Inquiry Type: Use this pop-up menu to select what type of 
information is to be retrieved. (See the list above.)

Store Result into: Select the variable or table field into which the 
selected information is stored. The data type of this variable or field 
must be the same as the data type designated above for the selected 
information.

Special Considerations: 

The result must be stored into a variable or table field of the same data 
type as the inquiry requested. Use the list of data types (above) as a 
guide.

Examples of Use:

To record the time of an incoming call, use System Inquiry to place the 
time of day into a field in the record for that incoming call.

Use one of the time/date stamp options to obtain a string of text that 
can be incorporated into a PathToFile type variable. 

Figure 10-5. Configuration Dialog Box for System Inquiry Icon
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10.2.5. Make Calculation

Description:

Uses information in a table field, variable, or constant to compute new 
values.

Choices in Configuration:

Take Contents of: Select the information to be used in the calculation. It 
can be a value that you enter here or it can be obtained from a variable 
or table field. The data type may be Text, Number, Decimal, Day, Time 
or Phone number.

Calculation Type: Use this pop-up to choose one of the avail-able oper-
ations for your calculation. These include Plus, Minus, Multiplication 
and Division, which are all self-explanatory. These may only be per-
formed on items which have the Number data type, except for plus, 
which can be used to add two strings of characters together.

Bit and: This is a binary operation which compares two binary num-
bers, returning 1 if both are 1 and 0 if either is 0. 101 AND 010, for 
example, would give the result 000.

Bit or: This is a binary operation which compares two binary numbers 
and returns 1 if either number is 1, or 0 if both are 0. 101 OR 010, for 
example, would give the result 111.

Mod: This gives the remainder from a division.

String Extracted from Left: Isolates the left-most characters in a string. 
You specify the string and number of characters to be isolated. A string 
left operation with five characters on the word “PhonePro” would 
give the result “Phone”.

String Extracted from Right: This is exactly like String Left, above, 
except that it will return the specified number of characters to the 
right-most of the specified string.
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Substring: This will return the location of the left-most character of a 
sequence of characters within a larger string. The location is expressed 
as the number of characters from the left of the larger string. It must be 
placed in a variable or table field with the number data type. If the 
substring is not found, the result is zero. If it is present more than once, 
only the position of the first one (the left-most one) will be re-turned. 
This operation is not case sensitive, so for example, “G” is considered 
to be the same as “g”.

...the contents of: Select the second part of the calculation. This infor-
mation can be a value you enter here, or the contents of a variable or 
table field.

Store Result Into: Select the variable or table field into which you wish 
to store the result. The type you select for this may affect the result. For 
instance, if the result type is Decimal, the division results in a decimal 
number. If, on the other hand, the result type is Number, the division 
returns a whole number and any remainder is lost. Valid data types 
are Text, Number, Decimal, Day, Time and Phone number.

Special Considerations: 

Items used in calculations must be of compatible data types.

Examples of Use:

Use this icon to create a loop counter. For instance, count the number 
of times a single caller attempts to enter a pass-code. Add the value 
“one” to a variable each time an invalid pass-code is entered, and, 
when a specified limit has been reached, disconnect the caller.

10.2.6. Delete Sound

Description:

This icon causes the script to delete a sound from the disk.
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Choices in Configuration:

Choose the sound you wish to delete. It may be a specific sound in the 
Sound Table, or it may be a sound stored in a table field or a variable. 
Data type must be Sound.

Special Considerations: 

This icon deletes the sound from disk, not just from a table field or 
variable which refers to it.

Figure 10-6. Configuration Dialog Box for Make Calculation Icon
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Other copies of the sound may exist if Sound Mover was used to copy 
the sound into more than one location, or if the Assign Value icon was 
used to copy the sound from one location to another.

10.2.7. Make Decision

Description:

This icon compares two table fields, variables or values and proceeds 
down the “-” or “+” paths, depending on whether the result is false or 
true, respectively.

Choices in Configuration:

If Contents of: Select one piece of information to compare with 
another. It may be a value or the contents of a table field or variable. 
Valid data types are Text, Number, Decimal, Day, Date, or Time.

Operation: Select the type of comparison. Available options are 
Greater Than, Less Than, Greater Than or Equal To, Less Than or 
Equal To, Equal, or Not Equal, Starts with string and Contains sub-
string.

Figure 10-7. Configuration Dialog Box for Delete Sound Icon
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...the contents of: Select the second piece of information to be com-
pared. It may be a value, variable, or table field and must be of the 
same type as the first piece of information.

Special Considerations: 

This icon can’t perform case-sensitive comparisons. Numbers in text 
are treated alphabetically, not numerically. Days, times and dates can 
be compared.

Examples of Use:

To play different greetings to callers depending on the time of day, a 
decision icon would be used to determine whether it was before or 
after a criterion time.

Figure 10-8. Configuration Dialog Box for Make Decision Icon
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10.2.8. Go To

Description:

Rather than draw a path, this icon directs the script to continue execu-
tion at a specified icon. This icon can be used as an alternative to a 
drawn path, which can improve the clarity of your scripts.

Choices in Configuration:

Use Select Icon Number to Go To: to enter the number of the icon at 
which the script should continue.

Special Considerations: 

While the Go To configuration box is on the screen, the scroll bars 
remain operational in the script window. This way, you may scroll 
around your script to find the icon to which the Go To should point. 
You can also re-size the script. All menus are disabled, however.

Examples of Use:

Avoid long, unwieldy paths with the Go To icon. It is very useful for 
returning a script to the Answer Phone icon when call processing is 
complete.

Figure 10-9. Configuration Dialog Box for Go To Icon
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10.2.9. Launch Script

Description:

This allows a secondary script (a “sub-script”) to be launched by the 
current script. When the launched sub-script is completed (a Stop 
Script icon is reached) PhonePro returns to the first script and executes 
the icon after the Launch Script icon.

Choices in Configuration:

Under “Script to Launch” select the sub-script to be launched. Its data 
type must be Script File and it can be selected directly or obtained 
from a table field.

Special Considerations: 

Be sure there is a Stop Script icon in the launched sub-script, so that 
the launching script may regain control from the script that was 
launched.

Figure 10-10. Go To Icon Configuration Using a Variable
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Examples of Use:

This is useful if each member of your staff wishes to have a different 
voice mail script. Launch that member’s script from within a master 
script.

10.2.10. Stop Script

Description:

This icon completes execution of a script. In a script launched by 
another script, it is the point at which the launched script is exited and 
the original script resumes control.

Choices in Configuration:

This icon is not configurable.

Special Considerations: 

This icon is not usually used in scripts which answer the phone, 
because the script is always reset to the Pick Up Phone icon.

Figure 10-11. Configuration Dialog Box for Launch Script Icon
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Examples of Use:

This icon is often used to end a launched “sub-script” so that the origi-
nal script can continue execution. See the Launch Script icon for more 
information.

10.2.11. Build AppleScript

Description:

This icon takes data from within PhonePro and places it into variables 
inside an AppleScript script file for use by that AppleScript script.

This icon uses a “template” AppleScript text file or text variable to cre-
ate an AppleScript script file that can be executed with the “Run 
AppleScript” icon. Using the Build AppleScript icon, information from 
within PhonePro can be exported to other applications. For example, a 
customer might enter a part number and quantity by interacting with 
a PhonePro script using the telephone. The PhonePro script could then 
generate an order in an electronic commerce system using an Apple-
Script.

Choices in Configuration:

AScript variable: This selector determines which variable or table 
record you will be incorporating into the AppleScript script. If you 
select a variable or a table field, a single AppleScript script variable is 
created. If you select a table, one AppleScript variable is created for 
each field of the table.

Using Template: This is a text file or text variable that acts as a tem-
plate for your AppleScript script. The AppleScript code contained in 
the specified file or variable makes use of the AppleScript variables 
that are inserted by PhonePro.

Save to: This specifies the file created by merging the PhonePro vari-
able or table record with the template. Normally, this file is then run by 
PhonePro using the “Run AppleScript” icon.
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Special Considerations: 

Typically you will use a text file as a template. However, if you have a 
short script (less than 255 characters) you can store it in a text variable to 
avoid needing an additional template file.

Examples of Use:

A customer could call and enter a product code which could be saved 
into an AppleScript variable. The AppleScript would then be executed 
(using the “Run AppleScript” icon) to submit an order form to another 
application.

Figure 10-12. Configuration Dialog Box for Build AppleScript Icon
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10.2.12. Run AppleScript

Description:

This icon runs an AppleScript script.

Choices in Configuration:

AppleScript From: This specifies the AppleScript text file that will be 
compiled and executed.

Examples of Use:

In conjunction with an Alarm Clock icon, this icon could be used to 
periodically produce a report by invoking an AppleScript which com-
municates with an accounting application.

Figure 10-13. Configuration Dialog Box for Run AppleScript Icon
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10.2.13. Execute XCMD

Description:

This icon allows customers to create “code resources” that are called 
by PhonePro scripts to perform functions beyond those available 
within PhonePro. These code resources are accessed through the same 
mechanism that HyperCard and other applications use to pass param-
eters in and out of external code.

Choices in Configuration:

PhonePro can be configured to execute any of the XCMD resources in 
a PhonePro script.

Special Considerations: 

Use ResEdit to copy needed XCMD resources (and any resources the 
XCMDs need) into your PhonePro script. Make sure that the script is 
not open in PhonePro when you attempt to open it with ResEdit.

XCMD List: The scrolling list at the top of the window lists all XCMD 
resources found in the script file. By double-clicking on one, a check-
mark is displayed to the left of the XCMD selected. Only one XCMD 
can be accessed from this icon.

PhonePro uses the standard “XCMD parameter block” for communi-
cation with the XCMD. The data type of the data being passed into the 
code resource can be found in the “InArgs[1]” field (Pascal) or 
“InArgs[0]” (C) of this structure. The field is a “long” but is treated as 
an “OSType”. This field has the following possible data type values:

Type Designator OS Type Code Data in InArgs[2]/OutArgs[2]

String Text StringPtr

Integer Long Long

Real Real Long (typecast to Pascal real)

Day “Day “ (space) Long (1 through 7)

Date Date Long (seconds since 1/1/1904)

Time Time Long (seconds after midnight)
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Phone Number Phn# StringPtr

Sound ‘snd ’(space) Handle to ‘snd ’ resource

Script File ScFl StringPtr (to full pathname)

Text File TxFl StringPtr (to full pathname)

Fax File FxFl StringPtr (to full pathname)

Any File AnFl StringPtr (to full pathname)

Pathname Path StringPtr (to folder pathname)

The data itself will be passed in the form as specified in the above table 
in InArgs[2] (Pascal) or InArgs[1] (C).

Figure 10-14. Configuration Dialog Box for Execute XCMD Icon
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If the XCMD is to pass data back to the PhonePro script, it should do 
so in the OutArgs[1] and OutArgs[2] fields (Pascal) or OutArgs[0] and 
OutArgs[1] (C) of the structure. The OutArgs[1] (Pascal) or OutArgs[0] 
(C) field should contain the OSType code of the data being passed in 
(as per the above chart). PhonePro will therefore be able to deter-mine 
if the data is the correct type of incorporation into the script. This acts 
as a “double-check” that the script element to which the data is to be 
assigned is in fact the same data type as the data being sent back from 
the XCMD.

The OutArgs[2] (Pascal) or OutArgs[1] (C) field should contain the 
data to be sent into PhonePro. In the case of StringPtrs and Handles 
being passed into PhonePro. PhonePro will deallocate memory for the 
data passed in automatically.

Here’s a simple XCMD that receives a long from PhonePro, multiplies 
it by two, and sends the result back to PhonePro:

#include “HyperXCmd.h”

void main (XCmdPtr paramPtr)

{

long inLong;

long outLong;

inLong= paramPtr->inArgs[1];

outLong= inLong*2;

paramPtr->outArgs[0] = (long)’Long’;

paramPtr->outArgs[1] = outLong;

paramPtr->result = 0; /* This performed without error */

}

Examples of Use:

A caller could input a number using Touch Tones. The XCMD could 
perform some higher level math function on the number, and return 
the result to PhonePro, which speaks the result to the caller.
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10.2.14. Wait

Description:

Pauses script execution for a set time interval.

Choices in Configuration:

Time to Wait: Select the number of time units for the script to wait. Use 
a value if the interval is a constant, or a table field or variable if it may 
change. Select the appropriate data type using the pop-up.

Time Unit: Use this pop-up menu to select a time unit. The options are 
seconds, minutes, hours or days. Wait

Special Considerations: 

If the phone rings while the Wait icon is active, the script will be 
unable to answer. Consider using the Detect Rings icon if this is a con-
cern.

Figure 10-15. Configuration Dialog Box for Wait Icon
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Examples of Use:

A script might give a caller the option to hold if an attempt to transfer 
is unsuccessful. Use this icon to pause the script before trying to trans-
fer the call again.

10.2.15. Fatal Error

Description:

If a running script is unable to recover from a problem, such as an 
inoperative mail server, missing table, or full hard drive, this icon will 
direct it to take alternative action, possibly recovery or shut-down pro-
cedures.

Choices in Configuration:

This icon cannot be configured. In effect, it is configured by placing 
icons after it.

Special Considerations: 

If this icon is included anywhere in the script, icons following it are 
run automatically if a fatal error occurs.

You can only have one Fatal Error icon per script. If a script launched 
from another script has a Fatal Error icon, the Fatal Error icon in the 
launched script takes priority. Otherwise, scripts up the “nested hier-
archy” of launched scripts will be checked to see where the first Fatal 
Error Icon is located (i.e. you may have launched a script from another 
script that was launched, in which case you’d want the most “local” 
Fatal Error Icon to be activated).

Examples of Use:

If your script runs into a serious problem, you may want it to notify 
you before quitting. By including a Fatal Error icon in the script, fol-
lowed by the appropriate icons of your choice, you can have PhonePro 
call a specified phone number and play a message that informs you of 
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the fatal error. Since the exact nature of an error can be retrieved with 
the System Inquiry icon, it is recommended that you attach a System 
Inquiry to any Fatal Error icon which is included in a script. Alterna-
tively, you could launch a second script with simpler or different func-
tionality in order to get around the problem. For instance, if the 
System Inquiry icon says that the error was a mail server problem, you 
might want to launch a script that did not use the mail server but still 
preserved that functionality.

10.2.16. Alarm Clock

Description:

The Alarm Clock icon sets a time interval for the execution of specific 
tasks. It has no inbound connector because it is, in effect, a global icon. 
Other global icons are the Fatal Error and Call Terminated icons. This 
icon is incorporated into scripts which also contain the Pick Up Phone 
icon.

Choices in Configuration:

Different types of time intervals can be configured with the Alarm 
Clock icon.

Configure the Time Interval as a value, variable, or a table field. Select 
the Alarm Clock Type using the pop-up. You can set the Alarm clock to 
be triggered by “absolute time”, meaning the actual time of day, or 
“Periodically after Run”, meaning that the alarm clock would be trig-
gered by a specific interval of “script run time”. Next, assign a table 
field or variable to the time interval or time of day, or enter a numeric 
value and assign a data type of Time or Number using the pop-up 
entitled “Type”.

If the Alarm Clock icon is set for an absolute time (like 10:24 am), set 
the data type pop-up to “time”. For periodic functions (hourly, bi-
hourly), set the pop-up to “number”.
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Special Considerations:

1. When the task is done, be sure to use a Go To icon that returns 
script execution to the icon waiting for a call.

2. PhonePro will not answer any calls once a task triggered by an 
alarm clock icon has begun. Therefore, try to keep tasks as short as 
possible, or schedule them for times when no calls are expected.

Examples of Use:

Use the Alarm Clock icon to check the availability of hard disk space 
on the start-up drive at specified time intervals.

For example, while the phone is waiting for a call, script execution will 
jump to the Alarm Clock icon every hour. The Alarm Clock icon will 
trigger the execution of the System Inquiry icon on an hourly basis.

Another example would be to use the Alarm Clock icon to switch to a 
different greeting after business hours.

Figure 10-16. Configuration Dialog Box for XXXX Icon
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10.3. Phone (Telephony) Palette

10.3.1. Detect Rings

Description:

This icon waits for an incoming call. When a “ring” is first seen on the 
telephone line, script execution continues from the bottom of the icon. 
This icon does not actually answer the phone, but allows tasks such as 
checking caller ID (if your phone system supports this) to be per-
formed before the phone is answered by the Pick Up Phone icon. The 
detect Rings icon can also be configured to perform tasks at periodic 
intervals if the phone does not ring.

Choices in Configuration:

The telephone number of the caller is retrieved from the phone line (if 
available). It is placed into a variable or table field specified during 
configuration.

The “P” connector on the side of the icon is used for “Periodic Tasks”. 
Icons connected here can be executed on a repeating schedule. The 
time period is specified in the icon’s configuration dialog box. When 
waiting for the phone to ring, if the period specified passes, any icons 
connected to the “P” connector are executed.

It is not essential to connect icons to the “P” connector. The icon is con-
sidered fully configured without this.

Special Considerations: 

This icon is primarily intended to work with ISDN and CallerID com-
patible lines. It is not recommended for use if your telephony hard-
ware doesn’t support CallerID.
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This icon will not pick up the phone - it provides a way to identify the caller’s 
telephone number and take action based on it. The “Rings Before Answer” 
setting in the Pick Up Phone icon uses the start ring time from this icon in 
order to determine if enough rings have been received to pick up the phone and 
handle the call.

Examples of Use:

This icon might be used to process telephone calls that are coming to a 
business line depending on whether the caller’s number is in a table. 
Phone numbers in the table could be those with messages waiting. If a 
caller’s number were found in the table, a “Sound Type” field in the 
table could be played specific to the person calling.

Figure 10-17. Configuration Dialog Box for Detect Rings Icon
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10.3.2. Pick Up Phone

Description:

This icon waits for an incoming call and then answers it.

Choices in Configuration:

Rings to Wait: Enter the number of rings after which PhonePro 
answers the phone. This can be a constant or it can be obtained from a 
variable or table field if it is subject to change. The data type must be 
Number.

Hang Up Pre-Existing Call: If this is checked, a call still on the line will 
be disconnected when this icon is first executed.

Examples of Use:

This is often the first icon after the Go icon in a script whose main pur-
pose is to answer the phone.

Figure 10-18. Configuration Dialog Box for Pick Up Phone Icon
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10.3.3. Hang Up

Description:

This icon disconnects the active call (“hangs up”) when processing of a 
call is completed.

Choices in Configuration:

This icon is not configurable.

Special Considerations: 

It is generally a good idea to hang up before starting time-consuming 
tasks such as system inquiries, table searches or electronic mail activi-
ties.

Examples of Use:

Disconnect calls with this icon.

10.3.4. Make Call

Description:

Use this icon to place an outgoing call.

Choices in Configuration:

Number to Call: Enter the number to call as a value if it will always be 
the same, or if it will change, enter the variable or the table field that 
contains it. The data type must be Number or Phone Number.

Rings before Fail: Enter the number of rings PhonePro waits before 
deciding no one answered. Enter this as a value if it will always be the 
same, or select a variable or table field. If it is set to 0, PhonePro will 
not be able to make the call. However, setting this option to 0 allows 
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PhonePro to send out Touch Tones without first hanging up the phone. 
You can therefore use this icon to send Touch Tones when navigating 
Electronic or Voice mail systems remotely.

Wait for silence before proceeding: PhonePro will wait for silence to be 
detected on the call before proceeding to the next icon. Unless this 
option is set, PhonePro will proceed as soon as its call progress detec-
tion features have determined that a call has been answered. This is 
useful if PhonePro reaches an answering machine and you wish to 
play a message after the answering machine’s greeting finishes play-
ing.

Assume call is immediately answered: If this setting is checked, 
PhonePro will not attempt to use its call progress detection features for 
this call and will proceed to the next icon as soon as the call is placed.

Figure 10-19. Configuration Dialog Box for Make Call Icon
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Special Considerations: 

A new call can fail when:
• The maximum number of rings is exceeded.
• A busy signal or error tone (e.g. re-order tone) is detected.

Before using PhonePro to make outgoing calls, you must first train it to 
differentiate between the various tones that are used to convey call 
progress information at your location. After you have configured the 
appropriate telephone tool for your telephony hardware, invoke the 
Call Progress Trainer feature from PhonePro’s Utility menu and use it 
to provide PhonePro with examples of different tones it must distin-
guish between. Configuring Telephone Tools is explained in Chapter 1. 
The Call Progress Trainer feature is covered in Chapter 9.

The speed and accuracy of call progress and silence detectionis depen-
dent on the telephony hardware you are using and the telephone sys-
tems that you are calling. If you are unable to train your system to 
accurately detect when a called party answers, (perhaps because your 
solution involves calling a very diverse array of international tele-
phone systems) you may wish to select the option to assume that the 
call is immediately answered and then follow the Make Call icon with 
a sequence of icons that play a short message while in a loop. The mes-
sage would instruct the caller to press a button upon answering and 
the loop would terminate either when a tone is detected or when a 
timeout occurs.

Examples of Use:

Use this icon to page someone, dial a list of numbers for telemarketing 
purposes, or to dial a specific number to deliver messages. 
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10.3.5. Transfer Call

Description:

This icon transfers calls to other destinations.

Choices in Configuration:

Transfer to Phone #: Enter the extension or phone number to call as a 
value if it is a constant, or, if it will change, enter the variable or the 
table field which contains the number. The data type must be Number 
or Phone Number.

Rings Before Fail: Enter the number of rings to allow before PhonePro 
considers the call incomplete. The data type must be Number.

Perform dial tone check...: This check box indicates whether PhonePro 
should confirm that the current call is still active (by checking for dial-
tone which would indicate a terminated call) before attempting the 
transfer.

Special Considerations: 

Before using any icon which makes a call, PhonePro should be config-
ured using the Telephone Tool and trained using the Tool Trainer.

PhonePro does not distinguish between transfers that fail because 
there is no answer and those that fail because of a busy or some other 
non-ringing signal.

When using the Call Transfer function of PhonePro, it is recommended 
that you add an “Announce Call” function to your script. This means 
that following the transfer call icon, you should insert a play message 
icon that says, for example, “You have a call”.

This is recommended because of the method that PhonePro uses to 
recognize when a person has picked up the outbound call. When 
someone picks up the phone and says “hello”, this voice sound will 
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tell PhonePro that the call is active. But, the caller who is on hold on 
the other line will not hear this “hello”. PhonePro will not connect the 
two calls until PhonePro actually hangs up its end of the call.

So, if you place this call announcement function in your script, the per-
son being called will not be confused when no one replies to the initial 
“hello”. 

You can also use this announcement function to screen calls. For exam-
ple, you can take advantage of Caller ID (in hardware that supports 
this) to speak back the caller ID information on the announcement. 
You can then add the option to answer the call or send the call to voice-
mail.

For example, the announcement could say “you have a call from John 
Smith, press 1 to accept the call or press 2 to send to voicemail”.

Figure 10-20. Configuration Dialog Box for Transfer Call Icon
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Examples of Use:

Use PhonePro as an electronic operator to transfer calls within your 
organization. Ask the caller for an extension number and transfer the 
call using this icon.

10.3.6. Call Terminated

Description:

The Call Terminated icon is an “event catcher”. Script execution auto-
matically jumps to this icon if a caller hangs up during an active call. 
This icon has no inbound connector, since it is active over an entire 
script, like the Alarm Clock and Fatal Error icons.

The telephony hardware (and associated telephone service) being 
used determines how promptly this determination can be made. With 
analog phone lines call termination is identified when dialtone is 
unexpectedly detected.

There are three situations where dial-tone checking is done, as this 
checking takes several seconds:

1. If a Touch Tone icon times out.

2. If a call is about to be transferred.

3. If script execution is about to jump to another PhonePro script.

Configure icons which follow the Call Terminated icon to drop the call 
(using the Hang Up icon) and complete any processing necessary 
before waiting for the next call.

Choices in Configuration:

No configuration is necessary for this icon. In effect, it is configured by 
placing icons after it.
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10.3.7. Play Message

Description:

This icon plays a sound over the phone line. The sound can be one 
recorded from within PhonePro or one brought in from another 
source.

Choices in Configuration:

Play Sound from: Choose the sound to be played. It can be any sound 
from the Sound table, a variable or a table field. The data type must be 
Sound.

Ignore Previous Touch Tones: If this is checked, this icon clears any 
Touch Tone keys that were pressed before it executed.

Touch Tone Interrupts: When this box is checked, a caller can enter 
codes or menu choices while the message is playing. The tone that 
interrupts the message will be interpreted by the following icon if that 
icon is one which interprets incoming touch tones (e.g. Touch Tone 
Menu, Touch Tone Digit String Icon, etc.).

Play through local speaker: If checked, the message will be played 
through the Macintosh’s speaker, not to the current call.

Do not forget that some callers may not be calling from Touch Tone 
phones!

Special Considerations: 

Long messages require more disk space to store and more memory to 
play back. You may need outgoing sounds to be short if your system 
has limited memory. See Chapter 5 for more information about how 
sounds are handled in PhonePro.

Examples of Use:

Play an outgoing greeting or details of touch-tone choices available to 
the caller.
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10.3.8. Speak List

Description:

This icon plays a series of pre-recorded sounds over the phone line.

Choices in Configuration:

This icon is configured somewhat differently from most. When it is 
first configured, a ready-made list appears, as shown on the next page. 
Add sounds to this list using the New Item button. A dialog box simi-
lar to the one at the bottom of the page appears and allows you to 
Select an item from a table field, a variable, a value (which you type in 
and then record using the Sound recording controls) or a sound. Select 
items in the order you wish them to play. Items can be of data type 
Sound (they will be played directly by Speak List) or, if you select or 
type entries that are Text, Number, Decimal, Day, Date, Time or Phone 
Number, PhonePro uses the Word Table to translate these into spoken 
words. See Chapter 3, The PhonePro Development Environment, for 
more information about the Word Table.

Figure 10-21. Configuration Dialog Box for Play Message Icon
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Click “Play” to hear the result. If you have included items that are not 
of type Sound in your list, PhonePro tries to find a sound of that name 
in the Word Table. If it cannot find a corresponding sound, you are 
asked if you want to add it.

Click the “Edit” button to edit an item on the list. For more informa-
tion about editing sounds, refer to Chapter 5. Press the “Remove” but-
ton to remove a highlighted item from the list. The item is removed 
from the list.

Click the “Play” button to listen to a highlighted item in the list. Use 
“Play List” to listen to the entire list as it would sound when played 
out over the phone line.

Figure 10-22. Configuration Dialog Box for Speak List Icon
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Special Considerations: 

To save disk space and memory, consider compressing long sounds. 
See Chapter 5 for more information on handling sounds.

Examples of Use:

To play a message which tells a caller about the number of messages 
waiting, Speak List could be configured to play a sound that said “You 
have”, followed by the variable containing the value you’ve prepared 
that contains the number of messages waiting, and a sound saying 
“messages waiting”. So, for instance, if there were three messages 
waiting, this configuration of Speak List would play a series of sounds 
saying “You have three messages waiting”.

10.3.9. Record Message

Description:

This icon records sounds from the phone line.

Choices in Configuration:

Save Sound to: Choose the location in which you want the sound 
saved. It can be an entry in the Sound Table, a variable or a table field. 
The data type must be Sound.

Seconds to Record: Select the number of seconds the recording will 
last. If this is a fixed length, use a value. If it will change, select the 
variable or table field which contains the length. The data type must be 
Number.

Touch Tone Interrupts: When this box is checked, a caller can enter 
codes or menu choices while the message is playing. The tone that 
interrupts the message will be interpreted by the following icon if it 
interprets incoming touch tones (e.g. Touch Tone Menu, Touch Tone 
Digit String Icon, etc.).

Remember that some callers may not be using Touch Tone phones!



PhonePro Icons

126

Automatic Silence Cutoff: When this box is checked, PhonePro stops 
recording when there is silence on the phone line. Using this option 
saves disk space if a caller leaves a very short message.

Record from local microphone: If checked, recording is from the built-
in microphone on the Macintosh, not the telephone line.

Special Considerations: 

Longer recordings need more memory and disk space. You can set the 
level of background noise that PhonePro considers to be “silence” with 
the Recording option in the Preferences command under the Edit 
menu.

Figure 10-23. Configuration Dialog Box for Record Message Icon
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Examples of Use:

Record messages and store them in a table field for later retrieval.

10.3.10. Touch Tone Menu

Description:

Allows the caller to follow one of several paths by pressing a Touch 
Tone key. Multiple paths may be connected to the outbound connector 
of this icon, each of which corresponds to a different Touch Tone. A 
number appears in each of these paths that designates its tone.

Choices in Configuration:

Time Out Seconds: Enter the number of seconds that may elapse with-
out a response from the caller before this icon “times out” and follows 
the “T” connector. This number can be the contents of a table field, a 
variable or a constant. The data type must be Number.

Use the “E” connector to designate what happens if a caller enters an 
invalid code.

To change the Touch Tone key for a path, double-click on the path and 
then click on the button you wish to assign to that path. Note that 
other keys that are in use on this touch tone menu are not available for 
selection.

Special Considerations: 

Callers who do not have Touch Tone phones may find themselves tim-
ing out! Be sure to take this into account when designing your scripts.

Examples of Use:

In a script for a movie theater, the Touch Tone menu could be used to 
allow callers to select a specific movie about which they want informa-
tion. For instance, the greeting could say, “Press 1 for information 
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about Superman, press 2 for information about Chariots of Fire, or 
press 3 for information about Attack of the Killer Tomatoes”. A sepa-
rate path would then go to a message about each of these movies.

10.3.11. Touch Tone Digit String

Description:

Collects a series of Touch Tone digits from the caller. Strings can be 
ended automatically at a specified number of digits, or by having the 
caller press “*” or “#”.

Choices in Configuration:

Store Result into: Select the table field or variable into which the 
results of the incoming touch tones are stored. Valid data types are 
Phone Number, Number, Decimal, or Text.

Time Out Seconds: Enter the number of seconds that may elapse with-
out a response from the caller before this icon “times out” and follows 
the “T” connector. This can be the contents of a table field, a variable or 
a value. The data type must be Number.

Figure 10-24. Configuration Dialog Box for Touch Tone Menu Icon
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Use the “T” connector to designate what will happen if a caller does 
not respond within the length of time specified in the Time Out Sec-
onds option.

Figure 10-25. Configuration Dialog Box for Touch Tone Digit String Icon
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Terminate: The incoming string can be terminated with the pound “#” 
key, the star “*” key, or after a certain number of digits. If you have 
chosen to have the string terminated by a “*” or “#”, be sure to set the 
Digits to Get value larger than the number of digits a caller may need 
to enter.

Digits to Get: This is the maximum number of digits PhonePro allows. 
If you have selected the “After Specified Characters” option in the Ter-
minate pop-up menu, this is where the number of characters is speci-
fied. If a different termination criterion is selected, this is the 
maximum number of digits that can be accepted. This information can 
either be a value, or it can be obtained from a table field or variable. 
The data type must be Number.

Special Considerations: 

Some callers may be calling from rotary phones. In this case, you will 
want to handle the “T” (Time Out) situation appropriately.

Examples of Use:

Use this icon to monitor the phone line for Touch Tones if the caller is 
asked for some sort of pass code, or if you have asked them to enter 
any other string of tones, such as an extension or account number.

10.3.12. Touch Tone Alpha String

Description:

Monitors the phone line for a string of Touch Tones that are inter-
preted as alphabetic characters.

To enter an alphabetic string, a caller must press the telephone key 
associated with the desired letter and then press the 1, 2 or 3 key to 
indicate the placement of the letter on that key. So to enter the letter 
“A”, press “2” followed by a “1”, because “A” is the first letter on that 
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key. This way, each letter is represented by two tones. Notice that “Q” 
and “Z” do not appear on the keypad. They are listed in the table on 
the following page, with all other possible characters.

To enter a number (as opposed to a digit character) using this icon, 
enter the number followed by a “0”. For instance, the number “6” 
would be entered as “6 0”. A string may be ended at the number of 
characters specified by Characters Accepted, or with the “*” or “#” 
keys.

Choices in Configuration:

Place Result Into: Select the location where the incoming information 
is to be stored. It may be a table field or variable, of data types Text or 
Day.

Time Out Seconds: Enter the number of seconds that may elapse with-
out a response from the caller before this icon “times out” and follows 
the “T” (Time Out) connector. This can be the contents of a table field, 
a variable or a value. The data type must be Number.

Terminate: The incoming string can be terminated with the pound (#) 
key, the star (*) key, or after the number of characters specified in Char-
acters Accepted.

Characters Accepted: This is the maximum number of characters to 
get. If you have selected the Specified Characters option in the Termi-
nate pop-up menu, this is where the number of characters is specified. 
If a different termination criterion is selected, this option, and not the 
number of keys pressed, configures the maximum number of digits 
that are accepted. This information can either be stored as a constant or 
be obtained from a table field or variable. This information must be of 
type Number.

Special Considerations: 

If you are entering only numbers, use the Touch Tone Digit String icon.
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Examples of Use:

If a caller wishes to be connected with an individual at your company 
but does not know that individual’s extension, you could use this icon 
to allow the caller to enter the person’s name, or some portion of it, 
and PhonePro can locate that information in a table.

Figure 10-26. Configuration Dialog Box for Touch Tone Alpha String Icon
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10.3.13. Hot Key

Description:

The Hot Key icon is a global icon which initiates execution of any icons 
connected to it whenever a specified telephone key is pressed by a 
caller on the line. Like the Call Terminated, Alarm Clock and Fatal 
Error icons, it has no inbound connector since it is active over an entire 
script.

Choices in Configuration:

Use the pop up in the center of the dialog box to select the Touch Tone 
key which will function as the Hot key.

Special Considerations: 

You can only place one Hot Key icon into a script. If the script launches 
a script which contains one, the icon in the Launched script will take 
precedence during the execution of the launched script. This icon will 
only work when PhonePro is not waiting for any other Touch Tone sig-
nal.

Examples of Use:

The Hot Key icon could be used to initiate transfer of a call to an oper-
ator during a recorded information sequence or within a voice mail 
system.
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10.4. Table Palette

10.4.1. Table Inquiry

Description:

Use this icon to get information about a table. The available informa-
tion and the corresponding data types are as follows:

• Current Record Number: Number
• Total Number of Records: Number

Choices in Configuration:

For Table: Select Table Field or Table File.

Figure 10-27. Configuration Dialog Box for Table Inquiry Icon
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Table Inquiry Type: Select the desired information from this pop-up 
menu.

Place Result: Select the location where this information will be stored. 
It must be a table field or variable of the type which matches the 
selected information.

Examples of Use:

To tell a caller how many calls have been received, use the Total Num-
ber or Records value acquired from the Table Inquiry Icon to give the 
total number of records in an incoming calls table.

10.4.2. Move Through Table

Description:

This icon changes the “current record” in a table file. The next, previ-
ous, first, last, or a specifically indexed record can become the current 
record.

Choices in Configuration:

Table: Select the table in which to change the current record. It must be 
of data type Table File and can be located directly or obtained from a 
table field of this data type.

Move to: Select how to move in the table. Depending on the “Position” 
option selected, the First, Next, Last, or Previous record may become 
the current record. Alternatively, a record’s index number can be spec-
ified by a table field, variable or value, in which case the data type 
must be Number.

Special Considerations: 

If an invalid move is attempted, the “-” path is followed, otherwise the 
“+” path is followed. You can use this to determine when you have 
reached the last record in a table, for example.
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Examples of Use:

To proceed through a table of calls, use this icon to move through a 
table one record at a time.

10.4.3. Sort Table

Description:

Use this icon to sort all the records in a table using one field as a key. 

Choices in Configuration:

Sort By: Select the table field on which the sort occurs.Sorting is based 
on the data type of the field specified.

Figure 10-28. Configuration Dialog Box for Move Through Table Icon
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Special Considerations: 

Text and PhoneNumber fields are sorted alphanumerically rather than 
by numeric value.

Examples of Use:

When a caller chooses to listen to a directory of employees, sort the list 
before presenting it using this icon.

10.4.4. Search Table

Description:

Use this icon to search a table for a specific record, using one field as a 
key. The first record matched becomes the current record. If the search 
is successful, the “+” path is followed; otherwise the “-” path is fol-
lowed and the current record does not change.

Choices in Configuration:

In Table Field: Select the table field on which the search occurs. Valid 
data types are Text, Number, Decimal, Day, Date, Time, or Phone 
Number.

Figure 10-29. Configuration Dialog Box for Sort Table Icon
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Find Next Record Where Field is: Use this pop-up menu to select the 
type of comparison. The choices are: Less Than, Less Than or Equal To, 
Equal To, Greater Than or Equal To, Greater Than and Not Equal To.

...the contents of: Select the source of the comparison information. It 
may be obtained from a value, a variable or a table field. This informa-
tion must be of the same type as the field searched.

Search Type: Use this pop-up menu to select the type of search:

First Record to Last Record: Searches the entire table from beginning to 
end.

First Record to Current Record: Searches from the beginning of the 
table to the current record.

First Record to Previous Record: Searches from the beginning of the 
table to the record before the current record.

Next Record to Last Record: Searches from the record following the 
current record to the end of the table.

Next Record to Current Record: Searches the entire table from the 
record following the current record to the end and then starts again at 
the beginning of the table and searches to the current record.

Next Record to Previous Record: Searches the entire table except the 
current record, starting with the record following the cur-rent record 
and searches to the end, then searches again from the beginning of the 
table to the record before the current record.

Special Considerations: 

If a search is successful, the first record with matching information 
becomes the current record. If the search is unsuccessful, the current 
record does not change.
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Examples of Use:

When a caller enters a pass-code, use this icon to search for that code 
in the appropriate table. If it is found, that record, which could contain 
other information about the caller, becomes the current record.

10.4.5. New Record

Description:

Use this icon to add a new record to an existing table.

Figure 10-30. Configuration Dialog Box for Search Table Icon
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Choices in Configuration:

Add Record to: Select the table to which to add the new record. 
Choose a Table File to add to directly or a field in a table that points to 
another table that actually receives the new record. See Chapter 4 for a 
discussion of this type of field. In either case, the file selected must 
have a “Table File” data type.

Add Record: Use this pop-up menu to designate where the new record 
will be added. The new record may be added Before the Current 
Record, After the Current Record, at the Beginning of the Table, or at 
the End of the Table.

Special Considerations: 

A Fatal Script Error will occur if the table contains the maximum of 
1000 records and an attempt is made to add a further record.

Examples of Use: 

Use this icon to add a new record to an incoming calls table when a 
call comes in.

Figure 10-31. Configuration Dialog Box for New Record Icon
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10.4.6. Lock/Unlock Record

Description:

This locks or unlocks a record (or all records) in a table. Locked records 
can’t be removed or altered.

Choices in Configuration:

In Table: Select the table in which to work. The data type must be Table 
File, and the target record may be located directly or obtained from a 
table field.

Operation: Use this pop-up menu to select the appropriate operation. 
The choices are: Lock Current Record, Unlock Current Record, Lock 
All Records, or Unlock All Records.

Examples of Use:

Lock a record to avoid deleting it. Changes (assignments to table 
fields) are not permitted to locked records. A Fatal Error is not gener-
ated if this is attempted.

Figure 10-32. Configuration Dialog Box for Lock/Unlock Record Icon
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10.4.7. Import Table

Description:

This icon imports a table from a tab-delimited text file into a PhonePro 
table. The text file fills the records in the table, with carriage returns 
generating new records and tabs indicating the next field in those 
records.

Choices in Configuration:

From Text File: Designate the text file to import into the PhonePro 
table. Data must be type Text File and may be directly located or 
obtained from a table field containing the name of a text file.

Import Data into: This is the name of the PhonePro table file which 
receives the information. The file must already exist, but it does not 
have to be empty. The destination file must be of data type Table File.

Text File Contains: If this box is checked, the first “row” in the text file 
will contain the field names. The second “row” will contain the data 
types of the fields. Only the first four characters of a data type are sig-
nificant; for example, the words “Phone Number” and “Phon” indi-
cate a Phone Number type. The text is not case sensitive.

Append to Existing Records: Check this box to add the imported data 
to the table. If it is unchecked, existing information in the table is over-
written. If it is checked, PhonePro uses the existing data types for the 
new records and therefore the data types do not need to be included in 
the imported file.

It might be helpful to export a table and use it to become familiar with 
the format for the importing process.

Examples of Use:

Import externally-generated data, such as a spreadsheet, into the 
PhonePro environment.
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10.4.8. Export Table

Description:

This icon exports a PhonePro table into a tab-delimited text file.

Choices in Configuration:

Export Records from: Select the table to export. The data type must be 
Table File and may be located directly or obtained from a table field of 
this data type.

Figure 10-33. Configuration Dialog Box for Import Table Icon



PhonePro Icons

144

To Text File: Select the text file which receives the exported data. This 
text file can be a previously-created one, or PhonePro offers the option 
to create a completely new text file as part of the exporting process. 
The data type must be Text File, and may be specified directly or by a 
table field of the Text File data type.

Special Considerations: 

Sounds will not be exported.

Examples of Use:

Use this icon to extract information from PhonePro tables for access by 
other applications.

Figure 10-34. Configuration Dialog Box for Export Table Icon
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10.4.9. Delete Record

Description:

Removes the current record from the table.

Choices in Configuration:

Remove from: Select the table from which to remove the record. It 
must be of type Table File and can be located directly or obtained from 
a table field.

Special Considerations: 

If the record is locked, it can’t be deleted. A Fatal Script Error does not 
result from this operation. If you are using record locking in a table, 
you may wish to “unlock” the record before removing it. Sounds that 
are stored in a field in this record can also be removed. Because indi-
vidual sounds are only stored once in each table, if that sound is refer-
enced by any other record in that table, the sound will also be removed 
from those records.

Figure 10-35. Configuration Dialog Box for Delete Record Icon
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Examples of Use:

PhonePro users who call to retrieve messages can delete them individ-
ually if this icon is used.

10.4.10. Delete All Records

Description:

Removes all records in a table.

Choices in Configuration:

Remove All from: Select the table from which records will be deleted. 
It must be of the Table File type and can be located directly or taken 
from a field containing a table file name.

Special Considerations: 

Locked records cannot be deleted. Sounds stored in the table may also 
be removed, depending on how it is set up. See Chapter 4, Data Han-
dling, for details. Since individual sounds are only stored once in each 
table, if another record also references that sound, the sound will also 
be removed from those records.

Figure 10-36. Configuration Dialog Box for Delete All Records Icon
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Examples of Use:

Someone who calls to retrieve messages may want to delete them after 
they have been read. This icon would delete all unlocked records in 
the selected table.

10.5. Files Palette
Files palette icons allow operations to be performed on any files which 
are accessible to the PhonePro Macintosh. This includes files which are 
accessible across a network, provided the file server where the file is 
located is mounted when PhonePro is running.

10.5.1. Create Folder

Description:

The Create Folder icon creates a new folder inside a specified folder. 
This functionality is useful for creating new mailbox folders for 
PhonePro Mail. The Create Folder icon can also be used for creating 
new folders from within the Data Modem Mode to make new “drop-
box” folders for storing files.

Choices in Configuration:

Under “In Folder”, specify the pathname to where the new folder will 
be created.

Under “Make Folder Named”, specify the title of the folder. This can 
be obtained from a Table field or a variable, or it can be typed in 
directly.

Under “Store New Path In”, specify a location where the complete 
pathname of the new folder will be stored.
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Special Considerations: 

If there is not enough space on the disk to create a new folder, or if any 
of the folders in which the new folder is nested do not exist, a fatal 
error will result. Script execution will stop unless a Fatal Error icon is 
in the script or the calling chain of launched scripts.

Figure 10-37. Configuration Dialog Box for Create Folder Icon
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Examples of Use:

This icon could be used to add a mailbox folder for a user in PhonePro 
Mail. It could also be used to create a folder from Data Modem Mode 
for depositing some files when accessing the system remotely. The 
configuration dialog box for the Create Folder icon.

10.5.2. Rename File

Description:

This icon will rename a specified file.

Choices in Configuration:

Under “Rename file”, specify the file which is to be renamed. This can 
be selected from a table field or variable, or it can be specified directly 
using one of the “File” radio buttons.

Figure 10-38. Configuration Dialog Box for Rename File Icon
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Under “To”, specify the new name for the file. This can be obtained 
from a table field or variable, or you can select a file name directly by 
clicking on one of the “File” radio buttons.

10.5.3. Count Folder Contents

Description:

This icon counts the files in a specified folder and stores the resulting 
number in the specified location.

Choices in Configuration:

Under “Count Files in”, specify which folder should have its files 
counted. This can be obtained from a table field or variable. Alterna-
tively, you can select a pathname using a standard directory dialog 
box.

Figure 10-39. Configuration Dialog Box for Count Folder Contents Icon
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Under “Place result into”, specify where you want to store the result of 
the count. This can be either a table field or a variable.

10.5.4. Get File Info

Description:

This icon enables you to obtain information about a specified file in a 
similar manner to the System Inquiry icon.

Choices in Configuration:

Under “For File”, specify the name of the file for which information is 
to be obtained. This can come from a table field or variable, or it may 
be selected directly by clicking on one of the “File” radio buttons.

Use the “File Info” pop-up to select the type of file info to get. The 
available options are:

• File size in bytes

• Resource Fork size in bytes

• Data fork size in bytes

• File creation day

• File creation date

• File creation time

• File modification day

• File modification date

• File modification time

Under “Assign Result to”, specify where the information is to be 
stored. It can be a table field or variable.
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10.5.5. Get Indexed File

Description:

This icon finds a file in a specified folder according to a specified index 
reference and places that file in a chosen location within PhonePro.

Choices in Configuration:

Under “In Folder”, specify the name of the folder from which the file 
should be obtained.

Under “File index in Folder”, specify the index which is to be used as a 
reference.

Under “Place result Into”, select a location where the file is to be 
stored. You can select a table field, variable or an actual file.

Figure 10-40. Configuration Dialog Box for Get File Info Icon
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10.5.6. Copy File

Description: 

This icon copies a specified file and places the result into a second file.

Choices in Configuration:

Under “Copy” and “To”, select the source and destination files. You 
can obtain these files from a table field or variable or the correct data 
type, or you may select files directly by clicking the appropriate radio 
button, followed by the “Select.…” button.

Figure 10-41. Configuration Dialog Box for Get Indexed File Icon
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Special Considerations: 

Make sure enough disk space is available to accommodate your dupli-
cated file.

10.5.7. Delete File

Description:

This icon deletes the specified file from disk.

Choices in Configuration:

Select the file to be deleted. This file can be obtained from a variable or 
table field of the appropriate data type (one of the File data types), or it 
can be specified directly by selecting one of the lower five radio but-
tons.

Figure 10-42. Configuration Dialog Box for Copy File Icon
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If you choose to specify the file name directly, you must choose it from 
a directory dialog box which appears when you click the “Select…” 
button.

10.5.8. Append Files

Description:

The Append Files icon allows two files to be joined together. The 
resulting, longer, file can be saved as a third file created for the pur-
pose, or as one of the files which were involved in the append opera-
tion.

Choices in Configuration:

Select the names of the two files to be appended under “File 1” and 
“File 2”. Select a target file under “Target File”. These file names can be 
obtained from a table field or variable. The sources of the names must 
be of a File data type (for example Text File or Any File).

Special Considerations: 

Make sure that there is enough disk space available to receive the tar-
get file.

Figure 10-43. Configuration Dialog Box for Delete File Icon
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10.6. VoiceMail Palette

10.6.1. Log On Mail Server

Description:

This icon identifies the user of a call. If a password is needed, you 
must specify the password for that user. If the log on is successful, the 
“+” path is followed; otherwise the “-” path is followed.

Choices in Configuration:

User Name: Select the user-name with which to log on. It can be 
entered as a constant value, or obtained from a table field or variable. 
The data type must be Text.

Password: Select the password. It can be a value or be taken from a 
table field or variable. Its data type must be Text.

Special Considerations: 

If you change the mail server password or user name, be sure to 
change the configuration of this icon and/or any tables which contain 
references to the user name and password. This icon follows the “-” 
path if the user name or password is incorrect, or if the mail server is 
unavailable.

Examples of Use:

In a call-retrieval script in which people retrieve messages from their 
mail accounts, use this icon to access their mailbox.
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10.6.2. Log Off Mail Server

Description:

This icon logs PhonePro off the current mailbox. PhonePro can be 
logged on using any user name and password specified in the Log On 
Mail Server icon.

Choices in Configuration:

This icon doesn’t require configuration.

Examples of Use:

Use this icon to log off a particular mailbox after retrieving messages 
for its owner.

Figure 10-44. Configuration Dialog Box for Log On Mail Server Icon
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10.6.3. Mail Inquiry

Description:

This icon obtains information about the mail server and the currently 
open mailbox. Available information and data types are as follows:

• Current message number: Number

• Number of messages in mailbox: Number

• Number of unread messages in mailbox: Number

• Subject of current message: Text

• Body text of current message: Text

• Sound attached to current message: Sound

• Day current message sent: Day

• Date current message sent: Date

• Time current message sent: Time

Choices in Configuration:

Inquiry Type: Use this pop-up menu to select the type of information 
to be obtained from the mail system.

Place Result: Select the location where this information is to be stored. 
This can be a table field or a variable. Be sure the type of this variable 
or table field matches the type of the information to be obtained from 
the mail server.

Examples of Use:

Use this icon to obtain the number of messages waiting for someone 
who calls to retrieve messages.
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10.6.4. Move Through Mailbox

Description:

This icon changes the “current” message in a mailbox. It is functionally 
similar to the Move Through Table icon.

Choices in Configuration:

Move to: Select the location and the criterion used to find the message. 
If “position” is selected, the First, Next, Last, or Previous message may 
become the current message, depending on the setting of the pop-up 
menu. If a table field, variable or value is selected, its data type must 
be Number.

Mail Messages Included: This allows you to select all messages, 
unread messages only or previously-read messages only as a criterion 
for selecting the current mail message.

Figure 10-45. Configuration Dialog Box for Mail Inquiry Icon
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Examples of Use:

Use this icon to proceed through the mailbox, listening to each mes-
sage.

10.6.5. Send Mail Message

Description:

This icon sends a message to a specified user on the mail system.

Choices in Configuration:

Send Item: Select the sound to be sent with the mail message. It can be 
selected directly or obtained from a table field or variable. The data 
type must be Sound.

To: Select the recipient for the message. You can select the address to 
send the mail to from an address list by clicking the Mailbox radio but-
ton and then clicking “Select Mail Address”. This will allow you to 

Figure 10-46. Configuration Dialog Box for Move Through Mailbox Icon
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choose an address from a list of all addresses on the mail system in the 
pop-up at the top of the configuration dialog box. You can select a mail 
address from a table field if you click the “Table field” radio button.

Subject: Define the subject for the message. The subject can be entered 
directly as a value or obtained from a table field or variable. Data types 
must be Text. The “Use” pop-up at the bottom of the dialog allows you 

Figure 10-47. Configuration Dialog Box for Send Mail Message Icon
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to place the text from the Subject of the mail message into the note 
field of the Info box (accessible in Finder using the Get Info command), 
or to make the Subject text into the message’s file name.

Special Considerations: 

There is no need to use Log On Mail Server with this icon. PhonePro 
logs on and sends mail under the user name specified in E-Mail Prefer-
ences if no user is currently logged on using a Log On Mail server icon.

To minimize disk space usage, be sure to turn off “mail logging” on the 
account that sends voice mail. If you do not, every message will be duplicated 
on your mail server each time you send a voice mail message, which will use 
large amounts of disk space and be hard to identify as the source of this usage.

Examples of Use:

Use this icon instead of maintaining a separate incoming calls table for 
each PhonePro user. Send incoming messages to the person’s mailbox 
with this icon.

10.6.6. Play Mail Message

Description:

This icon plays the sound from the current message in the currently-
accessed mailbox. If no mail system is accessed or no mail messages 
are available, execution continues to the next icon.

Choices in Configuration:

This icon only requires configuration of options such as handling 
touch tones during message play-back.

Examples of Use:

Use this icon to play messages to a caller who is calling in to retrieve 
voice mail.
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10.6.7. Delete Mail Message

Description:

This icon removes the current message from the mailbox.

Choices in Configuration:

No configuration is required.

Special Considerations: 

Mail messages can’t be locked as table records can. Any message can 
be removed by this icon. You must have used a Log On Mail Server 
icon to log on to a specific mailbox.

Examples of Use:

To help save disk space, remove messages after they have been lis-
tened to.

Figure 10-48. Configuration Dialog Box for Play Mail Message Icon
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10.6.8. Delete All Mail Messages

Description:

This icon removes all mail messages from the mailbox.

Choices in Configuration:

No configuration is required.

Special Considerations: 

Mail messages can’t be locked as table records can. All messages are 
removed by this icon. You must have used a Log On Mail Server icon 
to log on to a specific mailbox.

Examples of Use:

Erase all mail messages after reading them with this icon.

10.7. User Palette

10.7.1. User Decision

Description:

This icon posts a question to the Macintosh’s screen to be answered by 
the person at the keyboard. Script execution continues down the “+” 
path if the person answers “Yes”, and down the “-” path if they 
respond “No”.

Choices in Configuration:

The decision and button text can be entered as a Value, or retrieved 
from a table field or variable. Use the pop-up labeled “Dialog Times 
Out” to determine how long the decision dialog will be on the screen 
before it times out.
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Special Considerations: 

Scripts using icons from the User Palette must anticipate that someone 
will be at the Macintosh when the script is running. This person can 
press the Return or Enter keys to select the default positive response.

Examples of Use:

A portion of a script that handles manual backups could branch based 
on the user’s input regarding whether or not a particular table is to be 
exported to a text file as a backup.

Figure 10-49. Configuration Dialog Box for User Decision Icon
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10.7.2. User Enter Value

Description:

This icon prompts a person sitting at the Macintosh for a single piece 
of information which can be recorded into a variable or table field.

Choices in Configuration:

ˆUnder “Description”, enter the text that will appear in the box dis-
played to the person at the Macintosh. The text can be entered as a 
value or drawn from a variable or table field.

Under “Help Text”, enter text to be displayed if the person clicks on 
the Help button in the box.

Under “Place Results into”, determine where the value entered will be 
placed - into a variable or into a field of the current record in a table.

Use the pop-up labeled “Dialog Times Out” to determine how long the 
prompt will remain on the screen.

Special Considerations: 

If entering a value into a table, the table must contain at least one 
record.

10.7.3. User Select Table Record

Description:

This icon presents a list of a single field from all records in table, and 
allows a person using the Macintosh to select from the list. The record 
that the user selects becomes the current record.

Choices in Configuration:

The table and field for display are selected here.
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Special Considerations: 

The table must contain records before this icon is executed. If no 
records are found in the table, or the person selects the cancel button, 
execution continues down the “-” path with no display.

Examples of Use:

This icon could be used to identify a “category” of customer. A table of 
categories could be created, and presented to the person at the Macin-
tosh.

Figure 10-50. Configuration Dialog Box for User Enter Value Icon
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When a telemarketing call is made, a new table record could be created 
in a second table. A category would be selected from the first table 
using this icon. The category could then be assigned to a field in the 
second table with other information about the customer. This icon 
could also be used to allow a telemarketer to select a customer’s per-
sonal account record when taking an order.

10.7.4. User Edit Record

Description:

This icon allows the Macintosh user to edit the current record in a table 
using PhonePro’s built-in editor.

Choices in Configuration:

The table for which the current record is to be edited is selected. 
Browsing (moving from record to record, adding, and removing 
records) can be enabled or disabled.

Special Considerations: 

The table must contain records before this icon is executed.

Figure 10-51. Configuration Dialog Box for User Select Table Record Icon
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Examples of Use:

This icon could be used to permit an administrator to update informa-
tion contained in table.

10.7.5. Local Phone Picked Up

Description:

The Local Phone Picked Up icon will execute a sequence of icons 
attached to it when the a user takes a local telephone set off hook dur-
ing script execution.

Choices in Configuration:

No configuration is required for this icon, since it is in effect config-
ured by connecting icons to its outbound connector in a similar way to 
the Fatal Error and Call Terminated icons.

Figure 10-52. Configuration Dialog Box for User Edit Record Icon
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Special Considerations: 

This icon requires a telephony hardware that supports detecting the state of 
the local phone set.

If this icon is not placed in a script and the local phone is picked up, 
script execution will continue as if nothing had happened.

You can only have one Local Phone Picked Up icon per script. If a 
Launched sub-script contains one, that will become the currently-
active Local Phone Picked Up icon as long as the launched sub-script 
is executing.

Examples of Use:

If a script answering a call is expected to stop when the local phone is 
picked up, include the Local Phone Picked Up icon followed by a Stop 
Icon.

10.8. Modem Palette
Modem Palette icons enable callers to send and receive data from 
remote computers or terminals using a modem. For example, they let 
you create electronic bulletin boards accessible to callers with a 
modem.

The modem icons use the Macintosh Communications Toolbox. They 
use Connection Tools for connecting/disconnecting, and File Transfer 
Tools for file transfers.

To use the modem icons, PhonePro must operate in Data Modem 
Mode, as described on the following pages.
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10.8.1. Establish Data Connection

Description:

The Establish Data Connection Icon attempts to connect to a remote 
computer and enter Data Modem Mode. This is a mode where the 
Modem is used to communicate via character-based interaction, rather 
than voice or touch-tone interaction.

Choices in Configuration:

Connection On: Specify inbound or outbound connection.

Configure Connection: Using the Configure Connection button set up 
the Connection Tool which will be used by this icon to establish a con-
nection. The Connection Settings window will appear. The upper por-
tion of this window contains a pop-up menu from which to select a 
connection tool.The lower portion of the window allows you to config-
ure the tool that you’ve selected. Recommended tools are the Serial 
Tool and Apple Modem Tool, both from Apple Computer, Inc. The 
Apple Modem Tool may only be used in making outgoing calls. When 
using the Serial Tool, you must establish the phone call before estab-
lishing a data connection.

Figure 10-53. Configuration Dialog Box for Establish Data Connection Icon
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Special Considerations: 

This icon can be used in the following scenarios:

1. Using Apple Modem Tool to dial a number and connect to a 
modem.

Start with an Establish Data Connection icon configured for 
an outbound call and using the Apple Modem Tool. In config-
uring the Apple Modem Tool, enter the phone number you 
wish to dial. The modem tool has a feature to re-dial if it’s not 
successful. You may or may not wish to use this feature, so 
make sure you’ve got this configured properly.
You must not have a call already in progress when using the 
Apple Modem Tool. It will return an error. This tool is capable 
of dialing out on its own.

Figure 10-54. Connection Tool Configuration
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2. Using Make Call icon to dial a number, then the Serial Tool to 
make a data connection.

In this case, Phone palette Make Call icons are used to make 
the call, then the Establish Data Connection Icon is used to 
establish a modem connect over that call.

3. Waiting for Data Call
Scripts that are specifically waiting for a data call can use an 
“Establish Data Connection” icon configured to handle 
inbound connections. During script execution the script will 
pause at this icon until an incoming call is answered and a 
data connection is attempted. The Apple Modem Tool is rec-
ommended for this use.

Examples of Use:

After answering an inbound telephone call with a voice message, the 
Enter Modem Mode icon can be used to establish a data connection to 
a caller who wishes to upload or download files from within 
PhonePro.

10.8.2. Break Data Connection

Description:

The Break Data Connection icon exits Data Modem Mode and termi-
nates the existing call.

Choices in Configuration:

No configuration is required.

Special Considerations: 

A Data Modem Mode call must be in progress to use this icon.
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Examples of Use:

Use the Break Data Connection icon after a Data Modem Mode call 
and before waiting for another call.

10.8.3. Send Text String

Description:

Use the Send Text String icon in the Data Modem Mode to transmit a 
string of characters over the phone to a remote computer or terminal.

Choices in Configuration:

Specify the message as a table field, variable, value, or text file. Control 
is also provided for inserting carriage returns (CR’s) and line feeds 
over the phone line before or after sending the string or file.

Special Considerations: 

Because it is not possible to interrupt text transmission, messages 
should be relatively short (no more than approximately 1000 charac-
ters).

Figure 10-55. Configuration Dialog Box for Send Text String Icon
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Examples of Use:

Use this icon to display a welcome message to your personal bulletin 
board.

10.8.4. Receive Text String

Description:

The Receive Text String icon receives a string of characters from the 
phone line.

Choices in Configuration:

This icon can be configured to receive a specific number of characters, 
or can be set to terminate after a carriage return.

It also has a time-out connector, so that execution is not delayed if no 
text is received.

The icon can also be configured to suppress echoes to the remote com-
puter or terminal when typing passwords or other secret information. 
Other options include stripping the line feeds and carriage returns 
from the incoming text.

Special Considerations: 

Since many users are used to hitting “return” to complete a response, 
using the “Terminate after specified number of characters” option may 
cause confusion.

Because PhonePro string comparisons and searches are performed 
with all-capitalized strings, upper/lower case issues are not a concern.

Examples of Use:

Use this icon to ask the remote caller their name to check against a 
Table of authorized users.
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10.8.5. Send File

Description: 

The Send File icon sends a file from the PhonePro station to the remote 
computer or terminal.

Figure 10-56. Configuration Dialog Box for Receive Text String Icon
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Choices in Configuration:

The file specified can be located from within a Table, a variable, or 
located directly from within the lists of available file types. XModem, 
YModem, or ZModem can be specified as the transfer protocol.

Special Considerations: 

No initial message is displayed on the remote station. To ask the caller 
to “start receiving”, the Send File icon should be preceded by a Send 
Text String icon which warns the caller that a file is about to be sent.

Examples of Use:

If you are at a remote location, use the Send File icon to send a file to 
your laptop computer if you find that you are missing a file located on 
your hard disk at the office.

Figure 10-57. Configuration Dialog Box for Send File Icon
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10.8.6. Receive File

Description:

The Receive File icon receives a file from the remote computer or ter-
minal and stores it in a specified folder on the PhonePro Macintosh.

Choices in Configuration:

Drop Folder: The “drop folder” which receives the file can be located 
in a Table, a variable, or directly from the lists of available path names. 

Figure 10-58. File Transfer Tool Configuration
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Use this Filename: The Receive File Icon can be configured to specify a 
file name. This can be useful when you wish to replace an existing file. 
After checking the “Use this filename” check box in the icon configura-
tion window, you can specify the name of the file to be received. Some 
file transfer tools may not support this feature, so you should test first.

File Name: Set the source of the filename if you will be specifying a file 
name for the transfer. Most file transfer tools won’t overwrite an exist-
ing file. For example, if you have a file called “Current Price List” and 
upload another, it will probably be called “Current Price List #1”.

Transfer Setup: Click the “Transfer Setup…” button to select and con-
figure the file transfer tool to be used for the file transfer. The File 
Transfer Settings window will appear. The upper portion of this win-
dow contains a pop-up menu from which to select a file transfer tool. 
The lower portion of the window allows you to configure the tool that 
you’ve selected. PhonePro should work with any valid file transfer 
tool. Refer to any documentation you received with the file transfer 
tool you intend to use.

Special Considerations: 

No initial message is displayed on the remote station. You can send 
one using the Send Text String icon if you wish.

Examples of Use:

The Receive File icon enables users at remote locations to drop files 
from their lap top to a hard disk at the office to ensure safe storage.

10.8.7. Text Menu

Description:

The Text Menu icon allows a caller in the Data Modem Mode to select 
from a menu of text-based services and file transfer areas.
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Choices in Configuration:

A list at the top of the box shows the options which will be in your text 
menu. Up to 9 options may be included. A time-out period can also be 
specified. After this period, if no menu choice has been selected, script 
execution proceeds through the “T” (Time out) outbound connector.

Figure 10-59. Configuration Dialog Box for Receive File Icon
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After specifying the menu options, connect one path for each option to 
the outbound connector of this icon. A digit appears on each path, sig-
nifying the Touch Tone digit the caller uses to access that menu option. 
You can change these by double-clicking on the digit. This will allow 
you to specify a different one.

Special Considerations: 

It is possible to include additional “hidden” options by adding paths 
to the main menu. This is done by connecting a path to the outbound 
connector without adding it to the text for the menu options.

Examples of Use:

Use the Text Menu Icon to create an on-line, dial-in bulletin board. 
Instructions for using menus and other features could be sent using 
the Send Text String icon.

10.8.8. Select File

Description:

The Select File icon allows a caller to browse through and select from 
the contents of the available hard disks from a remote computer or ter-
minal.

Choices in Configuration:

Under “Start Folder”, specify the folder where you wish the caller to 
start browsing. This folder can be located in a Table, or located directly 
in the lists of available path names.

Under “Put File Into”, store the name of the file selected in a table field 
or variable for future retrieval, for example by the Send File icon.

Under “Timeout Seconds”, specify the time which is allowed to elapse 
without a response from the caller before this icon times out.
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Special Considerations: 

Security is a major consideration. If allowing a caller to browse the 
hard disks available to PhonePro, be sure to password-protect sensi-
tive material.

Examples of Use:

A caller wishing to download a file to a remote computer or terminal 
can select the file using this icon. The file can be sent out by the Send 
File icon.

10.9. Fax Palette
Fax icons enable the caller to initiate fax transmissions. All fax icons — 
Send Fax, Receive Fax, Create Fax Job, Add File To Fax Job, and Send 
Fax Job — appear on the fax palette, which can be opened from the 
Windows menu.

When PhonePro attempts to execute fax icons it utilizes the fax soft-
ware specified in the “Fax Modem” pane of the preferences window. 
The fax software is typically configured to use a separate telephone 
line from the one being used by PhonePro’s telephony hardware.The 
advantage to this “two call” system, or using a separate fax modem 
and line, is that PhonePro can field incoming calls while the fax soft-
ware is transmitting on a second modem.

Both fax and text format files can be faxed. They are stored in the “fax 
files” and “text files” lists, respectively, and are found in the Lists 
menu. Fax and text files can be stored in Table fields as well.

Fax Job icons

Fax Job icons are used to group fax files so they can be sent as a single 
“fax job”. Fax Job icons let callers specify several documents they wish 
to have faxed to them in one transmission. The icons also enable 
administrators to add files to a Table and later fax the contents of that 
Table as one job.
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Fax Job icons create, add documents to and send fax jobs. It is possible 
to send only one fax job at a time, and once a fax job is sent, it is 
deleted from the Table.

Note: Fax Job icons are not compatible with all fax modem software.

10.9.1. Send Fax

Description:

Use the Send Fax icon to fax out a single text or fax file.

Choices in Configuration:

FaxFile The file to be faxed can be specified from the fax file list, the 
text file list, or a Table field.

To Phone#: The phone number to receive the fax is labelled in the sec-
ond configuration field as a value, variable, or Table field.

Attention: If a cover sheet is specified for the fax software you are 
using, this setting will determine what appears in the “TO” or 
“ATTENTION” portion of the cover sheet. Select whether the Atten-
tion parameter is a value, variable, or a Table field.

Special Considerations: 

This icon faxes only one item at a time. To send multiple documents, 
use the Fax Job icons.

Preparing Faxes for FaxSTF

You will need to pre-convert any documents you wish to fax using 
FaxSTF to a format that it uses. To do this:

1. Turn the fax software “off”. This will allow you to access the fax 
file before it is sent.
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2. Select the Fax Printer in the Chooser, and “print” the document to 
the fax system as you normally would. Include an appropriate 
cover page.

3. Drag the new fax file from the fax spool folder. For STF versions 
2.2.3 through 2.7, you’ll find it in your System Folder, in a sub-
folder called “FaxSpoolƒ”. STF versions 3.0 and later spool to a 
folder called “Fax Out” inside another folder called “STF” which 
is in the System Folder. Move the fax file (it will have been given 
the same name as the document.) and place it in a folder that 
you’ve created to store your PhonePro script’s fax files (e.g. “Fax 

Figure 10-60. Configuration Dialog Box for Send Fax Icon
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Back Documents”). Move all files you wish to fax from within 
PhonePro to this folder after they’ve been “printed” to the fax 
folder.

4. Once you have done this for all the documents you wish, turn the 
fax software back on.

Important! Do NOT use any of the fax documents that come as examples with 
the purchase of FaxSTF or FAXcilitate. They will not work. You must use the 
procedure outlined above to create your faxable documents. In addition, do 
NOT use faxes that have been moved to the Fax Archive folder. These will also 
not work.

In configuring the Attention parameter of the Send Fax icon, bear in 
mind that FaxSTF normally requires a company name. To include a 
company name, use a dash (“-”) to separate it from the rest of the 
name. For example, with “Steve Jobs-Apple Computer”, FaxSTF 
would build a “To:” line like this: “To: Steve Jobs, Apple Computer”. 
The Company name is limited to 31 characters. You may wish to use 
the calculation icon to build a string like “The Person At Ext 13-A 
Future Customer”.

10.9.2. Fax Receive

Description:

This icon is used to receive fax files so that one telephone line can han-
dle voice and fax calls by doing automatic fax switching.

This icon is automatically activated if two fax CNG tones (1200 Hz 
tones) are detected within 10 seconds of each other. This icon works in 
conjunction with fax software you selected in PhonePro preferences.

Choices in Configuration:

This icon is not configurable.
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Special Considerations: 

This icon requires a telephone tools with voice/fax call discrimination.

Examples of Use:

A single phone number can be published for both voice and fax calls. 
A single PhonePro script can implement an auto-attendant for the 
voice calls and receive faxes on the same line using the Fax Receive 
icon.

10.9.3. Create Fax Job

Description:

The Create Fax Job icon starts a new fax job. Files are added to the fax 
job using the Add File to Fax Job icon.

Choices in Configuration:

This icon is not configurable.

Special Considerations: 

All three Fax Job icons must be used together to create, add files to and 
send a fax job.

10.9.4. Add File to Fax Job

Description:

The Add File to Fax Job icon adds a specified file to the fax job.

Choices in Configuration:

Specify the fax or text file which will be faxed. The file can be specified 
directly from within the icon through a text file, fax file, or any file list. 
It can also be specified through a Table field or a variable.
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Special Considerations: 

If you’re using FaxPro and you’re sending text files, be sure to have 
“auto convert” selected in FaxPro. If you are sending the same text file 
repeatedly, it is best if you pre-convert it to a fax file format.

Examples of Use:

Use this icon to allow callers to select files and add files which will be 
sent to them in one transmission.

10.9.5. Send Fax Job

Description:

The Send Fax Job icon sends a fax job with all the files specified by 
Add File to Fax Job since the Create Fax Job Icon. The caller’s fax num-
ber is specified here as well.

Choices in Configuration:

Assign the caller’s fax number to a Table field, variable, or a value.

Select whether the Attention field in the fax cover sheet is a value, vari-
able, or a Table field. The Attention field will be used on the cover 
sheet accordingly.

Special Considerations: 

The Add to Fax Job icon sends the file to the file server, so it is not a 
good idea to use this icon while the caller is on the line, as the transfer 
can take approximately 10 seconds. A better solution would be to 
mark the files to be faxed and store them in a Table. After a call is com-
pleted, loop through the Table and build the fax job with the marked 
files.

Note that a new, outgoing, call must be initiated before faxes can be 
sent.
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Examples of Use:

Fax Job icons enable callers to select a number of fax or text files and 
later receive them in one fax transmission.
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11.
Tutorial

11.1. Introduction
This chapter will help you to begin writing PhonePro scripts, first by 
explaining some concepts which will be useful to you and then by 
examining several example scripts.

The first of these, the Simple Answering Machine, breaks down the 
construction of a script into very basic steps. The examples that follow 
are intended to illustrate most aspects of the PhonePro environment.

The example scripts featured in this chapter are all provided on disk 
with PhonePro, in a folder called “Examples”. They are available for 
you to use in your own scripts if you wish to. Each one contains exten-
sive notes to help you make the best use of them.

11.2. Prerequisite Knowledge
Although PhonePro is designed to be used by relatively non-technical 
people, knowledge of a programming language such as BASIC is an 
advantage when developing PhonePro scripts.
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Never having learned to write conventional programs does not mean 
you will be unable to make the best use of PhonePro. By applying the 
information in this chapter in a practical manner, you will be able to 
develop well-structured, robust scripts.

11.3. Structuring scripts
Before you place a single icon in a script window, it is vital to have a 
clear idea of the tasks your script will perform and the methods which 
will be employed to perform those tasks.

Write down a methodical, step-by-step description of your script. 
Break down each task the script will perform as much as you can. This 
will help you to think it through, so that you can allow for every possi-
bility that might occur when your script is being used. It will also help 
you to decide which icons will be needed in your script.

Remember that configuring icons correctly is crucial to the script. Con-
figuration choices offer many options and simple errors can easily be 
overlooked.

Think about the information your script will use. Some scripts use col-
lections of information, such as an address book or call log. Others use 
small amounts of information. Will your script use stored text or 
sounds? Send faxes? Record spoken messages? The answers to ques-
tions such as these will help to determine how your script will be con-
structed.

11.4. Annotating scripts
You can include annotations in a script using the Script Annotation 
Tool and the Rectangle Tool. Notes and comments are extremely useful 
because they can make it much easier and quicker to understand the 
functions of each part of a script. Annotation can also provide useful 
information about the configuration of crucial icons, so that you don’t 
have to repeatedly check the configuration of individual icons.
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If you build a script, use it for a while and then decide to change it 
later, your notes (or lack of them) can make a great deal of difference in 
your ability to understand the script.

Annotation of the script also helps you to keep your thought processes 
clear.

The example scripts are extensively annotated and show how your 
own script notes might be organized.

The Script Annotation Tool and Rectangle Tool are explained fully in 
Chapter 10.

11.5. Simple Programming Concepts
A number of concepts are central to the type of programming involved 
in PhonePro. Understanding them will give you much of the insight 
you need to construct scripts.

In PhonePro, some of these concepts are represented by a single icon. 
Others, such as the concept of a table, are prevalent throughout the 
development environment. Still others will require you to connect cer-
tain icons together in a particular sequence.

11.5.1. How PhonePro Handles Information

In programming, numbers and other forms of information have many 
uses. When building PhonePro scripts you’ll typically deal with two 
categories of information: information that you, the programmer, 
establish a fixed value for and pieces of information whose value will 
be set by the script you write and will change as the script runs.

In PhonePro (as in most software development systems), pieces of 
information are all assigned a particular data type. The data type asso-
ciated with a particular piece of information determines what you can 
and cannot do with it. Examples of data types include Text, Date, 
Phone Number, Sound, and Links to various types of files.
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The illustration below shows the configuration dialog box for the icon 
which makes a telephone call. Obviously, if this icon is going to make a 
call, it needs a telephone number. There are several possible sources 
for this information which can be selected using the pop-up menu in 
the upper left of the window.

Constants

By selecting “value” from the pop-up menu on the left, the telephone 
number could just be typed in as a constant value that cannot change 
during the execution of the script. Constants such as numbers, dates, 
and test strings are handled as “values” that are entered directly into 
the configuration of the icon. Other types of icons may refer to con-
stants such as a pre-recorded sound, a link to a text file, a link to folder. 

Figure 11-1. The Configuration Dialog Box for the Make Call Icon. The Number to 
Call can be obtained from a fixed value, a variable, or a table field
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Note: A script can be written to erase or record a sound constant in order to 
allow developers to write a utility script as a tool to record the sounds to be 
used in a PhonePro solution.

Variables

The telephone number in the Make Call icon could be retrieved from a 
variable. A variable is a single, changeable piece of information that is 
given a name. A variable can be thought of as an empty box, into 
which a single piece of information may be placed. You can create vari-
ables using PhonePro’s Data Browser window or directly from within 
the icon configuration window. The information associated with a 
variable is stored in the script file itself, in a designated “shared file” 
that can be shared among a number of PhonePro scripts, or in the com-
mon file which is shared by all the PhonePro scripts on a given com-
puter.

Tables

The third option in the Make Call icon example is that the telephone 
number could be taken from a table, a collection of information orga-
nized rather like a stack of index cards. More specifically, the phone 
number actually comes from a table field, a particular field on the cur-
rent record within the table. Understanding the idea of a table field 
first requires the assumption that each record in the table (think of a 
“card” in the “stack”) has exactly the same structure of fields (think of 
boxes to fill in on the “card”). Names, addresses and telephone num-
bers are good examples of the types of fields which might be found in 
a PhonePro table.

Tables are created as separate files independent of the scripts which 
use them. The example of the answering machine script, further on in 
this chapter, explains how a table is created.
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If the Make Call icon in this example were configured so that it 
obtained the telephone number from a table field, you would have to 
specify which table and which field it should use. You would also need 
to use some table icons, in conjunction with the Make Call icon, to 
choose the appropriate record (or “card”) from the specified table.

Table fields are like variables except that there is a distinct piece of 
information with the same field name on every single record in the 
table. When you use a variable you specify the name of the variable 
and what file it is stored in. When you use a table field you specify the 
name of the table field, the table file it’s contained in, and (using other 
icons) the record in the table to choose from.

The example scripts used in this chapter all contain numerous exam-
ples of handling constants, variables, and tables within PhonePro.

Data types

Whichever source the telephone number comes from, it can be of sev-
eral data types. The data type helps to reduce the margin for error in a 
script by limiting PhonePro’s “expectations” about any given piece of 
information. It makes sure the information is appropriate for the use to 
which it will be put. For example, if a variable is given the data type 
sound, PhonePro will only expect that variable to contain a sound. In 
the case of the telephone number, the only available data types are 
Phone number and number.

PhonePro will reject an attempt to place information of an incompati-
ble data type into a variable or table field.

An item which has been given the Phone number type can include 
various touch-tone characters (such as the # symbol), parentheses (as 
might be used to denote an area code) and other “cosmetic” characters 
such as hyphens. An item which has the number data type can only 
include the digits 0-9; in other words, it can only be a whole number. 
Each data type has its own individual format and constraints.
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Data types are assigned to constants, variables, and table fields when 
they are created. However, simple constants that are just values 
entered in an icon configuration window can have their data type 
changed at any time. Changing the data type associated with a vari-
able or constants such as sounds and file links generally involves 
deleting the item and then replacing it. Changing the data type of a 
table field involves restructuring its table using the “Restructure…” 
command in the Tables menu.

For more information about data types, please refer to Chapter 4,.

11.6. Control Structures
Every program, whether it is written in a traditional programming 
language or in the form of a PhonePro script, has some form of control 
structure.

In its simplest form, a control structure involves nothing more than a 
series of programming steps happening one after the other in 
sequence. More complex control structures involve the making of deci-
sions, the taking of conditional action, and repetition.

The structural devices explained on the following pages are all essen-
tial to the production of successful scripts.

11.6.1. Conditional Branching

Conditional branching is almost like decision-making on the part of 
the script. An example of this is a sequence of icons which searches a 
table for a certain record, using criteria such as a number entered over 
the phone line by an incoming caller. If the record is found, the script 
will go on to perform one set of operations (such as connecting the 
caller to a voice-mail extension). If the record is not found, the script 
will perform a different set of operations, such as playing a message 
asking the caller to try a different number. Many icons have positive or 
negative paths which allow for this kind of process to occur.
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Another form of conditional branching is the use of a menu icon, such 
as the Touch Tone Menu icon, which offers a caller a number of 
options and then proceeds to execute the part of the script which 
matches the option they have selected. A Touch Tone Menu icon may 
have several outgoing paths connected to it, each of which will only be 
executed if a particular condition (a caller entering a certain Touch 
Tone) is met.

Still another form of conditional branching involves the use of the 
Make Decision icon. This icon allows a script to make a decision based 
on a comparison of two pieces of information. An example of this is a 
comparison to see if a variable contains a number which is equal to the 
contents of a particular database field. Another example is a compari-
son of two variables to see if they are equal. The Make Decision icon 
allows numerous such bases for comparison. Script execution may 
take one of two courses, depending on the result of the comparison.

11.6.2. Repetitive Execution

Repetitive execution is also referred to as a “loop”. The script executes 
from a beginning point, proceeds to an end point and then “loops” 
back to the beginning point a specified number of times.

The sequence of icons shown in Figure 11-3., if configured correctly, 
forms an execution loop. In this case, the loop plays a sound (using the 
Speak List icon, numbered 4) a certain number of times.

The number of times the loop repeats is determined using a combina-
tion of the Make Calculation icon, numbered 3 and the Make Decision 
icon, number 5.

Figure 11-2. The Make Call icon (left) and the Make Decision icon (right) allow 
conditional branching of a script
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First the Assign Value icon set the loop counter variable called 
“LoopCounter” to 0. The Make Calculation icon then adds 1 to a 
variable called “LoopCounter”. Then the sound is played. Then, the 
Make Decision icon checks to see if Loop counter is less than 10 (the 
number of times the loop is supposed to execute).

If Loop Counter is less than 10, the positive path is executed, which 
leads to the Go To icon. In this case, the loop goes back to the begin-
ning for another pass.

If Loop Counter is equal to 10 (i.e. it is not less than 10), execution pro-
ceeds down the negative path, leading to the Stop icon, which con-
cludes execution of this small script.

Figure 11-3. Loop Example



Tutorial

198

The Go To icon, at the bottom of the icon sequence, can be used to 
route the execution of the script in a number of ways, including the 
conditional branches described above and the subroutines described 
below. It directs script execution to a particular icon, specified using a 
unique number which appears next to each icon in a script.

The configuration dialog box used for the Make Calculation icon in 
this example appears in Figure 11-4. As you can see, it adds the value 
of 1 to the variable named Loop counter.

Figure 11-4. Make Calculation Icon in Loop Example
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The configuration dialog box used for the Make Decision icon used in 
the loop example is shown below. This compares the value of 
LoopCounter to the number 10. If Loop counter is less than 10, the 
positive path is executed. If not, the negative path is executed.

11.6.3. Jumps and Subroutines

A jump is where script execution “jumps” non-sequentially from one 
icon to another, using the Go To icon.

A subroutine is where script execution jumps to a small script or script 
segment which performs a task and then returns to continue from the 
point where the jump occurred. In PhonePro scripts that behave as 
subroutines for another script are known as “sub-scripts”. Scripts can 

Figure 11-5. The configuration dialog box for the Make Decision icon used in the 
loop example above.
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use sub-scripts with the Launch Script icon. The Launch Script icon 
opens the sub-script if it’s not already open and begins executing it 
starting at the Go icon. When the sub-script encounters a Stop Script 
icon it completes execution and returns control to the script which 
launched it, at the point where the launch occurred. Sub-scripts are a 
good way to divide your application into logical modules that can be 
used from multiple places in your main script.

11.6.4. Error Handling and Contingency Planning

It is important to build some error protection into your scripts. A sim-
ple example of this is a series of icons which handle the eventuality of 
a caller hanging up the phone before a call is completed. For this spe-
cific instance, PhonePro has a special “event catcher” icon, the Call 
Terminated icon, which executes only if a call is unexpectedly termi-
nated.

A number of icons have built-in “hooks” on which you can base a cer-
tain amount of contingency planning. A good example of this is the 
Send Mail Message icon, which has a “negative” outgoing path. Exe-
cution of the script only proceeds down this path if the message can-
not be sent successfully. Your job is to connect a sequence of icons 
which will handle the problem smoothly, for example by allowing a 
second try at sending the message. In a sense, icons like Send Mail 
Message which have positive and negative path connectors, allow con-
ditional branching of the script, as explained earlier. 

The Call Terminated and Fatal Error icons are both used to deal with 
potential problems. Neither icon has an inbound connector because 
they are event catcher icons which are invoked at any time during 
script execution when specific conditions are met. You effectively con-
figure both of these icons by joining other icons to them, forming script 
sequences which will allow recovery from an error or terminated call. 
You can’t have one of each of these icons per script file.
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11.7. The Answering Machine Script Example
The key to creating this and any future script is to think of the actual 
actions you want the Macintosh to perform. If you consider the basic 
actions of an answering machine, you can duplicate these with a 
PhonePro script.

First, an answering machine answers the phone when it rings, plays 
the owner’s greeting and then records the caller’s message. The 
machine then hangs up the phone and resets itself to await the next 
call. More sophisticated machines include the ability to retrieve mes-
sages remotely as well as various other features.

All of these capabilities (and many more) can be duplicated with 
PhonePro. We will start with a basic script and then add extended fea-
tures.

11.7.1. Adding Icons to the Script

Consider the desired script. The first thing a simple answering 
machine does is to wait for the phone to ring and answer it after a 
specified number of rings. This is done with the Pick Up Phone icon. 
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To bring the Pick Up Phone icon into the script, find it in the Phone 
Palette and drag it into the script, somewhere under the Go icon 
(Figure 11-6.).

Figure 11-6. Find the Pick Up Phone icon in the Phone palette and drag it into the 
script window
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To connect the Pick Up Phone icon to the Go icon, click on the out-
bound connector of the Go icon and drag to the inbound connector of 
the Pick Up Phone icon (Figure 11-7.).

Figure 11-7. As you drag from the outbound connector at the bottom of the Go 
Icon, a gray path appears
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As you click and drag, a path forms. When you have reached the sec-
ond connector, you’ll hear a “snap” to let you know that the path was 
successfully connected. The path also turns black to indicate that it is 
connected at each end (Figure 11-8.).

Figure 11-8. When you connect your path to the inbound connector at the top of 
the Pick Up Phone icon there is a “snap” sound and the path turns 
black to show that it is connected.
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After the answering machine answers the phone, it should play a 
greeting to the caller. This is done using the Play Message icon. Drag 
this icon out from the Phone Palette and connect it to the bottom con-
nector on the Pick Up Phone icon. Notice that the Play Message icon is 
shaded. This indicates that this icon must be configured before it can 
be used. Icons that are not shaded are already configured or do not 
require configuration.

Next, the answering machine records and saves the incoming mes-
sage. The easiest way to do this would be to save it as a simple sound, 
but this would not give you much flexibility in retrieving the message 
later. The best solution is to save the sound in a table.

To save the message in a table, you first need to create a new record. 
Drag the New Record icon out of the Table Palette and attach it to the 
outbound connector on the Play Message icon (Figure 11-9.).

The next step in the process is to record the incoming message. This is 
accomplished with the Record Message icon. Drag this icon from the 
Phone Palette and connect it to the New Record icon (Figure 11-10.).

As an added feature, you can have your answering machine thank the 
caller for leaving a message before hanging up. Use another Play Mes-
sage icon to accomplish this. It should be placed after the Record Mes-
sage icon and connected to it with a path.

Next, drag the Hang Up Phone icon from the Phone Palette and con-
nect it to the Play Message icon.
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Figure 11-9. Attach the New Record icon to the Play Message icon by creating a 
path between them.
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Figure 11-10. Script with Record Message icon
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As the last step in creating your answering machine, you need to reset 
it to wait for the next call. The simplest way to do this is to use a Go To 
icon to return the script to the top. Attach this to the Hang Up Phone 
icon (Figure 11-11.).

Figure 11-11. Complete basic answering machine script



Adding Detail to the Script

209

11.7.2. Adding Detail to the Script

You can easily add some extra features to your answering machine. 
Here, a couple of examples are provided, but you will probably have 
ideas of your own.

The current day, date and time are tracked by the Macintosh operating 
system. You can add them to your messages table very easily.

Figure 11-12. Add two System Inquiry icons to your script
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Drag two System Inquiry icons from the Core Palette, one for the time 
and one for the date (Figure 11-12.). You can put these icons in any of a 
number of locations, but because it takes a little bit of time to access 
the system and record the information in the table, you probably want 
to do it when the caller is not waiting. After the Hang Up Phone icon is 
a good time.

Figure 11-13. When you disconnect a path, it becomes dimmed. It will turn black 
when you reconnect it to the System Inquiry icon.
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Now disconnect the path connecting the Hang Up Phone icon to the 
Go To icon and reconnect it to the System Inquiry icon. When the path 
is disconnected, it is drawn in gray (Figure 11-13.), but when you suc-
cessfully reconnect it to the System Inquiry icon, it turns black.

Figure 11-14. Connect the System Inquiry icons between the Hang Up and Go To 
icons.
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Place the second System Inquiry icon under the first one and connect 
the two with a path. Now there is one each for the time and the date. 
Move the Go To icon to the bottom of the script and connect it to the 
second System Inquiry icon (Figure 11-14.).

11.7.3. Cleaning up the Script

Now all the functional components have been added to the script. For 
ease of use, however, you can compact it so that it fits on a small 
screen, or move icons individually or in groups, to make the structure 
of the script more apparent.

The following steps should provide some insight into the script layout 
capabilities of PhonePro:

Drag the Go icon to the left. Notice that the path connected to the icon 
moves with the icon. Drag the Pick Up Phone icon to the left and up a 
bit so that it is just under the Go icon. Continue to drag each icon so 
that it forms a tight column under the Go icon (Figure 11-15.).

Next, move the bottom five icons up so that they are in a column next 
to the first five icons. There are two ways to select all these icons and 
paths. The easiest is to drag a marquee around all the icons and paths 
you want to move. Alternatively, hold down the shift key and click on 
each icon and path. This is useful if you need to pick out isolated 
items.

To move the selected icons, click any highlighted icon, and drag the 
selection upward (To deselect, click any empty space in the script win-
dow.) As you near the top of the screen, PhonePro will scroll the screen 
upwards for you. Move the icons all the way to the top so that the Play 
Message icon is at the same level as the Go icon (Figure 11-15.).
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Figure 11-15. Before you rearrange them, the bottom five icons in your script 
should probably look something like this
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Arrange the second set of icons into another straight column 
(Figure 11-16.). The product of this maneuver is not very visually 
pleasing because of the path which runs diagonally through some of 
the icons. To correct this, you can make a path “turn corners”.

Figure 11-16. Icons in two columns
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To accomplish this, click on the long, diagonal path and press the 
Delete (or Backspace) key. Draw a new path from the bottom of the 
Record Message icon that goes horizontally to a point between the two 
columns (Figure 11-17.).

Figure 11-17. First path segment
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Hold down the Command key and drag upward to a point even with 
the top of the Play Message icon. As you drag, a path appears. Hold 
down the Command key again and drag a third path from the end of 
the second path to the top connector on the Play Message icon 
(Figure 11-18.). This set of three paths are treated as one path when the 
script is executed.

Figure 11-18. Icons connected with three path segments
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11.7.4. Setting up the Table

This script, as many do, uses a table to store incoming messages. 
Tables are created and stored on disk independently of scripts.

To create a table to store your incoming messages, consider the infor-
mation that needs to be stored in it. Table records can be thought of as 
cards in a deck. Table fields are categories of information on the cards. 
For more information about PhonePro tables, please see Chapter 4.

To set up the new table, do the following:

First, determine what information the new table will contain. In this 
example, each incoming message will be stored in one record of the 
table. The information saved in a particular record is determined by 

Figure 11-19. The New Table dialog box
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the types of fields you specify when you create your table. In this case, 
appropriate fields would store the message itself along with the time 
and the date of its arrival.

Select the “New” command from the Table menu. The New Table dia-
log box appears as shown in Figure 11-19.

Add a field named “TimeOfCall”. To do this, type “TimeOfCall” in the 
box at the top. Then tell PhonePro what type of information to expect 
in that field, using the pop-up menu below the name of the field. Select 
the data type “Time Type” from the available choices.

Next add a “DateOfCall” field of type “Date Type”.

Finally, add a third field to store the incoming message. Label this field 
“MessageSound” and select “Sound Type” as its data type from the 
pop-up menu.

Figure 11-20. This is what the table structure should look like
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Close the window by clicking OK. Name the table “Incoming Mes-
sages Table”. Click Save.

11.7.5. Configuring the Icons

Now that you have designed the script and set up the table, you need 
to configure each icon.

In general, to configure an icon, double-click on it in the script win-
dow. Icons that require configuration are shaded until they are config-
ured. Some icons, like the Go icon, do not require configuration and 
others, like the Pick Up Phone icon, have a default configuration so 
configuration is optional.

To configure the Pick Up Phone icon, double-click on it. The dialog box 
which appears allows you to specify how many rings to wait before 
answering. You can enter any number, or it can refer to a variable. For 
this tutorial, confirm the number of rings preset at 2 and close the dia-
log box by clicking OK

Important: The actual “number of rings” is based on elapsed time, not the 
number of times the Phone rings.

Figure 11-21. Pick Up Phone icon configuration
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To configure the Play Message icon, you will need to record a sound 
for this icon to play. Double-click on the icon and the configuration 
dialog box appears. Select the source of the sound you wish to play 
(Figure 11-22.). In this case, select “Sound” from the pop-up menu on 
the left.

Figure 11-22. Play Message icon configuration
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Select the “Add New…” option from the pop-up menu on the right. 
Use the dialog box which appears to give your new sound a name 
such as “Greeting”. Click OK.

Figure 11-23. Name your new sound
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The Record Window appears, with the name of the Sound and the 
Record, Listen, and Sound Edit buttons. For more information about 
sounds, see Chapter 5.

Decide what you are going to say and then click the Record icon. Click 
Record Now and wait for a beep and a progress bar on the screen 
before you begin speaking.

You can speak as long as your Macintosh’s memory allows. 30 seconds 
is a sensible maximum for a greeting of this type.

When you are finished speaking, click to stop recording.

You can now hear your message played back. Click the Listen icon (to 
the right of the Record button).

Figure 11-24. Record window
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If you are not satisfied with the results, click the Record icon again to 
re-record the sound. The original sound recording will be replaced by 
the new one.

When you are done, click OK, and you are returned to the icon config-
uration dialog box. Your new sound now appears in this pop-up menu 
as the pre-recorded sound that will be played to callers. Click OK 
again to complete the configuration of the icon. The Play Message icon 
in the script window is no longer shaded to signify that it is fully con-
figured.

Figure 11-25. Configured Play Message icon
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To configure the New Record icon, double-click the icon to open the 
configuration dialog box. There are two parts to this configuration.

First you must tell PhonePro which table should get the new record. 
Select “Table File Link” in the pop-up menu under “Add Record to:” 
and then select “Add Link to File…” from the pop-up menu on the 
left. This displays a dialog box from which you can select the appropri-
ate table file. Pick the table file which you created earlier. This creates a 
link between the script file and the table file that PhonePro will use to 
find the table file when the script is executed. The table file’s name 
now appears in the pop-up menu.

Next, you must specify where the new record is to be added in the 
table. Click on the Add Record pop-up menu and choose “At End of 
Table”. This will place all new messages at the end of the table, so that 
they will be displayed in chronological order. Click OK and the icon in 
the script window will no longer be shaded, indicating that it is fully 
configured.

Figure 11-26. New Record icon configuration
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To configure Record Message, double-click the Record Message icon to 
display its configuration dialog box. This icon needs two things to be 
configured: where the recording will be stored and its maximum 
length.

To select the storage location (under “Save Sound to…”), select “Table 
Field” from the pop-up menu. As you only have one table currently 
linked to this script file, PhonePro guesses that you want to use it so 
the “Table” pop-up on the right appears with your table already 
selected. Also, because the table only contains one field that can hold a 
sound, PhonePro guesses that this is the field that you wish to record 
the sound to.

Figure 11-27. Record Message icon configuration



Tutorial

226

Now select Seconds to Record (note that a default of data type “Value” 
is pre-set for you). To change the length of the recording to 10 seconds, 
type “10” in place of the pre-set 20.

The Record Message icon is now configured. Click OK to close the dia-
log box.

To configure the Play Message icon for the parting message repeat the 
process you followed for the greeting but name the new sound 
“Goodbye” instead of “Greeting”.

The Hang Up Phone icon does not require configuration.

To configure the first System Inquiry icon double-click the System 
Inquiry icon. Use the pop-up menu beside System Inquiry Type to set 
the type of information that you wish to obtain from the system. In this 
case, you want Current Time.

To set where to store the result, select Table Field from the pop-up on 
the left Once again PhonePro will guess the appropriate table and field 
because the “Incoming Messages” table is the only table linked to this 
script and the “TimeOfCall” field is the only field of the appropriate 
type. Click OK.

Figure 11-28. System Inquiry icon configuration
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Configure the second System Inquiry icon to store the Current Date 
into the DateOfCall field of the Incoming Messages table.

The Go To icon directs the script to another icon within the same 
script, so it is already appropriately configured because it is set to 
direct the script to icon number two, the Pick Up Phone icon. To re-
configure this icon, you would enter the number of the icon to which 
you want the script to jump. This is another example of an icon for 
which configuration is optional.

Now that you have completed creating your script, you can simulate it and 
see how it works. Save it first, though!

11.8. Executing your Script in Simulation 
Mode
To check the basic operation of your script, PhonePro provides a Simu-
lation mode which does not actually communicate with your tele-
phone line but imitates it so that you can test your script without 
making or receiving a call.

When you are in the Simulation mode, the cursor appears as a tele-
phone. When you exit Simulation mode, the cursor again becomes an 
arrow.

To simulate your Simple Answer script:

Select Simulate from the Script menu. The Pick Up Phone icon high-
lights, to show that the script is executing it.

Press the space bar. You will hear a phone ringing sound and the Tele-
phone cursor animates to indicate ringing. Press the space bar a sec-
ond time. Since you configured the script to answer after two rings, the 
script moves to the Play Message icon after the second ring.

The script proceeds from icon to icon. When it reaches a Play Message 
icon, you will hear the greeting that would be played over the phone 
line. When it reaches the Record Message icon, PhonePro will record a 
sample sound.
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When the script has completed a cycle, it returns to the start of the 
script and waits at the Pick Up Phone icon. Run through the script a 
second time.

5. At any time, you can select “Stop Script” from the Script menu or 
press the Command “.” keys to stop simulating the script. The cursor 
changes back to an arrow.

11.8.1. Checking Script Operation

To ensure that the script has recorded the sounds from each of the two 
recordings as you actually wanted, you can browse the incoming mes-
sages table.

Select “Open” from the Table menu. Locate and open your Incoming 
Messages table.

You are now looking at the table browser window. Each of the calls 
“received” in Simulation mode are listed by the first field in the table; 
in this case, it is the “TimeOfCall” field.

Double-click the first record listed. This brings up the complete record 
for the first call in the Table Editor window, as shown in Figure 11-29.. 
The Time and Date are listed in the appropriate fields. In the Message 
Sound field you will see that a sample sound has been recorded. You 
can play this by clicking on the Play button (with the speaker symbol) 
next to the name of the message sound.

To look at the second call, click the Next button found at the bottom of 
the window. The title at the top of the window will now say “Record 2 
of 2” and the Next button becomes dimmed to signify that you have 
reached the last record of the table.

Return to the first record by clicking Previous or First.

Delete the records one-at-a-time by clicking the “Remove” button. This 
control deletes the record currently in view.
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11.9. Executing your Script in Run Mode
Now you are ready to try using your Simple Answer script in Run 
mode. If you want to stop the execution of the script, select “Stop 
Script” from the Script menu or press the Command “.” keys to stop.

Select “Run” under the Script menu (Command-R). The cursor 
becomes a phone to indicate that the script is running. If you have two 
phone lines, place a call to the line your PhonePro hardware is con-
nected to. If you don’t, ask a friend to call and leave a message.

Figure 11-29. Table Editor window
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Watch the progress of the script as the call is received and the message 
is recorded.

After the call is completed and the script has returned to the Pick Up 
Phone icon, select “Stop Script” from the Script menu or press the 
Command “.” keys to stop execution of the script.

Open the Incoming Messages table as described above. There is only 
one record in the table corresponding to the call that was just com-
pleted. Double-click this record to access the Table Editor window. The 
sound field now contains a sound that was recorded over the phone 
line. You can listen to this sound by selecting the Play button on the 
right.

You have now created, configured, executed and checked a script.
Congratulations!

11.10. The Example Scripts
The example scripts provided with PhonePro can all be found in the 
“Examples” folder, which is placed on your disk with PhonePro at 
installation.

These scripts are there for you to make use of in any way you wish, 
either as learning tools or as a basis for your own scripts. 

Note the use of comments in all the example scripts. These add to their 
clarity and make them much easier to follow.

11.10.1. Using a Script with a Front End

The shortest of the sample scripts provided with PhonePro is the 
answering machine used in the previous part of the tutorial. On disk, 
however, the answering machine has a “front end”, a custom set of 
menus which can be used to access script data.
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The front end can be used to insulate novice computer users from the 
relative complexities of PhonePro. It can also be used to prevent tam-
pering. Additionally, the front end clarifies and polishes a PhonePro 
script, turning it into a complete application. A script which is running 
via its front end is called a “Captive” script.

A front end works by linking variables, tables and other items of data 
to the menu bar. You can display a data item and edit it by selecting it 
from the menu bar.

Locate the answering machine script in a folder called “Front End 
Example”.

To run the script in Captive mode, first double-click it in Finder, or 
open it using the Open command under the File menu. You might 
need to locate the Incoming Messages table file as well - if so, just fol-
low the instructions on screen. The table is in the same folder as the 
script.

How to run a Captive Script

To use the front end, you must place the script into “Captive mode”. 
Hold down the Option key while you pull down the Windows menu. 
At the bottom of the menu, you’ll see the option to “Try Simple 
Answer Captive”. Select this.

Placing the script into Captive mode removes the script window and 
palettes from your screen. A modified menu bar appears. Two “Cap-
tive menus” have been added, called “Set Up Items” and “Messages”. 
These menus both contain items which have been linked to various 
items of script data.

How the PhonePro Menus are Modified in Captive Mode

You will also find that the options offered by the remaining PhonePro 
menus (File, Edit and Scripts) have changed.
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Most importantly, you now use the File menu to Run or Simulate your script 
(instead of the Scripts menu). You can also select “Auto Run at Start Up” 
from the File menu. If selected, the script will automatically run in 
Captive mode, each time it is opened.

The Edit menu offers a subset of the options it normally contains.

The Scripts menu allows you to select any of the open scripts as the 
current script. If you hold down the Option key and pull down the 
Scripts menu, the option to Unlock the current script becomes avail-
able.

The Captive Menus

The Messages menu offers you an option called “Incoming Messages”. 
If you select this, it opens the Incoming Messages table and allows you 
to browse through it. This is how you would look at your new mes-
sages if you were using this script as your answering machine. Please 
see Chapter 4 for more information about using the Table Browser.

The Set Up Items menu allows you to “fine tune” your answering 
machine. You can change either of the greeting messages, or the length 
of time allotted for recording an incoming message.

All of these control options have been made possible by the simple 
process of creating a link between a named menu item and a data ele-
ment used by the script.

For example, the time allotted for recording a new message is specified 
when you configure the Record Message icon. Earlier in the tutorial, 
this icon was configured so that the “seconds to record” was entered as 
a literal value. The example script provided on disk takes the “seconds 
to record” from a variable instead. By creating a link between the 
menu item “Recording Time” in the front end for this script and the 
variable “Seconds to Record” from which the Record Message icon 
obtains the allotted recording time, the script offers you the option to 
change the allotted recording time easily, by selecting the “Recording 
Time” menu option and typing in the desired number of seconds.
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Complete information about creating front ends for your scripts is in 
Chapter 7. There is also some helpful annotation in the script itself.

Unlocking your Captive Script

To stop your captive script without quitting from PhonePro, hold 
down the Option key and select “Unlock” from the Scripts menu. Then 
type the password, “PhonePro”, into the dialog box which appears. 
Alternatively, select “Quit” from the File menu. This will shut 
PhonePro down completely.
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12.
Tips and Techniques

12.1. Script-building Tips
• Keep Touch Tone menu options to a maximum of 5 or 6 alterna-

tives - callers may have difficulty remembering all of the possibili-
ties for more complicated menus!

• Limit the number of icons in a script. The more icons, the more 
difficult it might be to identify the functions of a script. Include 
some “Launch Script” icons to help provide structure and modu-
larity to scripts.

• Use Script Annotations liberally. They help ensure that a script can 
be maintained easily. They can also assist in explaining parts of 
scripts that may not be easily understood by others.

• Use “Go To” icons instead of long, complex paths. Long paths can 
be difficult to follow, especially in complicated scripts.

• Speed up script execution by turning animation off in the Prefer-
ences/General panel. Animating the script can slow down script 
execution and make callers impatient - especially on slower Mac-
intosh models!
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• When recording sound files identified using PathToFile type vari-
ables, it’s often desirable to generate unique file names by using 
the current date and time. Use the Date/Time stamp options of 
the System Inquiry icon to obtain text strings containing date and 
time information that can be incorporated into a filename.

12.2. Keyboard Shortcuts
Several keyboard shortcuts apply to selected icons in a script window. 
These are:

• The arrow keys move selected icons around the script window.

• The Return or Enter key displays the configuration dialog box for 
a selected icon.

Other keyboard shortcuts are:

• Command-Shift-double click on an icon to begin script execution 
in Simulation mode at that point.

• Command-Shift-Option-double click on an icon to begin script 
execution in run mode at that point.

• Double-clicking on the Go icon executes the entire script in simu-
lation mode.

• The Delete key works in the same way as the Remove button in 
any dialog box which doesn’t allow text to be edited.

• Use the arrow keys to select the previous or next entries in any 
list.

• In the Table Editor, Command-Right and Command-Left arrows 
move to the next and previous records, respectively.

• Option-clicking and selecting appropriately from the Windows 
menu locks or unlocks captive scripts.

• Option-clicking and pulling down the File menu changes Close 
into Close All and Save into Save All, allowing you to close or 
save several script windows at a time.


